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1. About this document

1.1 Version information
This document describes how to use IRIS utilities for configuration, calibration, and
monitoring, as well as testing the antenna, IRIS, and signal processor.

Table 1 Document versions (English)

Document code Date Description

M212925EN-D June 2025 This version describes IRIS RDA
version 10.3.0.

Updates include:

• Correction to chapter: Signal
processing and data storage
(page 199): question Source of
recorded angles removed

M212925EN-C February 2025 This version describes IRIS RDA
version 10.2.0.

Updates include:

• Corrections to commands in
chapter Adding a radar site to
Network Manager (page 286).

• Notification conventions
updated according to the ANSI
Z535.6 standard. See
Documentation conventions
(page 14).

M212925EN-B August 2024 This version describes IRIS RDA
version 10.1.0.

M212925EN-A May 2023 First version of this document.

This document describes IRIS RDA
version 10.0.0, which supports
RVP10 Digital Receiver and Signal
Processor.

The predecessor of this document
is M211316EN, which describes IRIS
versions that support RVP900 and
earlier versions of RVP.

1.2 Related documents
Table 2 Related documents (English)

Document code Name

DOC236879 IRIS RDA Release Notes
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Document code Name

M212924EN IRIS and RDA Software Installation Guide

M212925EN IRIS and RDA Utilities Guide

M212926EN IRIS Radar User Guide

M212927EN IRIS Programming Guide

M212928EN IRIS Product and Display Guide

M212923EN Radar Control Processor RCP8 User Guide

M212604EN RVP10 Digital Receiver and Signal Processor User Guide

1.3 Documentation conventions

Warning alerts you to a hazardous situation that, if not avoided, could
result in death or serious injury.
WARNING!

Caution alerts you to a hazardous situation that, if not avoided, could result
in minor or moderate injury.
CAUTION!

Notice alerts you to a situation that, if not avoided, could result in the product
to be damaged or important data to be lost.
NOTICE!

Highlights important information on using the product.

Gives tips for using the product more efficiently.

Lists the tools needed to perform the task.
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Indicates that you need to take some notes during the task.

1.4 Trademarks
IRIS™ is a trademark of Vaisala Oyj.

AlmaLinux™ is a trademark of AlmaLinux OS Foundation.

Linuxâ is a registered trademark of Linus Torvalds.

All other product or company names that may be mentioned in this publication are trade
names, trademarks, or registered trademarks of their respective owners.
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2. Product overview

2.1 Introduction to IRIS utilities
IRIS utilities help you manage IRIS system and software. You can configure, calibrate,
monitor and test the signal processor, radar, and antenna separately. You can also configure
IRIS separately.

While some you can run some utilities while IRIS is running, this is not recommended and
usually unnecessary.

Table 3 IRIS utilities

Utility Run with IRIS Description

Antenna Provides monitoring and control for the RCP antenna controller.

Allows keyboard/mouse control of the antenna and radar transmitter/
receiver/servo system for testing and verification.

Ascope - General purpose data plotting and radar control program where you
can display up to 4 plots from the available parameters:

• Reflectivity against range
• Velocity against range
• Spectrum width against range
• Log, I and Q RAW A/ D samples against range
• Log, I and Q time series at a selectable range
• Doppler spectrum at a selectable range

Useful for diagnosing problems in the Doppler receiver.

Used to align the LOG and LINEAR channel A/D converters, verify the
system overall, and provide an alternative radar control program for
changing pulse width, PRF, clutter filters and data thresholding.

Bitex Provides detailed configuration and observation of the information
reported by the Built-In Test Equipment (BITE).

Dspx - Helps to debug interface hardware to the signal processor, or debug
new software you are developing using the signal processor.

Overlay Edit and display overlay maps that you develop, so that you can see
how they appear when displayed on the real-time display or other
products.

Setup - Configures the radar software for the characteristics of the radar, such
as the number of pulse widths, the duty cycle limits, the radar
wavelength, antenna gain, transmit power, and similar.

Run this utility first.

Zauto - Calibrates the slope and offset of a test signal within a linear range.

This information is stored in a file and used during programmed radar
collection.

Zcal Modifies the calibration file.

IRIS and RDA Utilities User Guide M212925EN-D

16



Table 4 IRIS utilities by function

Function Radar/Antenna Signal processor

Configuration

Run configuration utilities after installation or after
software and hardware updates.

Setup Setup, Dspx

Calibration

Fine-tune the system so that it generates the most
accurate data possible.

Run calibration utilities periodically or if there is a
change to the system hardware.

- Ascope, Zauto, or Zcal

Monitoring and Testing

Overseeing day-to-day system operation to make
sure that it continues to function properly.

Monitoring and testing is ongoing. Run these utilities
regularly or when problems arise.

Antenna, Bitex Ascope, Dspx

2.2 Radar system
The radar system connects to IRIS workstations through the RCP (radar control processor).
RCP resides in an RVP10SRV computer that is networked to other computers.

You must configure the relationship between the radar system, RCP, and IRIS during
installation. Then you must monitor and test it to make sure it continues to function properly.

Control

RCP

Antenna Radar Control Processor IRIS Workstation

Status

Figure 1 Typical radar system installation

2.2.1 Configuring Antenna
IRIS utilities and menus let you control the antenna's position and velocity from a remote
workstation. For these utilities and menus to work, you must first configure the antenna
using the Setup utility.

Some of the information you supply in the Setup utility comes from the manufacturer's
specifications, such as:

• Minimum and maximum elevation that the antenna can reach.
• Maximum azimuth and elevation velocities.
• Warm-up and settle times.
• RCP serial line format.
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The Setup utility must also know information about the antenna's location, such as:
• Height of the ground in meters.
• Height of the antenna in meters.
• Latitude and longitude of the antenna site.

To save time during configuration, gather this information before running Setup.

After the antenna is configured, run the Antenna utility to test the connection between the
antenna and IRIS.

You should also use the Antenna utility to test the antenna's built-in safeguards. These
safeguards ensure that the antenna does not exceed its elevation limits. It may require 2
people: 1 to run the utility, and 1 to watch the antenna.

More information

‣ Antenna overview (page 24)
‣ Setup overview (page 149)

2.2.2 Monitoring Antenna
The Antenna utility gives you access to the radar control features, including:

• Setting the azimuth and elevation position and velocity.
• Turning on the transmitter radiate, servo power, and transmitter power.

The Antenna utility also displays antenna status information, including:
• Airflow
• Waveguide pressure
• Magnetron current
• Transmitter radiate on, off, and warning status

After installation or routine maintenance, use the Antenna utility to test the interface
between the antenna and IRIS.

Do not run the Antenna utility when IRIS is running because it may interfere with commands
that IRIS sends to the radar control processor. Instead, use the Radar Status menu, which
gives you access to the same antenna status information without interfering with IRIS
commands. See IRIS Radar User Guide (M212926EN).

2.2.3 Testing Antenna
When analyzing antenna problems, start with the Antenna utility's RCP I/O Summary menu.
It can help diagnose problems on the serial line. For example:

• If the output count is frozen, the computer is not transmitting data.
• If the input count is frozen, there is no I/O coming from the RCP.
• If the error count is incrementing rapidly, you may be using the wrong antenna format

or baud rate.

If the I/O and error counts appear normal, the problem is not with the serial line. You should
then look at the Antenna status panel, which may show an error or fault for one or more
antenna controls.
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You can also run the Bitex utility to see if the BITE packets are coming across the line.
Information in the BITE packets can further pinpoint the cause of the problem.

More information

‣ Remote monitoring with Bitex (page 77)

2.3 Radar signal processor
Radar signal processor (RVP) software triggers radar measurement by producing the trigger
signal for the transmitter using the intermediate frequency digital receiver (IFDR) unit in the
receiver.

For more information, see RVP10 User Guide (M212604EN).

2.3.1 Configuring signal processor
After you install the IRIS hardware and software and before you run the signal processor,
you must run the Setup utility. This utility provides commands with which you define the
parameters of the radar transmitter, so that the signal processor can process the radar
information that it receives.

In the Radar signal processor (RVP), you define the parameters of the radar transmitter/
receiver, including:

• Wavelength
• Pulse width
• Minimum, maximum, and default PRF
• Transmitter, receiver and test signal losses

This information is available in the manufacturer's specification.

More information

‣ Setup overview (page 149)
‣ Ascope overview (page 39)

2.3.2 Calibrating signal processor
When the signal processor is configured, each of the connections between the transmitter/
receiver, signal processor, and IRIS must be adjusted and calibrated to ensure the most
accurate results.

The RVP Digital Receiver alignment does not require the radar utilities for installation,
except for the Zauto (or manual Zcal) utilities which are used for calibration.

The alignment can be done using the Dspx utility.

More information

‣ Dspx overview (page 112)
‣ Zauto overview (page 251)
‣ Zcal overview (page 269)
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2.3.3 Monitoring signal processor
You can use the Ascope utility to monitor the signal processor. It lets you control the
antenna position and velocity, sample data either once or continuously, and plot from one to
four output parameters in a graphical display. For example:

• Plot the reflectivity and Doppler spectrum to determine how much dynamic range is
available in the linear channel for clutter correction.

• Plot the mean velocity against range to make sure the velocity sign is correct.
• Plot the Doppler power spectrum at a selected range to examine weather targets in

detail.

2.3.4 Testing the signal processor
The RVP signal processor performs a series of self-tests when it is powered up.

The Dspx utility can help troubleshoot problems with the signal processor, especially when
developing new hardware or software interfaces to the signal processor.

See RVP10 User Guide (M212604EN).

More information

‣ Dspx overview (page 112)
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3. Running IRIS utilities

3.1 Running IRIS utilities overview
Utilities can be run in a terminal locally or over the network for remote operation and
maintenance.

You must be a radar operator to run the IRIS Utilities. Observers cannot run
any utilities that may affect the system configuration or operation.
CAUTION!

IRIS and RDA utilities can affect the calibration and operation of the radar system and can
only be run by IRIS operators (radarop). All the utilities are available on both IRIS and
RDA systems.

You can access utilities that use the signal processor without quitting the IRIS program
(service iris stop).
You can access utilities that use the signal processor without quitting IRIS by setting IRIS 
Radar Status Menu > Radar Process off.
Alternatively, use the -demo option which is available for many utilities. This allows you to
change and store values. Changes do not take effect until you restart IRIS (service
iris stop and service iris start).

3.2 Running utilities locally from a terminal
window

Use the terminal window if the workstation is connected directly to the signal processor
through the Ethernet.

RCP often runs on the same machine. If it is on a separate machine, it is connected the
workstation through an Ethernet or serial line.

1. To start a terminal on the local workstation, right-click the desktop and select New 
window.
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2. Type the name of the utility followed by any options (for example, -demo).

Type & after the utility name to free-up the terminal after the utility is started. For
example:

$ ascope -demo &

Type utility names in lower case. To view a list of available options, type the name of the
utility and the option -help. For example:

$ ascope -help

3.3 Running utilities remotely from a terminal
window

If you are working from a network workstation, you can export a utility display over the
network to your workstation.

For example, if you are at a central maintenance facility, you can calibrate or configure a
system remotely.

Make sure your communications bandwidth is adequate.
The Ascope utility is the most demanding in terms of bandwidth.

1. To start a terminal on the local workstation, right-click the desktop and select New 
window.

2. Use ssh to log in to the workstation where you want to run utilities. For example:

ssh -X nodename

where nodename is the host name of the network node you want to go to.

Depending on your security set-up, you may be prompted for a password, or denied
access. For more information, contact your system manager.
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3. Assign the display to show your system by typing:

$ export DISPLAY= mynodename:0.0

where mynodename is the host name of the workstation that you are on.

4. Type the name of the utility followed by any options (for example, -demo).

Type & after the utility name to free-up the terminal after the utility is started. For
example:

$ ascope -demo &

Type utility names in lower case. To view a list of available options, type the name of the
utility and the option -help. For example:

$ ascope -help

3.4 Running commands with root privileges
IRIS RDA software does not include a root account. To run commands that require root
privileges:

1. Log in as admin.

For servers installed at Vaisala, the default password is: Va1sala!
2. Type sudo at the beginning of the command.
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4. Antenna utility

4.1 Antenna overview
The Antenna utility allows you to manually control and monitor the radar and antenna. The
radar host computer communicates with the Radar and Antenna system over a serial line
connected to the radar/antenna control processor (RCP). The Antenna utility allows you to
communicate easily with the RCP to test the features of the RCP and its interface to the
radar system, including:

• Setting both the Azimuth and Elevation positions or velocities.
• Turning the servo and the transmitter radiate and cabinet powers on and off.
• Checking the Computer/Local switch position.
• Checking the status of the cooling airflow, waveguide pressure, transmit Radiate/OFF/

Warning status, magnetron current, and time stamp.
• Tracking the movement of the sun.

Not all of the readouts and controls, described in this chapter, are available on all systems.

At a new installation, or after extensive maintenance, you should run the Antenna utility
before running IRIS to test the interface between the IRIS host computer and the RCP.

4.2 Invoking Antenna
Antenna is an operator-privileged program for experienced maintenance personnel. IRIS
observers and others are not permitted to run this utility.

Radiation / crushing hazard
When the antenna is moving and the transmitter is radiating, there is a risk of people
getting hit by the antenna or exposed to radiation. Before running the Antenna utility,
make sure there are no people in the area surrounding the radar antenna.

WARNING!

To avoid damage to the antenna, use the Setup utility to configure the antenna
limits and signal processor pulse widths.
NOTICE!

Do not run the Antenna utility while IRIS is running because of the possibility of interference
with IRIS commands to the RCP.

During IRIS operation, most of the monitoring information available in the Antenna utility is
shown in the IRIS Radar Status menu.
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1. In the command line type: antenna&

4.3 Antenna menu

Figure 2 Antenna utility

Azimuth and Elevation panes
Controls the azimuth and elevation positions and velocities for the antenna.

Control Panel
Turns the transmitter, radiate, servo, signal generator, and continuous wave powers on
and off.

Status Panel
Displays the status of the radar and RCP.

The title bar contains the current date and time so that this information can be saved on
menu printouts.
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4.3.1 Azimuth and elevation section

Figure 3 Antenna azimuth and elevation panes

Azimuth position indicator

To set the azimuth position, move the arrow along the edge of the position indicator. The
pointer displays the movement of the antenna to the new position.

Elevation position indicator

To set the elevation position, move the arrow along the edge of the position indicator. The
pointer displays the movement of the antenna to the new position.

Mode

The Antenna utility can operate in the following modes:
• Position

Enables setting the azimuth or elevation position.
• Velocity

Enables setting the azimuth or elevation velocity.
• Sun Tracking

Invokes a sun tracking procedure, which computes the direction to the sun from the
radar location, and positions the antenna there. See Running Antenna in sun tracking
mode (page 33).

Stop

Select Stop to stop antenna movement, regardless of the current mode. The antenna slows
to a stop as indicated by the pointer within the position indicator.

The stop light is red when the antenna is stopped and green when the antenna is running.

Sun Tracking

The blue and yellow Sun Tracking button puts the antenna into the Sun Tracking mode.

Select this button again to exit Sun Tracking mode.

Sun Tracking

While in Sun Tracking mode, before moving the antenna you can enter an offset to be
added to the sun's position the Error field allows.
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Sliding scale

The sliding scales set the requested velocity for either the Azimuth or Elevation position.
The scale has a "tick" at velocity 0. For the Azimuth velocity, positive speeds are for
clockwise scanning while negative speeds are for counterclockwise scanning. For the
Elevation velocity, positive speeds are for upwards scanning (toward the zenith), while
negative speeds are for downward scanning (away from the zenith).

Position: Actual and requested

The screen displays both the actual and requested position of the antenna, as they may
differ.

When the antenna is in the Position mode, you may enter a position (in degrees) in the
Request field. Both the Azimuth and Elevation positions can be observed to change and
ultimately end up at or near the requested positions:

• Azimuth positions range from 0 ... 360º
• Elevation angles beneath the horizon are displayed as negative numbers.

The RCP has its own "soft" elevation limits. If the antenna elevation does not move all the
way up or down, to fulfill a position request, the request may be outside the limits
imposed by the RCP. Consult with your manufacturer if you are unsure.

Some RCPs cannot move both axes of the antenna, in a velocity servo, at the same time. On
these systems, the following message may be displayed at your request:

WARNING: Bad Combination of Servo Types.

Velocity: Actual and requested

The screen shows both the actual and requested velocities of the antenna, as they may
differ.

When the antenna is in the Velocity mode, you may enter a velocity in the Request field.
Enter the speed as a signed number (in degrees) per second. Six degrees per each second is
equivalent to 1 RPM:

• For the Azimuth velocity, positive speeds are for clockwise scanning while negative
speeds are for counterclockwise scanning.

• For the Elevation velocity, positive speeds are for upwards scanning (toward the
zenith), while negative speeds are for downward scanning (away from the zenith).

If a velocity request exceeds the maximum velocity allowed by the configuration, set in the
Setup utility, then the maximum velocity is substituted.

For example: If the upper limit in the Maximum Elevation field of the RCP section is 80° and
you enter an elevation position of 90°, the Request field displays 80° and the antenna
increases to that elevation. See Antenna characteristics (page 175).

During installation, you must test this feature to verify that the protection is functioning
properly. See Testing Antenna safeguards (page 32).
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Velocity and Increment

To set the Velocity field with the sliding scale, click inside the scale to move the slider.

To make fine adjustments, set the Increment field to 0.1 and click until the correct value
appears in the Request field.

Platform parameters

Use these parameters to manage the setting for moving platforms such as the pitch, the roll,
and the heading angles and velocities.

More information

‣ Stable Platform display (page 35)

4.3.2 Control Panel

Figure 4 Antenna Control Panel

The Control Panel controls the transmitter receiver and radiate, the servo, and the signal
generator powers. The indicator lights changes from red to green, indicating if the power is
off or on.

TR Power
Requests the RCP to turn the main power on or off to the transmitter/receiver. When
the power is off, many of the sensed status fields are reported as faults.

Radiate

Radiation hazard
Do not turn on radiation until you are sure nobody can be exposed to microwave
radiation.

WARNING!

Requests the RCP to turn the transmitter radiate on or off. If there is a problem with a
subsystem, such as the waveguide pressure or cooling airflow, the RCP may not grant
a radiate request.

Servo Power
Requests the RCP to turn the antenna servo amplifier on or off. When the servo power
is turned off, the antenna position cannot be controlled.
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Signal Generator
Toggles the calibration signal generator on or off while the sliding scale sets the power
level. Status fields display the current state of the Signal Generator, such as ON and
OK. Other status fields indicate the power-level setting.

Continuous Wave
Toggles between continuous and pulse mode.

Noise Source
Turns the noise source on and off within the radar receiver. This is usually done for
testing purposes only.

4.3.3 Status Panel

Figure 5 Antenna Status Panel

Ant Mode and TR Mode

The antenna and transmitter modes show the position of the control switch on the radar
console and indicate when IRIS is collecting radar data:

• Computer
The computer controls the antenna and RCP.
For normal operation, set the TR Mode to Computer and the Antenna mode to local
mode.

• Local
Antenna control requests from the computer are ignored, and the antenna is controlled
manually using handwheels or a terminal connected to the RCP.
This mode is used for testing though, on some systems, you may record manual scans
and run Ascope in local mode.

• IRIS
Status when IRIS is controlling the antenna to record data. The control switch is set to
Computer.

Other status indicators

Other status indicators report OK, Ready, or Fault. Not all systems have the same status
indicators, but the following are typical on most systems:

• Air Flow refers to the flow of cooling air in the transmitter/receiver cabinets. This is
usually sensed by a vane switch.

• Waveguide pressure is usually sensed by a pressure transducer.
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• Interlock refers to the interlock on a door that protects a high-voltage or radiation
hazard.

• Magnetron displays whether or not the magnetron current is within normal limits.

During installation, check the Antenna utility to verify that the sensors are properly installed
and reporting to IRIS.

Pulse width
• The first number is the pulse width that is currently being requested by the host

computer.
• The second number is the pulse width status reported back from the RCP to the host

computer.

The pulse widths here are referred to by index rather than microseconds. IRIS supports up to
4 pulse widths and the indices are labeled 0, 1, 2, 3. Most systems only use 2 pulse widths (0
and 1).

In most systems the RCP controls the pulse width. In this case you can use the control
button next to the pulse width status field to change the pulse width. The selection menu
displays both the index and the value in microseconds.

For systems where the signal processor controls the pulse width, this button cannot be used
to change the pulse width. The proper request and status is reported however. Note that in
this case the Ascope utility can be used to change the pulse width.

RCP status

Indicates whether the RCP has shut down by displaying either OK or Shutdown.

RCP reset

The RCP button resets the antenna controller. The button takes the antenna controller out of
the shutdown state.

4.4 Antenna commands
The Antenna utility provides the following commands:

Options
I/O Summary shows a summary of antenna I/O operations.

Time Set sets the system clock.

Stable Platform Params adds a center portion to the display which shows information such
as heading, pitch, roll related to shipboard or airborne applications.

Print
Print creates an X-window dump of the menu you are running, as follows:

• Print > to Printer sends the output to the postscript or color printer specified in the
Printer Setup menu.

• Print > to File sends the output to a file in your default home directory.
• Print > Setup lets you configure the printer on your system.
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Exit

Exit exits the utility.

Help
On Utility displays information about the utility.

Contents and Index provide access to the online help.

More information

‣ Stable Platform display (page 35)

4.4.1 RCP I/O Summary
Select Options > I/O Summary, the Antenna utility displays a summary of the information
gathered by the antenna process.

When the IRIS or Antenna utilities first run after boot-up, an internal antenna process starts
in the IRIS host computer. This process monitors I/O to the RCP, runs until it is stopped by a
qant command or until the computer shuts down.

Figure 6 RCP I/O Summary

RCP Status
The status of the RCP, either OK or Shutdown.

Update Time
The time in seconds since the last update was received from the RCP by the antenna
process.

Input Count
The total number of bytes read by the antenna process since it was started.
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Output Count
The total number of bytes written.

Error Count
The total number of bytes received that were discarded because of an error.

4.5 RCP serial line time reports
The RCP serial line can receive time reports. You can check the time sent from the RCP and
the time error between the host system time and the RCP time. You can also reset the
system time to match the time reported from the RCP or configure automatic time updates.

All automatic updates by IRIS are made only if the time error is 2 ... 5 seconds. This
compensates for the slow drifts that are typical of computer clocks. However, when
automatic time setting is first invoked, there is usually an error greater than 5 seconds.
In this case, the Time Set menu is a convenient way to force synchronization, after which
the automatic time resetting tracks the time.

1. For the question Operating system's time, select Setup > General.

See IRIS general setups (page 188).

2. To show RCP time settings, select Options > Time Set.

Last Reported Time
The last time report that was received from the RCP.

Seconds from Last Report
The number of seconds elapsed since the last time report.

Time Error
Defined as the system clock minus the RCP time, for example, for positive
numbers the system time is fast.

If the fields are blank, then you are not receiving the time from the RCP. Check with
your system manager to see if your RCP has this feature.

3. If the time is received from the RCP, select the Set Time button to reset the system time
to match the RCP time.

4.6 Testing Antenna safeguards
The host computer provides no elevation limit protection in the velocity servo mode.
Protection is provided by the RCP. You must use the Antenna utility to verify with the that
the RCP provides limit protection.

All antenna systems are equipped with safeguards against damaging the antenna during
elevation scanning. During installation these safeguards may not be in place.

After installation, you must test the safeguards with the Antenna utility.
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1. The first time you use elevation velocity scanning, position an observer safely near the
antenna to watch and listen for signs that the antenna drive is trying to push against
the stops.

2. In the terminal prompt, type antenna&
3. Set the antenna controls as follows:

a. Set the elevation position to 75.

This positions the antenna elevation close to the upper limit.

b. Set the Elevation Velocity field to 5° per second (first + then -) to move the antenna
slowly up, then down.

Crushing hazard
For the safety of the observer, be ready to stop the antenna if there is a
problem.

WARNING!

4. Start the antenna and be prepared to stop.

5. Make sure you hear the antenna drive stop when the RCP soft limit is encountered.

The soft limit must be encountered before the limit switch is encountered. If the
antenna tries to power up past the soft limit, you must signal the operator to stop the
antenna.

4.7 Running Antenna in sun tracking mode

Figure 7 Antenna in sun tracking mode

In sun tracking mode, the Antenna utility computes the direction to the sun from the radar
location and positions the antenna there.

The purpose of the sun tracking mode is to test the alignment of the radar pedestal.
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Because the sun is a black body radiator, it transmits microwaves that you can detect with
your radar, even through the clouds.

The test consists of moving the antenna until you get the maximum return from the sun and
then comparing the pedestal angles with the known position of the sun.

1. Stabilize and tune the antenna.

The antenna must accurately go to a requested position to within less than 0.2°.

2. Set your system time.

Vaisala recommends that you set the time to within a second of the correct time,
though a 10 second error gives only a 0.05° error.
If you are using time synching, such as ntp, set the time on the server system or turn
synching off.

3. Verify that your latitude and longitude are set correctly.

For a shipboard radar:

a. Run Antenna.

b. Select Options > Stable platform params.

c. For systems without an INU, check setup/rcp.

See Radar site and antenna placement (page 174).

4. Perform the test when the sun is low in the sky.

At high elevations, the sun is so wide in azimuth that you cannot measure the azimuth
offset accurately.

5. Configure and save a sun-track mode for Ascope.

We recommend turning off range normalization, displaying T only, sample size of 256.

6. In Antenna, start sun tracking mode by selection the sun icon.

In sun tracking mode, the position indicators are yellow circles displaying the sun's
current azimuth and elevation positions.

a. Using the Increment menus, set the azimuth and elevation steps to 0.5°.

b. Select either side of the yellow dot on the control panes to change the azimuth and
elevation offsets until you find the sun.

The power displayed on Ascope should be several dB above the noise.

c. Check the Request field that displays the azimuth and elevation settings of the
antenna.

The utility updates the position every 10 seconds, which usually produces a change
of about 0.01° on both axes.

d. If needed, use the Errors field to specify an offset to add to the sun's position before
moving the antenna so you can correct for errors.
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7. Set the step to 0.2°.

a. Make a pass through each axis.

b. Make a table of the power against angle error.

You should be able to determine the error at the peak.

8. Repeat the same test with the sun in a different azimuth direction (morning against
afternoon).

This allows you to differentiate a tip in the pedestal from a fixed offset.

9. Enter the measured errors in your antenna controller.

If you are unable to find the sun manually with small offsets, it may be because of a
large unknown offset.
If the weather is clear, you may be able to spot the sun on the antenna to indicate the
correct direction.
Alternatively, configure an IRIS sector scan centered on the sun and see if you can spot
it on the real-time display. For RCP:

a. Enter TTY setups

b. Enter the axis azimuth command and set the Input offset from true
orientation.

c. Type the measured error value.

d. Do the same thing for the axis elevation.

If there was a non-zero offset before, you must add the new error to it.

4.8 Stable Platform display
Antenna > Stable Platform Parameters parameters are for shipboard or airborne
applications where the antenna is stabilized by a radar control processor that is connected
to an inertial navigation unit (INU).

The INU provides high-speed accurate information on the attitude (heading, roll and pitch)
and position (East-West, North-South and height) of the ship.

The RCP uses this information to correct the antenna scanning for the ship motion, that is,
the RCP moves the antenna in 'earth-relative coordinates' just as if the antenna were not on
a moving platform. The concept of 'pedestal-relative coordinates' refers to how the antenna
is moving relative to the pedestal, or since the pedestal is mounted on the ship, relative to
the ship.

Since the motion of the ship effects the Doppler velocity, the Antenna utility also calculates
the velocity correction that is required to remove the effect of ship motion.
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Figure 8 Stable Platform Parameters

Attitude and Change

Train-order and elevation-order angles are displayed including the platform-relative pointing
angles of the antenna pedestal.

• Heading
The angle in which the bow of the ship points measured positive toward true North.
Positive angles are clockwise.

• Pitch
The up/down angle of the bow of the ship relative to the horizon. Positive angles are
bow down.

• Roll
The up/down angle of the side of the ship (normal to the long axis of the ship) relative
to the horizon. Positive angles are port (left looking forward) side down.

Each of the above parameters are associated with rates of change in degrees/second.

Position and Velocity

The motion of the INU is described in the middle section of the display as shown below.
• Long/EW and Lat/NS

Standard conventions are used for North/South and East/West.
• Height (m)

The height of the INU rather than the antenna in meters above sea level.
• Ship Vel m/s

The speed (vector (3D) velocity) of the INU, or the center of the ship in meters per
second.
The first entry is positive east, the second entry is positive north and the third entry is
positive up.

IRIS and RDA Utilities User Guide M212925EN-D

36



• Ant Vel m/s
The 3D vector velocity of the antenna feed in meters per second. Generally different
from the INU velocity.

The difference between the ship velocity and the antenna velocity is because the INU and
the antenna feed are usually not co-located, that is, there is a moment arm between them.
When the ship pitches, rolls and yaws, this moment arm induces a velocity.

The INU is not assumed to be at the center of rotation of the ship.
If you imagine yourself on a tall mast of a ship where antennas are typically mounted, the
rocking of the ship is amplified by the mast. If the INU is located on the deck and the
antenna is aloft, this difference is important.

Pedestal Angles and Velocity Correction

Although the RCP corrects the antenna scanning for the motion of the ship, sometimes it is
important to see the antenna position relative to the pedestal.

When the ship motion is severe, the antenna may be unable to achieve an earth relative
elevation because the antenna encounters an elevation limit of the pedestal.

• AZ
The azimuth angle of the antenna relative to the bow of the ship. Positive values are
clockwise from the bow.

• EL
The elevation angle of the antenna relative to the deck of the ship.

• VCOR
The Doppler velocity correction required to compensate measured Doppler velocities
for the ship motion.
The displayed velocity correction (Vcor) represents the velocity correction in meters
per second that must be applied to the Doppler rate.
The Vcor computed by a dot product of the antenna velocity with a unit vector
pointing in the direction of the antenna.

More information

‣ Antenna commands (page 30)
‣ Azimuth and elevation section (page 26)

4.8.1 Viewing Stable Platform Parameters
Invoke the display if your system is configured for shipboard operation with an inertial
navigation unit (INU), that is, the RCP data format RCV03 with shipboard information is
selected in the Setup utility.
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1. Select Options > Stable Platform Params.

The Antenna utility display changes to show:
• Stable Platform Parameters panel
• On the Azimuth panel, a small yellow triangle on the outside of the compass ring

denotes the ships heading.
In the example, the triangle is at 290°.

• On the Elevation panel:
• The solid red arrows show the earth relative antenna positions. This is the same

as if the antenna were not on a moving platform.
All antenna scan velocity and position requests are made in earth-relative
coordinates. This means that the Antenna utility for a moving platform behaves
in a manner identical to the fixed platform case.
The RCP makes the necessary corrections to the scanning.

• The yellow outline arrows show the pedestal relative antenna positions.
In the example, the ship is heading 290.85° and the earth relative position is
217.62. The pedestal (ship) antenna position is 283.97°.

Shipboard features on the Azimuth and Elevation panels are display-only.

4.8.2 Sun tracking check of Stable Platform corrections
In sun tracking mode, the antenna should track the sun regardless of the ship motion.

You can use the Ascope utility, digital power meter, or oscilloscope to monitor the received
power.

This is an excellent final check on the stabilization of an antenna system on a moving
platform.
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5. Ascope utility

5.1 Ascope overview
The Ascope utility is a diagnostic and test utility for aligning and testing the radar and signal
processor.

Ascope also provides a standalone radar display and control capability. Displays of the
signal processor output data, such as a single Doppler spectrum, time series, or raw A/D
samples are generated against range in a graphical format.

During Ascope operation, the antenna is usually controlled by hand wheels or the Antenna
utility to select interesting targets.

5.2 Invoking Ascope

Before running Ascope, you must run the Setup utility to install the proper
wavelength and pulse width configurations. The latter is especially important for duty
cycle limit protection.

NOTICE!

1. In the command line, type: ascope&
If needed, use one of the available command options:

Option Description

<filename> Preload a saved configuration.

-demo Runs Ascope without the signal processor, for testing and
demonstration purposes.

-step Start Ascope in single-step mode.

-stats Display additional signal statistics.

-delay millisec Set delay between rays (default 200).

-display DispName Move ASCOPE to another display device.

If Ascope cannot communicate with the signal processor (for example, if the signal
processor is not turned on), it displays an error message.
If this happens, repair the problem and restart Ascope.
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5.3 Ascope menu

Figure 9 Ascope utility

Antenna Status
Shows information about the antenna status.

Display Status
Freezes and resumes the display and set display parameters, such as the plotted data.

Radar Status
Shows radar status information, such as the PRF and pulse width settings.

Processing Status
Shows information about the processing mode and other processing options.

Filters
Sets the Doppler, LOG, Speckle, and Threshold filters.

Calibration
Shows information about DSP calibration. You can take noise samples or set A/D
converter offsets and gains.

More information

‣ Ascope plots (page 51)
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5.3.1 Antenna status

Antenna
Displays the antenna status as one of the following values:
• OK

The antenna is functioning properly.
• Dead

No data has been received from the RCP for at least five seconds.
Select the button to start the Antenna utility. See Antenna overview (page 24).

Time
Shows the time between successive frames of the display.

Azimuth
Shows the current azimuth of the antenna. Tag lines must be wired for this.

Elevation
Shows the current elevation of the antenna.

5.3.2 Display status

Freeze/Resume
Freezes or unfreezes the display, and stops or starts the signal processor. The green
light indicates that the display is not frozen and the signal processor is running; the
red light indicates that the display is frozen and the signal processor is not running.
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Plot Parameters
Shows the currently selected plot parameters. Select the button to launch the Plot
Parameters menu, where you can select from one to four plots displayed in the order
you choose.
You can set up to 8 parameters can be selected at once . The first 4 are plotted on the
display. See Data recording and playback (page 58).

Choose the plot parameters you want to display.
If you specify fewer than 4, the specified plots are displayed.
If you specify more than 4, only the first four are displayed.
If you select Clear, no parameters are selected and Ascope displays one plot: the
reflectivity against range plot.

Max Range
Shows the maximum range plotted for the selected plot parameters. You can also
specify a new maximum range by entering any number or choosing from a menu. If
the specified Max Range exceeds the unambiguous range, then the unambiguous
range is substituted. The maximum range is constrained to be an integer multiple of
the signal processor resolution multiplied by the number of range bins.
Menu choices are: 20, 40, 60, 120, 240.
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Range Strobe
Shows the value of the selected range for the spectrum and time series plots, as well
as the range for the numerical values displayed in the parameter against range plots.
This range is also used for noise samples. The Range Strobe is displayed in the plots
as a vertical red line. You can change the value of the Range Strobe field and the
position of this line in a number of ways:
• Enter a value directly in the field, and the line is moved to the new position. If the

range you enter exceeds the Max Range, then the value for the Max Range field is
substituted, and the vertical line is displayed at the far edge of the plot.

• Click the left mouse button in the plot. The vertical line moves to that location and
the value of the Range Strobe field is updated to the new value.

• Use the right or left arrow keys to move the line to the right or the left. The value of
the Range Strobe field is updated to the new value.

The Range Strobe is rounded to exactly hit the nearest processed range bin.

Number of Bins
Shows the number of range bins being plotted. Select the button to select the number
of acquired bins.
The maximum value that this field can have depends on the signal processor.
The number of bins determines the number of points plotted on the parameter
against range plots, including the Z, T, V, W, AI, AQ, and ALOG plot parameters.
Reducing this value can increase the update rate because less data needs to be
transferred. This is useful when more rapid updates are required, especially for serial
line graphics displays.

5.3.3 Radar status
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PRF
Shows the current PRF selection in pulses per second.
• The left box shows the requested PRF.
• The right box shows the measured PRF.
You can set these fields to any number between the minimum and the duty cycle limit,
or choose a value from the menu (Options are: 250, 300, 500, 600, 1000, 1200).
In configurations using an external trigger these numbers may differ.
The value shown is the higher PRF if dual PRF is selected.
The PRF should be set to 300 or greater when using alternating polarization.

Ascope automatically limits the PRF to be within the duty cycle limit of the
transmitter as configured in the Setup utility.
You must run the Setup utility before running Ascope.

Dual PRF
For automatic velocity unfolding. This field shows None, 3:2, 4:3, or 5:4.
When you change this value, the velocity limits on the data plot are changed
appropriately. Note that the PRF displayed as part of the status is the higher PRF rate.
If any plots require time series, Dual PRF is set to None (no unfolding). There is no
unfolding when I, Q, L, AI, AQ, ALOG, or Spec displays are plotted.

Pulse Width
Shows the current pulse width in microseconds. You can change he pulse width can be
changed by selecting an option from the menu.
Note that this uses the pulse width signal lines of the signal processor and/or the
antenna controller to set the pulse width. When switching longer pulse widths,
Ascope automatically lowers the PRF as required to stay within the duty cycle limits
established in Setup.

Gain Control
Shows type of gain control used.
Select this field to change the gain control scheme. In the Gain Control menu, select
one of the following:
• AGC

Automatic gain control
• STC

Sensitivity time control
• Fixed dB

Gain at a fixed level of attenuation.
When you choose Fixed dB when you are running in IAGC mode, you can enter
1 ... 3 dB levels. Ascope cycles between these settings.

Select OK to close the menu.

Polarization (available with ZDR option)
Displays the transmitted polarization and lets you set the polarization and switching
scheme. Box is desensitized on single polarization systems.
Options: Horizontal, Vertical, H+V, or Alternating.
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5.3.4 Processing status
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General Setup
Shows a menu displaying the current processing mode and options. You can use this
menu to switch between major modes of the RVP (such as PPP and FFT), and to select
other processing options.
• R2 Algorithms button

Selects whether the computation for spectral width uses three correlation lags (R0,
R1, and R2), or only 2 (R0, and R1).

• Clutter Microsuppression button
Enables the algorithm for removing suspected clutter bins from a run of range
averaged samples.

• 16-Bit Time Series button
Instructs ascope to read extended precision samples during the time series modes.
It should generally be pressed ON. The OFF position causes 8-bit fixed point data to
be read.

• Spectra from DSP button
Causes the Ascope spectrum plot to be drawn from spectral components that are
read directly from the DSP, rather than internally computing those components from
the raw time series.
The DSP spectra are often interesting during major modes that employ spectral
filtering (such as the FFT and Random Phase modes).

• Type of Spectra button
Is sensitized only in Random Phase major mode and only if spectra are being read
directly from the DSP. This button pops up a menu of 8 power spectra and lets you
view the data as they progress through the RVP processing stages.

The buttons in this menu are "live" and take effect immediately. You may keep the
menu up on the screen to compare the results with different settings.

IRIS and RDA Utilities User Guide M212925EN-D

46



Select Exit when you are finished. The Major Mode remains visible in the button on the
main screen.

Pulse Samples
Shows the current number of pulses for averaging of the spectrum moments or for
time series. You can also select the number of samples (pulses) to be averaged into
each of the V, W, Z or T plots; or the number of I, Q or L time series points to be
plotted. The valid range is from 4 to 256. This field also sets the Spectrum Size field.
Menu choices: 8, 16, 32, 64, 128, 256.

Range Average or Smoothing
Sets the number of consecutive range bins to average within the DSP before displays.
Choose None for no range averaging. Smoothing performs an average in range, but
does not reduce the number of recorded range bins. An entry such as 1/4 means no
range averaging, but do range smoothing over 4 bins.
Menu choices: None, 2, 4, 8, 1/2, 1/4. Other values available by type in.

LOG Range Normalization
Toggles range normalization of the LOG channel on and off. In some cases, you may
want to disable the LOG channel range normalization algorithm in the signal
processor. In this case, the reflectivity against range plot displays dBm above
threshold rather than radar reflectivity factor.

Spectrum Size
Shows the number of samples used for a Doppler spectrum. This is always the
greatest power of two less than or equal to the Pulse Samples field. That is, the
Spectrum Size is the value of Pulse Samples field rounded down to the nearest of 4, 8,
16, 32, 64, 128 or 256.
For alternating polarization, this number is the sample size at each polarization, and
the maximum value is 128.

Spectrum Average
Shows the averaging constant for spectrum averaging. The time constant for
spectrum averaging affects only the spectrum display (the Spec plot parameter). The
argument None corresponds to no averaging. The number 8 corresponds to maximum
averaging. This number is the time constant of an exponential average in CPIs. Thus, a
value of 1 means that after spectrum is computed, the previous data has weight 1/e.
You should allow ample time for the spectrum to settle after changing the averaging.
Changing the spectrum size zeroes the averaging. The annotation numbers displayed
in the spectrum plot are also averaged.
Menu choices: None, 1, 2, 3, 4, 6, 8.

Spectrum Window
Select the window to be applied to the time series before the spectrum is computed.
The window dramatically affects the spectrum and can affect the computed SQI
shown on the plot.
The choices are: Black (Blackman), Hamm (Hamming), and Rect (Rectangular).
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5.3.5 Filters

Doppler Filter, LOG Filter

These fields show the current filter selection.

You can select the clutter filter by number. RVP has filters numbered 0 ...  7.

Filter 0 is equivalent to no clutter filter.

See RVP10 User Guide (M212604EN).

2D Speckle Filter and 1D Speckle Filter

The speckle remover thresholds a data bin for which the bin before and after are already
thresholded.

Use this toggle button to clean random data from the display.

Point Clutter

Turns on/off the point clutter remover.

This is a NEXRAD algorithm which runs on the I/Q stream before the data moments are
computed. If it sees a sudden spike in power, it replaces the average values from before and
after in range.
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Thresholds

The signal processor uses thresholding to removes range bins that have weak signal power
or unreliable estimates of the Doppler parameters.

• Select Thresholds to turn thresholding on and off.
• Select Levels to set threshold criteria and levels.

See Antenna overview (page 24) and RVP10 User Guide (M212604EN).

Criteria for thresholding are set for each data parameters (ZT, Z, V, W, Dual Pol, and
Other). You can choose to discard the data when one or more of the following threshold
parameters are weak:

• LOG
LOG receiver signal-to-noise ratio.

• SQI
Doppler channel signal quality index.

• CSR
Doppler channel clutter-to-signal ratio.

• SIG
A measure of the power from weather targets, excluding noise.

You can select, or enter any Boolean equation using the variables SQI, LOG, CSR, and SIG,
separated by and and or.

Choose or enter All Pass to accept any value, in effect turning off thresholding.

To select thresholding levels, enter a value directly or move the sliding scale until the value
you want appears in the field.

LOG
Sets the LOG receiver threshold in dB above noise.
If thresholding is turned on and the LOG video signal is below this threshold level,
reflectivity is thresholded on the reflectivity plots.
Enter a value of 0 ... 5 dB.
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SIG
Sets signal power threshold level in dB above noise.
Often this is used to threshold widths.
If the LOG video signal power is below this threshold after removal of clutter power,
the widths are thresholded.
Enter a value of 0 ... 20 dB.

CSR
Sets the clutter-to-signal ratio threshold.
If the ratio exceeds this threshold, and thresholds are enabled, the Doppler data are
thresholded.
Enter a value of 0 ... 50 dB.

SQI
Sets the Doppler threshold level.
Similar to the LOG threshold level except that it is for the Doppler channel signal
quality index.
If the processor computes an SQI less than the threshold defined here, the velocity
and width data for that range bin are not plotted.
You can enter a value of 0 ... 1.
A value of 0 causes nearly all data to be plotted; 1 causes nearly nothing to be plotted.
A value of 0.3 generally eliminates the weak signals and passes signals that have good
mean velocities.

The "noise points" that get by the threshold correspond to speckles on the color
display.
This is useful for reducing the amount of data that is transferred to serial line
graphics displays.

After you have entered your thresholding criteria and levels, select OK to apply your settings
and exit the menu.

To reset the values to their defaults, select Default.

5.3.6 Calibration
In Ascope, you can measure the current noise level for use during radar calibration.
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Sample 

Takes a new signal processor noise sample at the range specified in Ascope > Display > 
Range Strobe.

For more information, see RVP10 User Guide (M212604EN).

Noise

Select Noise to measure the current noise level by selecting the calibration parameters used
when processing noise sample data.

The parameters are set in RVP or in the calibration information that comes in the IQ stream
metadata.

Do not to take a noise sample when a test signal is present, or the test signal level is
interpreted as the noise level. This leads to erroneous displays of reflectivity.

When you are satisfied with these settings, select Exit.
ZDR Offsets

Shows the ZDR calibration offset, or N/A for systems without ZDR.

You can also use this field to set the ZDR offset. The number you enter is added to the
differential reflectivity to correct for differences in the receiver chain.

More information

‣ Display status (page 41)

5.4 Ascope plots
Ascope can plot 1 to 4 parameters at a time.
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The plots are scaled so that when only one plot is requested, it is zoomed to fill the left side
of the menu.

More information

‣ Ascope menu (page 40)

5.4.1 Reflectivity against range plot (T and Z)

This plot is generated when you choose the T and Z plot parameters.

T is the total reflectivity without clutter correction; Z is the reflectivity with clutter
correction. These are the equivalent radar reflectivity factors and are fully calibrated
estimates.

You must calibrate your radar system before the values are correct. See Zauto overview
(page 251) and RVP10 User Guide (M212604EN).

The Ascope utility lets you temporarily change the slope and offset of the calibration
without modifying the calibration file used for the IRIS system.

The data are plotted in -32 ... 96 dBZ decibel values between 0 and the selected Max Range.
The numerical value in the upper right of the plot shows the reflectivity at the selected
range, indicated by the vertical red line.

See also the Pulse Samples, LOG Filter, Thresholds, Number of Bins, LOG Range Norm,
Calibration ZCAL, and Calibration Slope fields.
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5.4.2 Doppler mean velocity against range plot (V)

This plot is generated when you choose the V plot parameter.

The mean velocity corresponds closely to the peak velocity in the Doppler spectrum display.
Velocity is displayed in m/s on the unambiguous velocity interval. T indicates toward, and A
indicates away.

Similar to the reflectivity plots, the value of the mean velocity in m/s (and normalized to the
interval [-1, +1]) at the selected range is displayed in the upper right corner of the plot.

See also the Pulse Samples, Threshold Levels, Doppler and LOG Filter, Thresholds, and
Number of Bins fields.

5.4.3 Spectrum width against range plot (W)

W

i

d

t

h

5.51 m/s (0.32)
17.0

0.0

Figure 10 Spectrum width against range plot example

This plot is generated when you choose the W plot parameter. The spectrum width is the
standard deviation of the Doppler spectrum. (The Doppler spectrum display itself always
appears broader than the indicated width, because the spectrum is on a log scale).
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Width is displayed in m/s up to the unambiguous velocity value. Broader widths are difficult
to measure.

Similar to the mean velocity, the numerical value of the width is displayed in m/s and for the
normalized velocity interval [-1, +1] for the selected range (as indicated by vertical yellow
line).

See also the Pulse Samples, Threshold Levels, Doppler and LOG Filter, Thresholds, and
Number of Bins fields.

5.4.4 ZDR against range plot (ZDR)
If you have the ZDR option, this plot is generated when you choose the ZDR plot parameter.

The differential reflectivity is the ratio of the reflectivity at vertical polarization to the
reflectivity at horizontal polarization. The range displayed is roughly -8 ...  +8 db.

Similar to the spectrum width, the numerical value of the ZDR in dB is displayed for the
selected range (as indicated by vertical yellow line).

See also the Polarization, Plot Samples, ZDR Offsets, and Number of Bins fields.

5.4.5 Linear channel A/D against range plot (I and Q or
Mag and Arg)

This plot is generated when you choose the I and Q plot parameters against range.

The A/D values are -128  ...  127. The range is 0  ...  Max Range. The number of points plotted
is determined by the Number of Bins field.

The I and Q DC offsets (if any) and average amplitudes are displayed in the status display.
These are important for the signal processor A to D converter alignment. Note that the I
and Q A/D values should never be allowed to saturate (Hit the top of the box). If you observe
saturation, adjust the gain of the converters as described in:

• Coarse adjustment of gain and offset pots (page 71)
• RVP10 User Guide (M212604EN)

The Mag and Arg choices represent I and Q in polar form as a phaser. These plots are
sometimes more intuitive than the I and Q plots.

• The magnitude is the SQRT ( I2 + Q2).
• The phase is ATAN ( Q / I ).

5.4.6 LOG channel A/D against range plots (ALOG)
This plot is generated when you choose the ALOG plot parameter.

This plot is similar to the linear channel AI and AQ plots, but the values correspond to the
LOG channel analog to digital converter. The values are 0 ... 255.

The Z offset is displayed in the status section. This is the average value of the LOG A/D
samples and should be approximately 10 ... 30 A/D units. If it is not, align the A/D converter
according to the instructions in:

• Coarse adjustment of gain and offset pots (page 71)
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• RVP10 User Guide (M212604EN)

5.4.7 Doppler spectrum plot (Spec)
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Figure 11 Doppler spectrum plot example

This plot is generated when you choose the Spec plot parameter. This is the most useful
plot for monitoring the alignment and performance of the Doppler channel.

The Doppler spectrum is computed from the I and Q time series for the selected range. See
Time series at a selected range (I,Q, andLOG) (page 56).

The FFT mode spectrum can be displayed directly. The scale is in dB marked with 20 dB
divisions. Zero velocity is indicated by a vertical line. This is the velocity of ground clutter
targets. The Doppler spectrum plot is always given twice as much vertical height on the
screen as the other plots.

The numerical values in the display are as follows:
• Top left

Linear channel power in dB. This is uncalibrated on an absolute scale. However it is very
accurate on a relative scale as long as the linear receiver is not saturated.

• Top right
Signal quality index or SQI (|R1|/R0). This is a value between 0 (white noise) and 1
(pure tone). This is useful in determining the coherency of the radar system. See
Ascope checkup procedures (page 71).

• Top right (beneath SQI)
RMS phase noise in degrees. This includes noise contributions caused by both
amplitude and phase errors, and is computed directly from the SQI as follows:PℎaseNoise = 180π × −1n SQI

• Time series are clutter-filtered. You can use the filter fields to see the effect of various
filters on the Doppler spectrum.

The typical Doppler spectrum contains white noise at all velocities, a ground clutter spike at
0 velocity, and a weather spectrum. Some points to note:
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• With the clutter filter set to None (no filter), you can observe a strong clutter target to
determine the linear dynamic range of the system. Observe the dB difference between
the peak of the clutter and the white noise.

• Coherent artifacts are caused by leakage of other signals, such as 50 or 60 cycle line
power into the transmitter/receiver system. These appear as peaks located
symmetrically about 0 velocity.
To obtain the best Doppler measurements, minimize coherent artifacts by reducing the
leakage of stray signals.

• Image spectra occur when a weather spectrum has a mirror image on the other side of
zero velocity. Usually the image is smaller than the primary weather peak. Image
spectra are typically caused by the following:
• Saturation of the A/D converters
• Gain imbalance of the I and Q channels

To correct these problems, see:
• Coarse adjustment of gain and offset pots (page 71)
• RVP10 User Guide (M212604EN)

The number of points that are plotted are 4, 8, 16, 32, 64, 128, or 256 as indicated by the
Spectrum Size field.

You can change the number of points in the Pulse Samples field. If a number other than a
power of 2 is entered, the next lowest allowable value is accepted (for example, a Pulse
Sample of 126 sets the Spectrum Size field to 64 points).

When selecting the range for the spectrum, it is useful to display a velocity against range (V)
or reflectivity against range (Z) plot. These plots can show you where there are targets of
interest.

Because spectra can be very noisy, Ascope has a spectrum averaging feature for detecting
weak signals. Averaging causes the update rate to slow down. A value of None corresponds
to no averaging. 8 is the maximum value.

See also the Pulse Samples, Spectrum Average, Spectrum Window, Doppler and LOG
Filter, and Range Strobe fields.

5.4.8 Time series at a selected range (I, Q, and LOG)
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Figure 12 Time series at a selected range plot example
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These plots are generated when you select the I, Q and LOG plot parameters.

I and Q correspond to the linear channel in-phase and quadrature signals, and LOG
corresponds to the LOG channel video signal.

These plots are similar to the AI, AQ, and ALOG plots except that the samples at a single
range are plotted versus time. Each point represents a different pulse.

The Pulse Samples field sets the number of points that are plotted. As with the spectrum
display, the velocity or reflectivity against range plots can help you select a range where
there are interesting targets.

An alternative way to show I and Q is to use the Mag and Arg displays (the phased form of
I and Q). The numerical value displayed in the upper right is the RMS value of the
fluctuations. When viewing a clutter target, these values can be used to assess both the
phase and amplitude stability of the transmitter/receiver.

The RVP time series are clutter filtered. When using the time series plots remember that
the clutter filter removes low velocity signals.
This can be perplexing when a test signal is inserted and no signal time series is observed.
It may be that the clutter filter is effectively removing the signal.

See also the Pulse Samples, Range Strobe, and Doppler and LOG Filter fields.

5.5 Ascope commands
The Ascope utility provides the following commands:

File
Load shows a list of configuration files. Choose the one you want to load..

Save As... lets you save your configuration under the same name or under a new name that
you specify.

Print creates an X-window dump of the menu you are running, as follows:
• Print > to Printer sends the output to the postscript or color printer specified in the

Printer Setup menu.
• Print > to File sends the output to a file in your default home directory.
• Print > Setup lets you configure the printer on your system.

Exit exits the utility.

The named Ascope configurations are stored in the files *.ASCOPE in the config
directory. The default startup configuration is named DEFAULT.ASCOPE

Options
Simulator shows a menu for defining a digital signal. See Digital signal and target simulators
(page 65).

Plots Only removes the plot parameters from the Ascope menu, so that the plots can take
up the entire window.
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Plots/Params shows the plots on the left and the parameters on the right.

Reset Plots

Help
On Utility displays information about the utility.

Contents and Index provide access to the online help.

5.6 Data recording and playback
The Ascope utility can record live DSP data directly to a disk file so that users may develop
their own off-line application programs for custom data analysis. The recording procedure is
interactive and may be invoked any time that interesting data are observed on the display.

You can also play the files back in Ascope to review their contents or check the integrity of
the values.

After you have recorded files to disk, you can archive them to tape using UNIX tar.

5.6.1 Recording data

Figure 13 Record/Playback menu
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1. Configure Ascope normally, so that the weather phenomenon is shown on the screen.

When the Record menu first appears on the screen, Ascope operates the DSP in the
usual continuous manner
To create the configuration that you would like to record, you can modify and all menus,
including the Record menu.

a. Select a maximum range and bin spacing that captures the event at an adequate
resolution.

b. Setup the PRF, clutter filters, range averaging, spectral averaging, and so on, so that
the weather target's characteristics are nicely captured.

You cannot change the Ascope menus during recording.

2. Select File > Rec/Play....

The menu launches in record mode.
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3. In the Plot Parameters menu, select the parameters you want to record.

You can choose up to 16 parameters to be recorded to disk at once. The first 4
parameters are plotted on the screen, and all the selected items are archived.
For example, if you select: Z, T, V, W, I, and Q in that order, Ascope displays the first 4
parameters versus range, and records all 6 as soon as the Rec button is pressed.
If the time step and number of rays were setup for a long interval of recording, you can
monitor the plotted parameters by eye and discontinue recording if the weather event
changes or becomes less interesting.

a. Power spectra:

Ascope can record power spectra, either in place of or in addition to the I and Q
data from which the spectra are derived.
If spectra are recorded on their own, then the size of the data files is reduced by
approximately a factor of 2. This may be significant when many bins of data are
being recorded.
Another advantage that spectra offer is that they can be averaged prior to being
recorded, and thus could supplement the I and Q data in a useful way. For example,
if I, Q, and Spec rays were recorded every 10 seconds, and if the spectral averaging
were set to approximately 10 seconds, then the archived data would contain highly
averaged spectra plus occasional instantaneous time series.

b. Data parameters:

Each data parameter (T, V, Zdr, and so on) is recorded over the full range interval
specified by the maximum range and bin count in the Ascope main menu.

c. Single pulse data samples:

The single pulse AI, AQ, and AL data samples are recorded over the full range
interval.
However, time series and spectra are recorded only at the limited number of bins
specified in the TS Bins field, and centered at the distance of the range strobe.
When the Record menu is visible, this secondary range interval is shown as a pair of
dotted vertical lines drawn on either side of the range strobe. To record time series
and/or spectra, you must choose a nonzero value for TS Bins, and must select I, Q,
and/or Spec from the Plot Parameters menu.

The MAG and ARG parameters are not available for recording to disk. This is because
these parameters are merely computed at display time and are completely
redundant with I and Q. They would not add any averaging or data reduction
possibilities if recorded.
If you press the Rec button while a MAG and ARG plot is selected a warning message
reminds you that you may not be recording exactly what you think. However, the
data file still contains all the other selected parameters.
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4. Select the recording directory in which data files are recorded.

The default is /usr/iris_data/ascope. You can change it to any writable
directory.
Ascope creates the file names automatically in form WWWYYMMDDHHMMSS.ASC where
WWW represents the 3-character local site code, and the remaining characters are the 2-
digit year, month, day, hour, minute, and second at the start of recording.

5. Define the number of TS Bins at which time series and/or power spectra are recorded
(0 ... 128).

The chosen bins are centered on the range strobe selected in the Ascope main menu.

6. In Num of Rays, define the number of rays of data to record.

Each ray represents the data from one complete iteration of the basic Ascope loop, that
is, one acquisition of the set of all data types that are selected in the Plot Parameters
menu.
The maximum number of rays that can be recorded is 10000.

7. Define the Time Step between rays.

This is the time in seconds between successive recorded rays (0 ... 600 seconds (10
minutes)).
Set this value to 0 for a continuous data recording. Use larger values to record over a
longer time interval without creating too large a data file.
For example, a time step of 10 seconds would record 6 rays per minute to disk, even
though the DSP and display still update continuously.

8. Select Rec.

During the recording session, the progress bar indicates the progress.
Recording stops when the full number of rays are recorded and the slider has reached
100% or when you select Stop.
When recording is complete, the Ascope environment returns to normal operation.

9. Select Cancel to return to normal Ascope operation.

5.6.2 Playing back data
Use this menu is to review the contents of the recorded data files, and to check on the entire
recording process. You can select any file for viewing, and display the rays individually or as
a continuous loop.

You can invoke the Playback menu when Ascope is in its normal operation mod, that is,
acquiring live data from the DSP. It may also be used off-line (in a system with no DSP) by
initially starting the utility with the -demo option. Each time you start the menu, the
playback directory is rescanned for files that match the Ascope naming convention. This
collection of files is then displayed in the scrolling list with timestamps.

Each time a new ray is requested from disk, the data values displayed in the plotting area
and all other numeric fields are updated using information contained in the header files
consisting of the time, TAG bits and GPARM information. Also, the azimuth and elevation
angles are displayed, along with the current PRF, error bits, and so on, that were originally
measured with each ray.
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1. Select File > Rec/Play....

The menu launches in record mode.

2. Select Record to > Playback.

The Playback menu appears.

3. Directory from which data files are played. By default, this is the same directory used
for recording. If needed, change to any readable directory containing Ascope data files.
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4. In the list of files, select the file you wish to playback.

The most recently recorded data are always at the top.

a. Stretch the menu vertically to view the entire menu.

b. Use the slider to select the ray number to be displayed.

The left and right limits correspond to the first and last ray within the selected file.
The ray number (starting from 0) is displayed on top of the slider.
Left-click either side of the slider to increase or decrease the ray number by 1.

When you select a file, the Ascope configuration is reloaded from the header of the
data file. This causes all menus and displays to return to the appearance that they had
at the time the recording was made. The name displayed in the top title bar of the main
menu changes to the name of the selected file.
• All Ascope menus are grayed out, except for the Play button and slide pots of the

Playback menu. Ascope is now bound by the original selections of the highlighted
data file.

• The data from the first ray are loaded from the file and plotted on the screen. The
ray selection slide bar is initialized to its left edge (ray #0), and the time shown in
the top title bar changes to the time of this first ray.

• Ascope waits in this state until the file is deselected or you exit the Playback menu.
You can browse the recorded data set using the ray slide bar or the Play function.

5. Select Play and Stop to manage the movie loop playback mode.

When you select Play, Ascope loops continuously through all the rays in the data file.
This is useful for watching a phenomenon evolve over time.

6. Select Pause and Speed to adjust the end-of-loop pause and frame rate during
playback.

The pause at the end of each loop can be up to 10 seconds, and the delay between
successive rays can be up to 2 seconds.

7. Select Cancel to return to normal Ascope operation.

5.6.3 Format of recorded data
The data files are organized as a 1280-byte asc_stats configuration structure, followed by
the individual ray data in their original order of arrival.

For an explanation of the structure, see the public header file ascope.h.

Ascope data file headers

Each ray is prefaced with a 200-byte asc_ray_header structure that holds additional
information from the exact moment that each ray was acquired.

To check Ascope data file headers, type the following command:

dd < RVP8040722170814.ASC bs=1280 count=1 | structmap asc_stats -recursive -
data
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Reading an Ascope data file

To process the contents of an Ascope data file, begin by opening the file and reading the
first 1280-bytes into an asc_stats structure.

Use the actual ray count irec_rays_actual, and ray data length in bytes
irec_ray_size, to divide the remainder of the file into fixed length blocks. Each block
consists of an asc_ray_header structure followed by the ray data itself.

Ray data

The ray data are defined by the iplottypes[] array, which lists up to 16 different data
parameters that were recorded.

Each parameter is stored in its native format as read from the DSP. For information on the
data formats, see IRIS Programming Guide (M212927EN) and the PROC command section in
RVP10 User Guide (M212604EN).

The length of each data parameter array is rounded up to the next multiple of 4 bytes to
make sure that successive elements within the file are aligned on 4-byte boundaries if they
need to be.

There is no difference between I and AI, Q, and AQ, and so on in terms of data format.
However, the A terms span the full range, and the non-A terms span the full pulse count.

The "derived parameters" MAG_AIQ(10), ARG_AIQ (11), MAG_IQ (15) and ARG_IQ
(16) are not recorded on the archive disk, since doing so would not add any more
information than that in the original (I,Q) data. Ascope can plot these parameters (because
that is often handy). If you want to archive this data, include the raw (I,Q) parameters
themselves.

Example

Suppose that a recording is made with the following settings:
• In the main menu: 30 bins and 10 pulses
• In the Plot Parameters menu: T reflectivity and L time series
• In the Record menu: 5 TS-Bins and 7 ray
• In the General Setup menu: 16-bit time series

Then the data file is 3604 bytes long and consists of:
• A 1280-byte asc_stats header
• Seven ray blocks, each 332-bytes long, comprised of a 200-byte asc_ray_header

structure, followed by 32 bytes of T data, and 100-bytes of 16-bit L samples.
The length of the T data was rounded up to the next multiple of four, and that the L
sample length is based on:10pulsesray 5 bins 2 bytesbin × pulse = 100bytesray
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5.7 Digital signal and target simulators
To test the signal processor, evaluate its performance in response to weather targets, and
train personnel, Ascope provides a digital simulators, which allow you to:

• Simulate weather and clutter targets in the host workstation using Ascope in order to
develop operational processing strategies.
You can configure the operational configuration in Ascope, then test it using signals
from the simulator.

• Automatically download the simulated LOG, I, and Q signals to the signal processor
where they are processed as usual.

• View the processed results in Ascope.

Only one range bin is simulated and the resulting I, Q and LOG time series are loaded in
every range bin that is processed.

The technique is based on Sirmans and Bumgarner's (1975: Jour. Appl. Meteor., 14, 991–1003)
signal simulation approach. A Doppler spectrum is constructed with magnitudes that have
Poisson statistics and random phases. This is inverted to provide digital I and Q values. The
Ascope simulation approach is extended to include ground clutter, transmitter/receiver
instabilities, and second trip echoes.

More information

‣ Using the digital signal simulator (page 67)
‣ Using the digital target simulator (page 65)
‣ Data simulations (page 164)

5.7.1 Using the digital target simulator
Use the digital target simulator with Ascope to simulate weather and clutter targets in the
host workstation.

The digital target simulator can simulate up to 4 point targets. You can set the parameters of
each target independently.
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1. Select Options > Target Simulator.

The simulator and its control panel start.

Figure 14 Digital target simulator display and Ascope view example

Cx
Select Cx to indicate that the target impacts the data from the cross-polarization
Rx channel (vertical polarity).

Co
Select Co to indicate that the target impacts the data from the co-polarization Rx
channel (horizontal polarity).

Range (km)
How many km it will affect after the starting range

Length (km)
How far away from the radar the object is.
In the example plot, this is shown in the trapezoid changes. A range of 50 and a
length of 10 km indicates the target occupies the range bins between 50 ... 60
km.
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Power (dB) 
Signal power of the target.

Gradient
How much the power changes over the range of the target.
For example, a Targ-1 target between 50 ... 60 km with the Power of 10 and the
Gradient of -13 dB starts at the signal power of 10 dB @ 50 km and then drops 13
dB down to -3 dB at 60 km.

Doppler (Hz)
Doppler frequency of the target in Hz.

Gradient
How much the frequency changes over the range of the target.

5.7.2 Using the digital signal simulator
You can use the signal simulator to simulate one or two targets that can occur both in the
first trip or the first and the second trip to test the random phase range unfolding feature of
RVP.

The simulator creates a time series across all range bins with the same statistics.
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Figure 15 Digital signal simulator

Signal
Sets the signal power of the meteorological target (dB).
As you raise this value, the Doppler spectrum of weather increases in power.
If the Signal value is larger than the minimum slider value (---), the Signal, Velocity,
and Width parameters define the Doppler Power Spectrum of a weather target with a
Gaussian / Normal distribution.

Velocity
Sets the mean radial velocity (m/s) of the weather target normalized between [-1, +1]
to correspond to the Nyquist interval (fold point).
As you change this value, the Doppler spectrum moves horizontally.

Width
Sets the spectrum width (standard deviation of velocity) in m/s.
As you change this value, the spectrum become broader.
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Clutter
Sets the power (dB) of the clutter signal which has a mean velocity of 0.
As you increase this value, the clutter peak at 0 velocity increases.
The power is calibrated in the same way as the signal power. For example, if both the
Clutter and Signal powers are the same, the clutter-to-signal ratio is 0 dB.

Noise
Sets the power (dB) of the white noise present. If --- then no noise added.
Raising this value causes the noise floor to increase.

Tx. Phase
Sets the sequence of phases used to modulate the time series from pulse to pulse:
Coherent - no phase modulation.
Random - random phase sequence.
For more information, see CFGPHZ host computer command in RVP10 User Guide
(M212604EN).

Second Trip
Adds a second trip to Target #2.
If Target #2 is in the second trip echo (Second Trip is enabled), the Tx. Phase
parameters to give Target #2 a phase shift from Target #1.

RMS Phase
Simulates phase noise. Increasing the phase noise increases the white noise level in
the Doppler spectrum.
If the phase from pulse-to-pulse is the same, this setting defines amount of pulse-to-
pulse Tx phase modulations of the simulated signal.
Typically, a magnetron radar has between 1 ... 3° of phase noise.
A Klystron system can have as little as 0.1° of phase noise.

RMS Power
Defines the pulse-to-pulse amplitude modulations of the simulated signal.

1. Select Options > Signal Simulator.

The simulator starts and the control panel is shown.

2. Configure Target #1.

Disable Target #2 by setting all of the Target #2 slide pots to the far left. This makes it
easier to interpret your results.

Vaisala recommends that you display a Doppler spectrum with 128 samples so that
you can see the results of any changes that you make.
When you are satisfied with the Doppler spectrum that you have constructed, you
can switch to other types of displays.

Chapter 5 – Ascope utility

69



3. Configure Target #2.

a. Define Target #2 settings.

b. Leave the Second Trip button out (disabled) so that Target #2 is in the first trip.

c. Select Second Trip.

You can see the power from Target #2 put into the white noise of the first trip
spectrum.

The signal, clutter, and noise signals for Target #1 and Target #2 are added together to
form a single time series.

5.7.2.1 Velocity, width and intensity display features for testing
The digital signal simulator (DSS) lets you input signals of known properties, then view the
results in the Ascope displays.

Effects of clutter filters, time averaging, and PRF can be determined using the spectrum
display.

The following moment display features are designed to simplify testing:
• The velocity against range plot shows the numerical value (in parentheses) of the mean

velocity normalized to the interval [-1, +1]. This can be compared directly to the value
set in the DSS.

• The width against range plot also shows the normalized value of the width for direct
comparison with the DSS.

• With no clutter power in the DSS and LOG Range Normalization turned off, the Z or T
readouts are 80 dB greater than the DSS setting for signal power (for signal powers
>10 dB).

• With no clutter power in the DSS the MAG(IQ) plot are 3 dB less than the DSS setting
for signal power.

When making comparisons, note that the natural fluctuations of weather echoes are also
simulated. This means that you can see fluctuations in the values, particularly if the
spectrum width and/or the noise power are large.

After you set the DSS, the same time series is loaded into the signal processor every time.
To get a new "realization" select on any of the slide pots that you are using. A fresh time
series is created.

5.7.2.2 Random phase 2nd trip echo testing
You can use the digital signal simulator (DSS) for testing random phase for 2nd trip echo
recovery.

Random phase processing filters and recovers second trip echoes, which can be a serious
problem when operating at high PRF. See RVP10 User Guide (M212604EN).
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To use this feature, random phase features of the RVP must be licensed on your system.

1. Verify that RVP non-volatile setup (under Mb) has digital phase locking enabled.

See Sample Dspx session (page 116) on the dspx utility chat mode.

2. Select Plot Params > Spectrum Display.

3. Select General Setup > Major Mode > Random Phase.

4. Select General Setup > Type of Spectra > Raw #1.

5. On the DSS panel, turn Digital Locking on (button in).

6. On the DSS panel, set Second Trip off (button out).

7. Use the DSS to configure Target #1 and Target #2.

8. Set Second Trip on (button in) to put Target #2 in the second trip.

9. To verify the stages of the algorithm, select General Setup > Type of Spectra > Raw #1, 
#2, and similar.

10. Set up moment plots (Z, V, and so on versus range) to verify the moments.

11. Trace the filtering steps of the random phase algorithm and experiment with different
set-ups for the whitening filters.

5.8 Ascope checkup procedures

5.8.1 Coarse adjustment of gain and offset pots

Perform this procedure when you have adjusted all signal line drivers and you
have checked the I, Q, and LOG video signals with a scope to make sure that they are
within the proper limits of the signal processor A/D converters.
The analog-to-digital converter section of each DSP contains 2 potentiometers for each
digitized video signal. Nominally, I and Q signals should be between ±1 V and the LOG
channel 0 ... 2 V. The potentiometers allow the A/D converter span and offsets to be
adjusted around these nominal values so that the full span of A/D values is available to
the signal processor.
These plots are on the outside edge of the RVP. When signal processors are used for
reflectivity-only processing, then only the LOG video channel must be adjusted.
Otherwise the signal processor could be damaged if an inappropriate voltage is applied.

NOTICE!

For information on the location and use of the adjustment plots, see the section on A/D
alignment in RVP10 User Guide (M212604EN).
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There are two ways of setting these controls. The recommended procedure is to use the
Ascope AI, AQ, and ALOG plots to view the raw time series against range.
For information on setting these controls without Ascope, see RVP10 User Guide
(M212604EN).

1. Run Zauto and check the value of the calibration slope.

Typical values are 0.3 ... 0.5. The default is 0.5.
If the calibration slope is 0, set it to the correct value.

2. Disconnect the gain control output from the processor.

This makes sure that the linear receiver is operating at full gain. If the processor gain is
not used on your system, check with your manufacturer to see how the receiver can be
set to full gain at close range.

3. In the terminal prompt, type: ascope&
4. Set up Ascope as follows:

PRF 250

Max Range 100

Number of Bins 100

Plot Parameters AI AQ ALOG

5. While running Ascope, turn on the transmitter and point the antenna in a direction so
that the main bang of ground return can be observed.

Sometimes it helps to scan the antenna very slowly to get a representative sample of
targets.

a. Make sure all test signals are off.

b. Adjust the LOG offset pot so that the far range noise is approximately 10 % off the
bottom of the plot (as compared to the full range of A/D values).

c. Select Noise to invoke a new noise sample and verify that the Z offset in the status
section is 15 ... 30 units.
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6. Adjust the LOG gain pot so that the saturated main bang at close range is below the
high limit.

a. If there is difficulty observing the saturated main bang close to range 0, reduce the
Max Range field to 10 km (6.2 mi).

b. Readjust the offset as required, because changing the gain can affect the offset.

Another technique is to use an RF test signal generator to adjust the A/D range to
correspond to the dynamic range of the receiver (typically 80 dB).
To do this, use Ascope to observe the LOG channel A/D against range plot (ALOG).
Do not select Noise or leave the Sample Offset Noise Sampling Mode set to
Continuous.
Use the signal generator in CW mode. The transmitter is usually turned off to avoid
damage to the signal generator while it is connected.
Now starting from the minimum value of the signal generator output, increase the
signal level until the LOG A/D values just start to increase. This is the approximate
noise level.
Adjust the gain so that, for example, the LOG A/D values are at approximately 250
when the signal generator level is increased to 80 dB above the noise level.

7. Adjust the I and Q pots until the signal is approximately centered in the display.

a. Select Noise to verify that they are within ±5 units of 0.

b. If not, adjust accordingly.

8. Make sure the gain control is disconnected or otherwise disabled so that the receiver is
operating at full gain for this test.

a. Adjust the I and Q gain pots so that the strongest clutter targets at close range are
just below saturation.

b. Adjust the amplitude of the I and Q signals with the gain pot so that they are equal.

Slight saturation on the very strongest clutter targets is tolerable because no useful
weather information can be obtained in the vicinity of these anyway.

c. Recheck and readjust the offsets as required.

5.8.2 Phase and amplitude stability checks
This test establishes how much dynamic range is available in the linear channel for clutter
cancellation. This is useful for determining the maximum clutter correction that can be
achieved.

Disconnect or otherwise disable the gain control so that the linear receiver is at full gain
during these test.
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1. Set Ascope to run as follows:

Parameter Value

Pulse Width: 0.5

PRF: Highest value

Plot Parameters: T Spec

Doppler Filter: None

LOG Filter: None

Thresholds: Off

Max Range: 20

Pulse Samples: 128

Spectrum Window: Rect

This creates a Doppler spectrum with a fairly rapid update for searching.

2. Use the Reflectivity against Range plot (Total dBZ) to select a range where there are
strong clutter targets and observe the peak-to-noise level for the strongest clutter
targets. You may want to scan the antenna very slowly, stopping at strong clutter
targets. Estimate the peak-to-noise level ratio by eye (20 dB per division) for several of
the strongest targets by estimating the average noise level. Spectrum averaging helps
to reduce the fluctuations. For a 128-point spectrum (Pulse Samples: 128) the clutter to
total noise power in dB is the observed peak-to-noise ratio minus 10 log(128), that
is:

dB(Clutter-to-noise) = dB(Peak-to-noise) - 21 dB
This is a measure of the available dynamic range of the system. If the value is 20 dB,
(typical for a magnetron system), then the maximum clutter correction that can be
achieved is approximately 20 to 30 dB depending on the number of samples averaged
together.

Another way to assess the coherency of the system is to use the SQI and phase noise values
displayed in the upper right corner of the spectrum display. The SQI is a number between 1
(perfectly coherent) and 0 (perfectly incoherent) which is related to the pulse-to-pulse
phase noise, the peak-to-noise and the clutter-to-noise. The following table summarizes
these relationships. Note that the calculations in the table assume you are looking at a pure
clutter target with no weather or coherent artifacts such as 50 or 60 Hz or image spectra.
For example, an SQI of 0.9800 corresponds to a phase noise of 8.1°, a clutter-to-signal ratio
of 16.9 dB and a 128-point peak-to-noise (observable in the spectrum plot) of 37.9 dB.

Table 5 Coherency relationships

SQI Phase Noise
(Degrees)

Clutter-to-Noise
(dB)

128-Point Peak-to-
Noise (dB)

256-Point Peak-
to-Noise (dB)

0.99998 0.26 47.0 68.0 71.0

0.99996 0.36 44.0 65.0 68.0
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SQI Phase Noise
(Degrees)

Clutter-to-Noise
(dB)

128-Point Peak-to-
Noise (dB)

256-Point Peak-
to-Noise (dB)

0.99994 0.44 42.2 63.2 66.2

0.99992 0.51 41.0 62.0 65.0

0.99990 0.57 40.0 61.0 64.0

0.99988 0.63 39.2 60.2 63.2

0.99986 0.68 38.5 59.5 62.5

0.99984 0.72 38.0 59.0 62.0

0.99982 0.77 37.4 58.4 61.4

0.99980 0.81 37.0 58.0 61.0

0.99970 0.99 35.2 56.2 69.2

0.99960 1.15 34.0 55.0 58.0

0.99950 1.28 33.0 54.0 57.0

0.99940 1.40 32.2 53.2 56.2

0.99930 1.52 31.5 52.5 55.5

0.99920 1.62 31.0 52.0 55.0

0.99910 1.72 30.5 51.5 54.5

0.99900 1.81 30.0 51.0 54.0

0.99800 2.56 27.0 48.0 51.0

0.99700 3.14 25.2 46.2 49.2

0.99600 3.63 24.0 45.0 48.0

0.99500 4.06 23.0 44.0 47.0

0.99400 4.44 22.2 43.2 46.2

0.99300 4.80 21.5 42.5 45.5

0.99200 5.13 20.9 41.9 44.9

0.99100 5.45 20.4 41.4 44.4

0.99000 5.74 20.0 41.0 44.0

0.98000 8.14 16.9 37.9 40.9

0.97000 10.00 15.1 36.1 39.1

0.96000 11.58 13.8 34.8 37.8

0.95000 12.98 12.8 33.8 36.8

0.94000 14.25 11.9 32.9 35.9

0.93000 15.43 11.2 32.2 35.2

0.92000 16.54 10.6 31.6 34.6
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SQI Phase Noise
(Degrees)

Clutter-to-Noise
(dB)

128-Point Peak-to-
Noise (dB)

256-Point Peak-
to-Noise (dB)

0.90000 18.60 9.5 30.5 33.5
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6. Bitex utility

6.1 Remote monitoring with Bitex
Bitex is the built-in IRIS software for monitoring and managing radar components remotely.
Remote managing includes resetting faults, starting equipment, switching power systems,
and so on.

Vaisala configures Bitex factory settings before shipping the radar.

Bitex displays status information reported by Built-In Test Equipment (BITE) integrated in
the radar and associated systems and reported through the Radar Control Processor (RCP).
Operator-initiated commands are sent to BITE units through RCP.

BITE typically connects to the RCP through interfaces such as contact closures, analog
voltages, or serial communications. RCP integrates this information and sends it to IRIS for
display in the Bitex utility. These packets are mingled with the RCP antenna controller
commands on the same network port.

RCP can also decode button pushes into control variables for use in logic equations for
complex functions.

Bitex can handle up to 256 pieces of data from up to 16 separate BITE units. For example,
the antenna sub-assembly may be one BITE unit, the transmitter a second, the radar
controller a third, and facility equipment (power equipment, building alarms, and similar) a
fourth.

For more information, see RCP8 User Guide (M212923EN).

For information on setting up and configuring the Bitex, see IRIS and RDA Utilities Guide
(M212925EN) and the project documentation.

Table 6 Bitex status colors

Color Meaning

Green Normal operation

Yellow Warning

Red Alarm

This manual shows the default Bitex views for dual polarization weather radars.
Bitex content varies depending on your system configuration.
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6.2 Invoking Bitex
You can invoke graphically Bitex from the Radar Status Menu.

To invoke Bitex from the command line, type: bitex&.

You can also use one of the Bitex command line options.

Table 7 Bitex command line options

-setup Lets you customize the BITE menu contents and layout.

-upgrade Upgrades old format bitex configuration files to the current format.

-version Prints the version number.

6.3 Bitex window

Figure 16 Bitex Main screen for Vaisala Weather Radar WRM200

Bitex Main Screen
The Bitex Main Screen shows each Bite Unit.

Sub Panels
Select an option on the Bitex Main Screen to show its sub-panel, such as the
Transmitter sub panel.
You may have many or no sub-panels. It is convenient to have a few sub-panels
accessible from the main panel, where each sub-panel represents a different
functional area of your radar BITE.
You can also nest sub-panels, so that from one sub-panel, you can open other sub-
panels.
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Figure 17 Bitex Transmitter screen for Vaisala Weather Radar WRM200

6.4 Histograms
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Histograms of the bitex status data may be viewed in a graphical display format. The output
data points can be analog or digital. The histogram may be opened by right clicking on any
of the bitex panels. You cannot pop up the histograms if you started bitex in -setup mode.
The graphical display can be a valuable tool when assessing the frequency and endurance of
faults.

The time scale for viewing the histogram is adjustable from 10 minutes to 96 hours using the
Time Span slider. The y-axis scale for analog output is also adjustable with the Vertical Span
slider. Each circle represents the time a status packet was received. The graphical display
may be printed to a printer or file.

The histogram data files are created in the ${IRIS_LOG} directory. A new log file is
generated each day at midnight. An IRIS setup question allows the operator to choose how
many days of antenna log files to retain at any given time. Keeping old log files preserved is
helpful for post analysis of problems.

6.5 Bitex commands
File
Save applies the current settings and writes them to disk file called bitex.conf and
bitex_wgt.conf. Save available only if you invoke Bitex with the setup option.

Print creates an X-window dump of the menu you are running, as follows:
• Print > to Printer sends the output to the postscript or color printer specified in the

Printer Setup menu.
• Print > to File sends the output to a file in your default home directory.
• Print > Setup lets you configure the printer on your system.

Exit exits the utility.

Customize
General launches the Bitex Customization Menu, which allows you to set up the serial
stream parameters for each BITE unit.
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Tools launches Bitex tools for creating, deleting, and positioning sub panels and data point
items.

Panel Options allows you to set the current panel name to be set to specify a background
GIF image for this panel.

Display IO Count places a network traffic count in bytes on the top of the Bitex display .

General, Tools, and Panel Options are only available if you start Bitex with the -setup
option.

Help
On Utility displays information about the utility.

Contents and Index provide access to the online help.

6.6 Exporting BITE status information
The bite_export program reads the Bitex configuration and exports configured status
information to a CSV file in ASCII format. The program listens to the multicast UDP
messages and retrieves data from there.

You can set bite_export to run in the background as a service using the /etc/init.d/
bite_export script.

1. To configure the tool, type a command similar to the following example:

${install_root}/bin/bite_export -port 30785 -interval 2 -history -
output /var/log/irisrda/bite_ascii.csv &

Use this command to configure the history option, logging interval, and the output file.
In the example the command logs Bitex status to the defined output file every 2
seconds (-interval 2).
If you change the multicast port, update the configuration here.
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2. To use the -history option, you must configure logrotate.

The -history option does not overwrite the file. Instead, it appends the data to the
end of the file.

If you do not use the -history option, only the latest data is saved to output file
and old values are overwritten.

a. Create and edit the /etc/logrotate.d/sigmet-bite_export file.

The default file contents are:

/var/log/irisrda/bite_ascii.csv {
    copytruncate
    missingok
    notifempty
    daily
    rotate 5
    su root users
}

This copies the contents of the output file once a day to /var/log/irisrda/
bite_ascii.csv.1, from .1 -> .2 and so on. It leaves the original output file
empty.
This configuration stores 5 days of history, each in its own file and deletes log files
older than 5 days.

b. You can configure the rotate 5 parameter to save more history data.

For example, to save 100 days of history, change the value to rotate 100.
This creates files:

/var/log/irisrda/bite_ascii.csv.1
/var/log/irisrda/bite_ascii.csv.2
…
/var/log/irisrda/bite_ascii.csv.100

c. As admin, add file permissions 644 to the logrotate sigmet-bite_export
configuration file with the following command:

sudo chmod 644 /etc/logrotate.d/sigmet-bite_export

d. To check the logrotate configuration, run the debug command:
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sudo logrotate –d/etc/logrotate.conf

Look for the bite_export in the command output and check for errors.
This command indicates what would have happened if the rotate had been run. It
does not rotate the actual log files.

e. To force logrotate to run, type the following command:

sudo logrotate –f /etc/logrotate.conf

This rotates the log files.

3. To manage how bite_export starts and stops, login as admin and use the following
commands.

Command Description

sudo chkconfig --add bite_export Enable bite_export to start automatically
during boot-up.

sudo chkconfig --del bite_export Disable bite_export from starting automatically
during the boot-up.

sudo service bite_export start Start bite_export if it is not already running.

sudo service bite_export stop Stop bite_export.

6.7 Customizing Bitex
1. Invoke Bitex with the -setup option.

See Invoking Bitex (page 78).

2. In the customization menu, make the necessary changes to the configuration.

The customization menus are scratch pads. Changes do not take effect until they are
applied and saved.

3. Select OK.

This applies the changes and closes the menu.
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4. Select File > Save.

5. Select File > Exit.

The configuration is used the next time the antenna driver starts.

6.7.1 General Bitex customization options

To display the BITE Configuration menu, choose Customize > General. This menu is used to
change the format of the BITE packet transmission and reception over the network
communications stream. In normal operation, this menu is not needed. To protect against
inadvertent changes, you must be in setup mode to make changes.

Number of BITE Units
Select from 1 to 16 BITE units. The number of units and the characteristics of each unit
displayed in the menu changes reflecting the setting of the Number of Units.

IRIS and RDA Utilities User Guide M212925EN-D

84



Unit Action
The choices for Unit Action are Receive Status Bits, Receive Status QBITE, or
Transmit Control Bits. Each of the units is configured independently. If the RCP is
configured to send status information to IRIS for this unit, the Unit Action in Bitex
should be Receive Status Bits. Any data point configured for this unit then displays
status information.
If the RCP is configured to receive control information from IRIS for this unit, the Unit
Action in bitex should be Transmit Control Bits. Any data point configured for this
unit is a button for sending actions to the RCP.

Unit Alias
This name is used on the Interrogate menu to identify the purpose for the different
BITE units.

Unit Hex ID Number
Each BITE unit has an identification byte (displayed in hex) which determines the
meaning of this packet. Unit IDs configured in bitex should match Unit IDs
configured on the RCP. Transmit Unit IDs are independent of Receive Unit IDs,
thus they may share the same Unit IDs. But within Transmit IDs or Receive IDs, the
unit numbers must be unique.

Unit Byte Count Packet
For each BITE unit, you must specify the number of bytes expected in each packet,
from 4 to 128. These numbers must match those configured on the RCP for each BITE
unit.

I/O
A display-only field showing the number of characters received from or sent to that
particular BITE unit.

Age
A display-only field showing the time in seconds since the last packet for this
particular unit was received or transmitted.

6.7.2 Using Bitex customization Tools
The Bitex customization Tools allow you to create, delete, or move sub panels and data
points.
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Figure 18 Bitex customization Tools

1. To access the tool bar, in any Bitex panel, select Customize > Tools....

2. Edit your panels using the options in the tool bar:

• Erase Tool: Erases the next data point or sub panel.
• Move Tool: Click, hold and drag the next data point or sub panel.
• Cut / Paste: Cut the next data point or sub panel. When mouse is put over an

unoccupied area and click again, pastes the object just cut.
• Add Data Point: Add a new data point object to the next clicked position.
• Add Sub Panel: Add a new sub panel data object to the next clicked position.

3. To exit the tool, select the Pointer Tool in the tool bar.
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6.7.3 Bitex Panel Options

Use the Bitex Panel Options to configure the following:

Panel Title

The Panel Title value is shown on the title bar of this panel.

Background Image

All panels may optionally have a GIF image to be used as the background.

This image may be simple (such as a solid color), or complex (such as pictures of cabinets
and sub-assemblies, and similar).

To use a GIF background image, type its file name here, or use the selection button to
browse to an image.

The images must be in the /etc/vaisala/irisrda/images/ directory.

6.7.4 Bitex data point configuration
Bitex supports the following types of data points:

• Status data points (information received from the RCP)
• Status QBITE point (from the RCP)
• Control data points (information sent to the RCP)

Status points are passive (accept no user input). They graphically display status information
as reported by the RCP.

Control data points are active and include a button for toggling the status. The status of the
button is sent to the RCP. The RCP decodes this uses this state to affect electrical outputs.
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Figure 19 Status data point example
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Figure 20 Status QBITE data point example

Figure 21 Control data point example

6.7.4.1 Configuring Status data points

1. Start Bitex with the -setup option.

2. Right-click the data point.
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3. In the Status Field Configuration Menu, update the configuration.

BITE Address
The BITE address specifies which byte and bit in the BITE packets from the RCP
corresponds to this status item. The BITE address has 3 parts:

• Unit
Corresponds to the one of the Received Status Bits units defined in
the Bite Customization Menu.

• Byte
For this unit, what byte is used for this data point. Limited to a range
between 3 and a customized number of bytes (N) minus 1 for this Unit
(bytes 1, 2, and N are reserved).

• Bit
Corresponds to the bit (in the Unit and Byte numbers) that this data point is
mapped to. Limited to the range 0... 6.

Field Text Name
The text string that appears on this data point that defines its meaning (up to 19
characters).
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Select the button on the left of the field to choose a pre-defined text string. If a
pre-defined field name is used, the allows Antenna utility recognizes this data
point as a "special meaning" data point, and the Antenna utility displays the
setting of this data point. This is only applicable to systems that require an INU
(moving platform radars).

Condition Text if Low / High
Allow the display of optional text depending on the reported state of this data
point.
If entered, this text is displayed on the left side of the actual data point display.
This text can be up to 9 characters long.

Warning Flag
Controls fault generation. This can be set to None, Low, or High.
None means not to generate a fault based on this bit, otherwise the warning flag
indicates the level considered a fault. If a fault is possible, the fault can be further
conditioned with the Disable Warning field.
If the warning flag is set (value other than None), then if the data point is in the
unfaulted state, the LED indicator is green. If the data point is in the faulted state,
the data point is displayed as either yellow (non-critical), or red (critical)
depending on the state of the Critical button (next to the Warning Flag
selection).
If the warning flag is set to a value other than None, then this data point is or'ed
into the overall status of this site. Thus this data point could cause this site to be
considered faulted, or critically faulted. This information can be used by the RCP
to allow channel changing in system employing redundancy.

Disable Warning
Lets you override a warning if a particular field is set to Low or High.
Use this when a condition should generate a warning only some of the time.
For example, a High Voltage Missing condition does not require a warning
if the transmitter is turned off. By specifying this additional BITE condition, you
disable the warning.

4. Select Apply All.

6.7.4.2 Configuring Control data points

1. Start Bitex with the -setup option.

2. Right-click the data point.
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3. In the Control Field Configuration Menu, update the configuration.

BITE Address
The BITE address specifies which byte and bit in the BITE packets from the RCP
corresponds to this status item. The BITE address has 3 parts:

• Unit
Corresponds to the one of the Received Status Bits units defined in
the Bite Customization Menu.

• Byte
For this unit, what byte is used for this data point. Limited to a range
between 3 and a customized number of bytes (N) minus 1 for this Unit
(bytes 1, 2, and N are reserved).

• Bit
Corresponds to the bit (in the Unit and Byte numbers) that this data point is
mapped to. Limited to the range 0... 6.

Field Text Name
The text string that appears on this data point that defines its meaning (up to 19
characters).

If Field
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Allows for the button color to change based on some condition.
Select the button to the right of If Field and choose the conditional data point,
low, high, or None.
To disable this feature, select None.
To change the color that the button changes, select the button next to set color
to.

Button IN / OUT Text and Color
Allow text information to be displayed next to the button depending on of the
button is pressed in or out.
You can also change the color of the button depending on its position.
In the example, no text is desired, so the information is blank.

Button IN control bit level
Sets the polarity of the data bit corresponding to this button.
The polarity is dependent on if the button is in or out.
This field selects the IN polarity, the OUT polarity is the opposite.

Momentary Button / Toggle Button
Configure buttons to be momentary (you must be applying pressure for the
button to stay in) or as toggle buttons.

Normally Out / Normally In
Selects the normal position of the button.

IRIS Flag
When set to Yes, a message is sent to IRIS when the state of the button changes.
The message is put into the message log and status product.

4. Select Apply All.

6.7.4.3 Configuring Status QBITE points
In QBITE, a quantitative value is passed. It is a packet in the an integer number of bytes in
the data packet, using 7 bits/byte.

1. Start Bitex with the -setup option.

2. Right-click the data point.
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3. In the QBITE Status Field Configuration Menu, update the configuration.

BITE Address
The BITE address specifies which byte and bit in the BITE packets from the RCP
corresponds to this status item. The BITE address has 3 parts:

• Unit
Corresponds to the one of the Received Status Bits units defined in
the Bite Customization Menu.

• Byte
For this unit, what byte is used for this data point. Limited to a range
between 3 and a customized number of bytes (N) minus 1 for this Unit
(bytes 1, 2, and N are reserved).

• Bit
Corresponds to the bit (in the Unit and Byte numbers) that this data point is
mapped to. Limited to the range 0... 6.

Field Text Name
The text string that appears on this data point that defines its meaning (up to 19
characters).

Units Text
A short string to display next to the QBITE value.

Cal Slope, Offset, and Signedness
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The QBITE value is computed by first concatenating all the bytes together from
the data packet. We then interpret this number as either a signed or unsigned
integer, which is then multiplied by a slope, and an offset is added. Specify this
here.

Num Format
Specify how many digits to show when displaying the QBITE value.

Alarm Thresholds
Controls fault generation. You can configure the system to generate both a
critical and a non-critical fault based on the QBITE value.
Specify the threshold values and whether it should alarm above or below the
threshold.
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7. Color Setup

7.1 Color Setup overview

This utility is a legacy feature used when viewing radar data with IRIS Analysis.
When possible, Vaisala recommends viewing radar data with IRIS Focus.

The colors in the IRIS graphical displays are configured using the Color Setup utility. The
displays use the following color classes:

• Data colors
For displaying data values as color coded levels.

• Special colors
Used for overlay lines, text, centroids, wind barbs, and so on.

When configuring the colors, be aware of the following concepts:
• Color set

A group of up to 16 colors used for displaying data. A color set can be used for several
different data types and color scales.
IRIS supports up to 8 different color sets. For example, one may be used for positive
data such as reflectivity or rainfall rate, while another may be used for signed data such
as velocity of shear.

• Color scale or legend
A user defined set of numeric values for the color scale, as well as which color set to
use. Each data parameter (dBZ, R, V, TOPS, and so on) can have up to 8 custom color
scales.

Typically, you do not need to change the color sets and color scales very frequently. Access
to Color Setup requires operator privilege. Observers can select different color scales and
make their own uniformly-spaced color scales in the Quick Look Menu.

Changes to the color palette, color sets, and color scales affect all displays.
Operators should coordinate changes with the system manager.
NOTICE!

7.2 Invoking Color Setup
1. Login as radarop.

2. In the terminal window, type: color_setup
The Color Configuration menu appears.

3. Select ConfigColor Set Editor.
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4. Select File to save, list, or print Color Setup configuration settings.

Print creates an X-window dump of the menu you are running, as follows:
• Print > to Printer sends the output to the postscript or color printer specified in the

Printer Setup menu.
• Print > to File sends the output to a file in your default home directory.
• Print > Setup lets you configure the printer on your system.

7.3 Configuring a color scale
Use the Color Configuration Menu to configure the numerical data values that are
associated with each color band.

To see an example color scale, select File > Open Example.
This loads an example color scale for the selected data parameter (for example, velocity
or dBZ). The numerical values of the color seams for the examples correspond to the
suggested default values.

Table 8 Color scale data parameters

Parameter Signed (+_) or Positive Description, Units, and Method

dBZ Positive (Z) dB of radar reflectivity factor in mm6 m-3

R Positive Rainfall rate in mm/hr or inches/hr

V Signed Velocity in m/s

W Positive Spectrum width in m/s

VIL Positive Vertically integrated liquid in mm

Height Positive Echo top height in km

Rain Positive Rain accumulation in mm

Shear Signed Wind shear in (m/s)/km

VILDen Positive Density of VIL

ZDR Signed Differential reflectivity (optional)in dB

KDP Positive Specific differential phase in degrees/km

User   

PHI Positive Differential phase in degrees

RHO Positive Cross-correlation scalar (0..1)

SQI  Signal Quality Index scalar (0..1)

LDR Positive Linear Depolarization Ratio in dB

Time Positive Time

Turb Positive Turbulence
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Parameter Signed (+_) or Positive Description, Units, and Method

Temp Signed Temperature

Albedo Positive Albedo

HClass  Enumerated Echo Classification method dependent
indexing (0..8)

1. Select the data parameter for which you would like to make a color scale.

The Units field shows the quantities and range of values. The table shows if these
quantities are treated as signed or positive only numbers, or as enumerated class
identifiers.

dBZ can be negative if Z is less than 1 since it is a dB value.

2. Select Levels to define the number of levels in the color scale (2 ... 16).

When you change the number of levels to be less than the maximum of 16, the unused
levels are desensitized. Also, the top end point indicator shifts.
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3. Select Color Scale to select existing color scales or to edit or to create new ones.

a. Select an existing Color Scale name to examine or edit it.

b. New creates a new name.

Up to 8 color scales are allowed for each data parameter, one must be named
Default.
Set theDefault scale to be something that you use frequently.

You can rename a Color Scale by editing an existing name. The old name is
replaced by the new name.

When you first enter the Color Configuration Menu, the Default color scale is
always loaded.
You can change the values of the Default scale but you cannot delete it.

If you already have 8 Color Scale names, you must to delete one before creating
a new one.

c. Select Delete to delete a color scale.

Restrictions are:
• The current color scale name cannot be deleted.
• The Default color scale name cannot be deleted.

4. Select Color Set > Signed and the Color Set name.

The Color Set determines the order of colors from top-to-bottom. There are 4 available
Color Sets, one of which must be named Default.
See Configuring a color set (page 101).
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5. At the end points of the scale (top and bottom) toggle thresholding/saturation choice
by selecting the arrow sign:

        End Point Saturation End Point Thresholding

30 >3515

<–35 –301

30 3515

–35 –301

• Saturate
Displays all values outside the last seam as the boundary color. The left example
above shows both the bottom and the top using saturation. This is indicated by the >
and < signs.

• Threshold
Uses a fixed value as the outside limit. Values beyond the fixed value (either too high
or too low) are not displayed. The right example above shows the case for
thresholding at the top and the bottom.

If you select thresholding, type in the appropriate boundary value. The top and the
bottom behavior can be specified separately.

For positive-going scales (dBZ, TOPS, VIL, R, and so on) use thresholding at the
bottom and saturation at the top. Eliminates weak echoes from the display, while
allowing you to see the very strong echoes.

You can configure the uniform step color scales in the Product Configuration Menu
and the Quick Look Menu using the end-point behavior that you specify for the
Default Color Scale.

6. Enter the color scale values:

• Entering the lower left value first (if you are using thresholding).
• Entering the remaining seam values starting at the bottom right and working

upwards in the right column Note that the values in the left column are filled
automatically.

If a data value exactly matches a color scale seam, it is displayed as if it was above the
seam. Everything >= the lower seam and < the higher seam is included in a color
interval.
The values that are entered are formatted in the same manner as they are for the actual
legends in the color display. The formatting is automatic to make numeric displays
readable:
• Trailing zeroes are suppressed when possible. If there is a value with 10ths such as 1.1,

then the trailing zeroes are used (for example, 5.0 rather than 5).
• In most cases 2 significant figures are shown in the legend, provided that the data

type supports it and that it does not cause incidental trailing zeroes.
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7. Select Save All.

The modifications to the current color scale are saved. You must restart the applications
for which you changed the color scale for changes to take effect.

8. To start over, select Restore All.

This restores the last saved values.

9. Select Exit to exit the utility.

More information

‣ Example Color Setup values (page 105)

7.4 Configuring a color set
Each color cell can be either a solid color, or a gradient color which changes continuously to
the next value.

For gradient colors, the color at the top seam is set to the same value as the bottom color of
the cell above.

There can be up to 8 color sets, one of which must be named Default.

To create, rename, or delete color sets, see Configuring a color scale (page 97).
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Figure 22 Color Set configuration menu example for Velocity

1. Check the currently shown color set.

The Color Set menu shows the current color set.
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2. Select File to view the available color sets, including example color sets for common
IRIS data types, one for gradient colors and one for solid colors.

3. To toggle between solid or gradient colors, select the buttons to right of the colors.

If the button is pressed in, then the color cell is gradient.

4. To change a color set or create a new one (with a new order of colors) select Config > 
Change Color Set.

The Color Set Configuration Menu opens. If you had made changes to the color scale,
you are prompted to save or cancel your changes.

5. To change the colors in the color set, highlight the color level that you want to change
and use the scroll bars at the top to change the RVB values.

Your change are shown immediately in the color set (and in the color scale in the main
menu).
You can select either the top or bottom of each color cell to adjust. For solid colors,
either selection changes the whole cell.

6. Select File > Close.

7.5 Configuring special colors
You can use special colors for non-data items in the display such as overlays and legends.

Table 9 Special colors

Name Description Default R G B

Legend
Background

Background behind the legend
text

Black 0 0 0

Legend Text Text on the legend background White 255 255 255

Drop Shadows Shadows cast underneath
echoes for 3D look

Black 0 0 0

Overlay Level 1 Layer 1 lines typically used for
geography

Black 0 0 0

Overlay Level 2 Layer 2 lines, for example, rivers,
roads, political

Gray 128 128 128

Overlay Level 3 Layer 3 lines, for example, rivers,
roads, political

Green 0 255 0

Overlay Text
Background

Background color for text on the
overlay

Tan 196 196 128

Underlay #1 To overlay areas, typically land
color

LtBrn 212 155 95

Underlay #2 To overlay areas, typically sea
color

Blue 117 117 199

Underlay #3 To overlay areas, typically special
areas

Tan 170 155 95
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Name Description Default R G B

Centroid Ellipses Fill color for warning centroids,
typically bold

DkPink 200 100 220

Blink Blinking data alternates with this
color

Red 255 0 0

Track Line Track lines drawn in this color Black 0 0 0

Highlight Forecast arrows and protected
area hits

White 255 255 255

Shear Line Shearlines drawn in this color Black 0 0 0

Wind Barb Color Wind barb displays Black 0 0 0

Range Ring Color Range ring overlays Black 0 0 0

1. Select Color Configuration > Config > Set Special Colors.

The color configuration menu appears.

2. Use File > Open > Example to get the sample values that are listed in the table.

7.6 Configuring HydroClass names
For the color scale for HydroClass data, each numerical value corresponds to an index of
a discrete class.

You can customize the class indices displayed in the HydroClass Name Editor by defining a
name for each class (text to display on the legend).

The meanings (associations with a class) of the HClass numerical values is specific to each
classification method, as described in sig_data_types.h.
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Figure 23 HydroClass Name Editor

1. In the HydroClass Name Editor, select the IRIS default name on the left column, and
type your own custom name on the right.

Names are limited to 8 characters. You can name a new class or change the language of
an existing class.

7.7 Example Color Setup values
To make it easier to start your operation, example values are supplied for all menus. These
are intended as examples only. You can use these until you get a feeling for the climatology
and your particular application. The examples are summarized below.
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Color Scales

Figure 24 Color Configuration menu example for Velocity

The default color scales are loaded in the Color Configuration Menu.

First select the data parameter (dBZ, R, and so on), then select File > Open Example. The
table below gives the examples for each data type.
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Reflectivity - dBZ (mm6/m3)  Rainfall - Rate R (mm/hr)

Level Start Stop Level Start Stop

16 66 >72  16 500 >800

15 60 66  15 200 500

14 55 60  14 100 200

13 53 55  13 80 100

12 50 53  12 50 80

11 44 50  11 20 50

10 39 44  10 10 20

9 37 39  9 8 10

8 34 37  8 5 8

7 28 34  7 2 5

6 23 28  6 1 2

5 21 23  5 0.8 1

4 18 21  4 0.5 0.8

3 12 18  3 0.2 0.5

2 7 12  2 0.1 0.2

1 2 7  1 0.05 0.1

Rain Accumulation - Rain (mm)  Vertically Integrated Liq - VIL (mm)

Level Start Stop Level Start Stop

16 800 >1100  16 32 >34

15 500 800  15 30 32

14 200 500  14 25 30

13 100 200  13 20 25

12 80 100  12 15 20

11 50 80  11 8 15

10 20 50  10 6 8

9 10 20  9 4 6

8 8 10  8 2 4

7 5 8  7 1 2

6 2 5  6 0.8 1

5 1 2  5 0.6 0.8
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Rain Accumulation - Rain (mm)  Vertically Integrated Liq - VIL (mm)

Level Start Stop Level Start Stop

4 0.8 1  4 0.4 0.6

3 0.5 0.8  3 0.2 0.4

2 0.2 0.5  2 0.1 0.2

1 0.1 0.2  1 0.05 0.1

Velocity -V (+ is away in m/s)  Spectrum Width (W in m/s)

Level Start Stop Level Start Stop

16 30 >35  16 5.5 >6.0

15 25 30  15 5.0 5.5

14 20 25  14 4.5 5.0

13 15 20  13 4.0 4.5

12 10 15  12 3.5 4.0

11 5 10  11 3.0 3.5

10 2 5  10 2.5 3.0

9 0 2  9 2.0 2.5

8 -2 0  8 1.5 2.0

7 -5 -2  7 1.0 1.5

6 -10 -5  6 0.8 1.0

5 -15 -10  5 0.6 0.8

4 -20 -15  4 0.4 0.6

3 -25 -20  3 0.2 0.4

2 -30 -25  2 0.1 0.2

1 <-35 -30  1 <0.0 0.1

Wind Shear - Shear (m/s/km)  Echo Tops - Height (km)

Level Start Stop Level Start Stop

16 20 >25  16 ??? ???

15 15 20  15 16 >17

14 10 15  14 15 16

13 8 10  13 14 15

12 6 8  12 13 14
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Wind Shear - Shear (m/s/km)  Echo Tops - Height (km)

Level Start Stop Level Start Stop

11 4 6  11 12 13

10 2 4  10 11 12

9 0 2  9 10 11

8 -2 0  8 9 10

7 -4 -2  7 8 9

6 -6 -4  6 7 8

5 -8 -6  5 6 7

4 -10 -8  4 5 6

3 -15 -10  3 4 5

2 -20 -15  2 3 4

1 <-25 -20  1 2 3

Specific Differential phase - Kdp (deg/km)  Differential Phase - PHI (deg)

Level Start Stop Level Start Stop

16 20 >33  16 169 >180

15 7.0 20  15 157 169

14 3.1 7.0  14 146 157

13 2.4 3.1  13 135 146

12 1.7 2.4  12 124 135

11 1.1 1.7  11 112 124

10 0.75 1.1  10 101 112

9 0.50 0.75  9 90 101

8 0.33 0.50  8 79 90

7 0.22 0.33  7 68 79

6 0.15 0.22  6 56 68

5 0.10 0.15  5 45 56

4 -0.10 0.10  4 34 45

3 -0.20 -0.10  3 23 34

2 -0.40 -0.20  2 11 23

1 <-.80 -0.40  1 <0 11
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Signal Quality Index - SQI (no units)  Depolarization Ratio - LDR (dB)

Level Start Stop Level Start Stop

16 0.94 >1  16 0 >2

15 0.87 0.94  15 -2 0

14 0.81 0.87  14 -4 -2

13 0.75 0.81  13 -6 -4

12 0.69 0.75  12 -8 -6

11 0.62 0.69  11 -10 -8

10 0.55 0.62  10 -12 -10

9 0.50 0.55  9 -14 -12

8 0.44 0.50  8 -16 -14

7 0.38 0.44  7 -18 -16

6 0.31 0.38  6 -20 -18

5 0.25 0.31  5 -22 -20

4 0.19 0.25  4 -24 -22

3 0.13 0.19  3 -26 -24

2 0.06 0.13  2 -28 -26

1 <0.00 0.06  1 -30 -28

ZDR (db)  HydroClass

Level Start Stop    

16 5.0 >6.0  16   

15 4.0 5.0  15   

14 3.5 4.0  14   

13 3.0 3.5  13   

12 2.5 3.0  12   

11 2.0 2.5  11   

10 1.5 2.0  10   

9 1.0 1.5  9   

8 0.8 1.0  8   

7 0.5 0.8  7   

6 0.2 0.5  6 6 Hail

5 0.0 0.2  5 5 Graup
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ZDR (db)  HydroClass

Level Start Stop    

4 -1.0 0.0  4 4 Snow

3 -2.0 -1.0  3 3 WSnow

2 -3.0 -2.0  2 2 Rain

1 <-4.0 -3.0  1 1 NoMet

Color Set and Palette examples

Select Color Set Configuration Menu > File > Open Example and choose either the velocity
example or dBZ example.

This loads both a color palette and a color set. Note that the color palette is the same for
both examples.

The velocity example shows a convenient color set for signed data. The dBZ example shows
a convenient color set for positive data. You may want to save these as Signed and
Positive.

The RGB values for the default color palette are given in Figure 24 (page 106).

Special Color Examples

Select Special Color Editor Menu > File > Open Example.

This loads examples for all special colors.

Chapter 7 – Color Setup

111



8. Dspx utility

8.1 Dspx overview
You can use the Dspx utility to debug the interface hardware to the RVP signal processor
and to help develop new software that uses the signal processor.

You can also use Dspx to localize a problem when the DSP does not perform as expected.

For more information, see RVP10 User Guide (M212604EN).

8.2 Invoking Dspx
1. In the command line, type one of the following commands

dspx -nochat

or

dspx

The Dspx prompt opens.

8.3 Dspx commands and prompts
When started with the –nochat option, dspx displays a prompt such as:

[110] :

For parallel interfaces, the prompt shows (in binary form) the three status lines coming from
the DSP. The least significant prompt bit, when 1, indicates that data is available in the DSP
output FIFOs. The other bits are unused.

Table 10 Dspx commands

Command Description

* Perform a complete power-up restart of the DSP.

*f Clear the DSP output FIFO.

*n Clear the measured noise levels.
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Command Description

chat Access DSP setup terminal information. The terminal behaves as if it were
a TTY plugged into the DSP through the serial edge connector.

d [n [m] ] Display n words starting at location m.

The data are shown in both Hex and Signed Decimal format.

Variations on the d command are:

• du which displays entirely in Unsigned Decimal
• dx which displays entirely in Hex

q or e Exit

f n m [#] Fill, write n, m times, using DMA size #

gparm Read the current GPARM values, and print them in a format that is easy to
read.

? or h Help, print command summary

r [n [#]] Read up to n words, DMA size #

rays Display history for the last 40 rays that were processed. The table shows
the starting and ending Azimuth and Elevation, the number of samples,
and the processing time for each ray.

repeat [n] Repeat line n times

w n [n n ...] Write word

~ [t] Sleep t milliseconds (default 1000)

! [n] Re-execute last line n times

; Command separator

8.4 Dspx plots
Dspx generates an X-Window version of the oscilloscope plots that are produced by the
RVP plot commands.

You can access the P plot commands through the DSP chat mode. For more information, see
RVP10 User Guide (M212604EN).

The scope window appears when you enter a plot command.
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Figure 25 Ps plot example

8.5 Dspx chat mode
You can use the chat mode to access the internal setup information in the signal processor
(RVP).

1. Enter chat mode directly by starting dspx without the –nochat argument.

Alternatively, enter chat mode using the chat command.
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2. To begin the dialog with RVP, press ESC.

In chat mode, you can access the TTY setup commands from the host computer, as if it
were a terminal plugged directly into the DSP.
When you are in chat mode, the normal square-bracket prompt disappears.
For information on TTY setup commands, see RVP10 User Guide (M212604EN).

Command List:

F: Use Factory Defaults
S: Save Current Settings
R: Restore Saved Settings
M: Modify/View Current Settings
Mb – Burst Pulse and AFC
Mc – Board Configuration
Mf – Clutter Filters
Mp – Processing Options
Mt<n> – Trigger/Timing <for PW n>
Mz – Transmitter Phase Control
M* – Stand–alone Settings
M+ – Debug Options
P: Plot with Oscilloscope
Pb – Burst Pulse Timing
Ps – Burst Spectra and AFC
Pr – Receiver Waveforms
P+ – Visual Test Pattern
V: View Jumpers and Status

?: Cmd list (?? Settings list)

*: Power–Up Reset

Q: Quit

3. To disconnect the terminal from the DSP, type: q
Dspx waits for you to press Ctrl/C, then returns to the dspx prompt:

> q

Exiting Setups...

^C

[110] : 
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8.6 Sample Dspx session
You can use the commands in the following sample session to manually request the internal
processor parameters, and display them in numerical format.

For more information, see RVP10 User Guide (M212604EN).

$ dspx -nochat

Digital Signal Processor Examiner (DSP#1)

[110] : w 9

1 Words were written.

[111] : r

64 Words were received.

[110] : d

0000/ 0:  e000 0096 07d1 e13e -8192  150    2001  -7874
0004/ 4:  00b6 0780 0514 0000 182    1920   1300  0
0008/ 8:  0000 0280 0000 0000 0      640    0     0
000c/ 12: 002d a7d6 001e 0096 45     -22570 30    150
0010/ 16: 0096 0000 00fa 7530 150    0      250   30000
0014/ 20: 07d0 1770 2ee0 5dc0 2000   6000   12000 24000
0018/ 24: 842b 0000 2710 2710 -31701 0      10000 10000
001c/ 28: 07d0 07d0 0017 0666 2000   2000   23    1638
0020/ 32: 000d fedf 0066 0050 13     -289   102   80
0024/ 36: fd89 0005 001e 0000 -631   5      30    0
0028/ 40: 0000 0000 0000 b3f6 0      0      0     -19466
002c/ 44: 0033 007a 0000 0780 51     122    0     1920
0030/ 48: 8000 0000 0000 0000 -32768 0      0     0
0034/ 52: 0000 0000 0000 0000 0      0      0     0
0038/ 56: 0000 0000 0000 0000 0      0      0     0
003c/ 60: 0000 0000 0000 0000 0      0      0     0

You can also view the corresponding results of a gparm command:
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[110] : gparm

==================== GPARM Read Back ====================

Code Revision 14 Serial #: None

L-Status: 0x0000 I-Status: 0x0280 Diagnostics: 0x0000 0x0000

Current A/D Samples: I:5 Q:0 LOG:30

Requested Trigger: 600.00Hz Trig-Out: 600.00Hz Trig-In: 599.40Hz

Last PROC Starting and Ending rates: 600.00Hz, 600.00Hz

Maximum Trigger Rates: 3000.00Hz, 1000.00Hz, 500.00Hz, 250.00Hz

Trigger Count: 2014614 Wave: 0 PW: 0 PW-patterns: 0x842b

Bins in Range Mask: 150 Range Averaging: 1

Last AQ Bin Count: 150 Last Valid Bin Count: 150

AZ Tags: 0x6539 (142.34) EL Tags: 0x00b6 (1.00)

Noise Range: 250km Noise PRF: 200.00Hz

LOG Noise: 30.00 LENM: 30.00 LENSD: -512.00

I-Mean: 5.08 I-STD: 0.25 Q-Mean: 0.00 Q-STD: 0.03

SOPRM Flags: 0x0017

Thresholds: LOG: 0.81dB WSP: 5.00dB SQI: 0.40 CCOR: -18.06dB

LOG Slope: 0.400 Cal Refl: -39.44dBZ Sample Size: 45
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9. Overlay utility

9.1 Overlay overview

This utility is a legacy feature used when viewing radar data with IRIS Analysis.
When possible, Vaisala recommends viewing radar data with IRIS Focus.

You can use the IRIS Overlay utility to draw overlays or maps for display on top of other
IRIS/Open products. Overlays are used for product output and the real-time display.

An overlay can consist of the following:
• Geographical and political boundaries displayed with or without latitude and longitude

lines or range rings.
• Text strings to label areas of interest, such as cities.
• Bitmap Icons that can be constructed by the user and applied to the overlay. Icons can

represent any feature, for example, airports, train stations, and similar.
• The lines, text and icons mentioned above can be separated into different layers within

the overlay file. Then at display time, either all or only a subset of these layers may be
displayed giving yielding overlays that appear different based on which layers are
active. Layers can be drawn in different colors.

• Underlays are filled regions of color displayed under the radar images where there is no
weather data. Underlays are typically used to indicate areas of water.

Each overlay is defined in an ASCII file using a connect-the-dots approach (sometimes
called a vector approach). This allows overlays to be drawn to any scale factor.

You use the Overlay utility to create and modify your own overlays in a window on your
workstation.

Typically, you get the basic map (coastlines, borders, rivers) from Vaisala and then
customize it to meet your needs. It is often convenient to make separate layers for different
interests (river catchments, airports). IRIS supports up to 20 overlay files.

IRIS overlays are ASCII files so you can edit them with any text editor (vi, or emacs which is
distributed with IRIS).

9.2 Invoking Overlay
1. Invoke the Overlay utility by typing: overlay&

Overlay starts as a default with an empty window on your workstation.
Settings from your previous session are still valid when you restart.

2. Open an overlay (.ovr) file from the /etc/vaisala/irisrda/overlay directory.
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3. To see the latitude and longitude of your cursor, select File > Display Lat Lon.

You can move your cursor around your map with the mouse. To find a precise point, use
the arrow buttons of the keyboard to move pixel by pixel.

4. To define the mode to show latitude and longitude, select File > Lat Lon Units.

You can display the values as degrees and decimals or degrees, minutes and their
decimals.
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5. To define the map display, select File > Options.

The Options window is shown.

a. In the top pane, define the following:

Display size in km
Defines the horizontal size of the map in km.

North/East offset in km
Move around your original map and create subareas.

Layers to draw
Defines if you want to work with all of your map layers or only a subset.

b. In the bottom pane, define the following:

Fill points
Indicate the areas, typically lakes, you want to be colored with a certain color.

Range Rings 
Centered at a predefined point, typically a radar site

Protected
The areas you use with the WARN product
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Lat Lon
Displays a latitude-longitude grid

NoUnderlay
Do not use an underlay.

c. Select the map projection.

Typically, Azimuthal is used in one–radar applications, Mercator in composites in the
tropical areas and Polar Stereographic in the composites near the poles.
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6. To create or modify a layer, select File > Add/Modify Layer.

Everything you add to an overlay goes to a layer. You can add or delete text, icons and
fill points. You can also select a "pointer" which gives you position of you cursor.

a. Assign each layer a color from a predefined set, shown in a box next to the layer
name.

To define more colors, use the Color utility.

b. To add content to a new or existing layer, select Create New Layer.

The Add/Delete Tool appears.
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• To add icons, you must include a text next to the icon.
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When you use icons, Vaisala recommends that you justify them right or left,
because the icon goes to the point and the text should be next to the icon. You
can highlight the text to give it a colored background.

• When adding text, most users want to justify text to center, so that the point
shown with latitude and longitude in the upper column is under the middle
character of your text.

c. To merge 2 layers, in the Add/Modify Layer window, select target layer and – – –.

d. To prevent the filled color from leaking around the edge of the overlay limits, use the
RANGE command to tell Overlay how far you have drawn your overlay.

e. Define your underlay fill points.

Fill points are used to make an underlay. An underlay can contain up to 400 fill
points. Overlay starts from each of the specified fill points and fills all contiguous
areas, stopping at overlay lines.
You can enter many fill points for the same filled region. In fact, this is required for a
coastline with deep bays, so that the region fills correctly at all scales. Many overlays
contain coastline and use a blue underlay for ocean.

f. To delete items from a map, select a Kill option.

When you select a Kill option, your cursor becomes a killer tool and you can delete
items from the map by pointing and clicking them. There is a separate kill tool for
text, icons and fill points to minimize the risk you kill something you didn't want to
kill. If you can't kill what you want, you are probably working with a wrong layer.

7. Select Header to check the overlay file header.

See Overlay header (page 128).
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9.3 Listing and printing overlay files
Overlay files in use on are stored on disk in a directory called IRIS_OVERLAY. The product
output process always looks for overlay files in that directory.

To see a list of the overlay files stored on your system, issue the following commands from
the operating system prompt:

$ cd $IRIS_OVERLAY

$ ls

Overlays for many IRIS sites are included in the release in the IRIS_ROOT/
config_template/overlay directory. Overlay defaults to the IRIS_OVERLAY
directory, unless you specify a path in the file name.

The overlay directory should contain only overlay files. Do not use it to store any other kinds
of file. In addition, Vaisala recommends that you follow these file naming conventions for
any overlay files that you create:

• Use the .ovr suffix or file extension to denote overlays. The product output process
uses only these files. The Overlay utility uses files with this extension by default. That is,
if the file has the .ovr suffix, you do not need to type the suffix when you display it
using Overlay.

• Use .xbm to denote bitmap overlay icons that are referenced within the overlay files.

Because overlays are ASCII files, you can print them on your system printer.

9.4 Viewing an overlay example
The overlay template directory contains a file called sample.ovr. It contains some text
strings, a simple overlay area, and an underlay area.

To display sample.ovr:
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1. Run the Overlay utility, specifying the name of the overlay file, as follows:

$ cd ${IRIS_ROOT}/config_template/overlay

$ overlay ./sample

Overlay processes the file, which may take several seconds. If you supplied the -v
option, it responds with summary statistics as follows:

12 (max 40) icon files, using 311 (max 12000) bytes:

0: dot9.xbm       1: dot7.xbm      2: dot13.xbm
3: airport.xbm    4: beacon.xbm    5: test.xbm
6: building.xbm   7: golf.xbm      8: hospital.xbm
9: park.xbm       10: poi.xbm      11: train.xbm

Processing Overlay file.
10 (max 200000) points, 25 (max 400) strings, 9 (max 4000) fill points and 
0 (max 10) gifs
1 (max 32) named layers:
0: Default
Site Draw center: 42¯24.0'N 71¯ 6.0'W
Fill center: 42¯24.0'N 71¯ 6.0'W

This summarizes the icon files found, then the number of end points, text strings, and
fill points in the selected overlay. Finally the latitude and longitude of the draw and fill
center are shown.
Overlay always draws range rings centered at the draw center, while the Product
Output menu aligns it with the radar.

2. Overlay displays the overlay on the screen in using the colors specified in Color Setup,
as shown in the following figure. Optional range rings or a latitude and longitude grid
are drawn in green.

Filled areas have a maximum range, which is specified in the file. A circle is drawn at
that range, the underlay areas are filled, then the circle is removed.
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3. When you have finished looking at the overlay file, return to the terminal or window
where you invoked Overlay and press CTRL/C.

Figure 26 Sample Overlay Display

9.5 Format of overlay files
When creating an overlay, you must transfer the points from a map to an overlay file.

There are 2 major paths available to you when building an overlay file: absolute or relative
coordinates.

Overlay files are defined with a special syntax. A small set of simple statements specify the
location of the radar and place the text or lines on the map. A semicolon (;) marks the
beginning of a comment line.

The END statement marks the end of the map. Anything that appears in the file beyond the
END statement is ignored.
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It is sometimes helpful during editing to put an END in the middle of a file, so that Overlay
plots only the map lines and text up to that point.

9.5.1 Overlay header
Absolute coordinates

If the overlay is defined in absolute coordinates, all points in the overlays are given in terms
of a longitude, latitude coordinate pair. This sets an absolute position for each point.

The following header commands must be included at the top of the overlay file:

Table 11 Overlay latitude and longitude header commands

Command Description

PROJECTION latlon Informs system overlay is in absolute coordinates.

DRAW_CENTER lon lat Tells Overlay where to center the image.

Generally this is the either the coordinates of the radar site, or a nearby
special area of interest such as an airport.

FILL_CENTER lon lat Specifies center of fill area. Typically this is the center of the array of data
points you have generated.

FILL_RANGE range Sets the maximum range that the underlay covers, in km.

Overlay draws a circle at this distance from the fill center before filling the
underlay.

Relative coordinates

If the overlay is defined in relative coordinates, all points are defined in terms of map units.
Map units are any arbitrary unit of measure that is E/W and N/S of an origin (0,0), which can
be anywhere on the map.

Often millimeters from graph paper are used to designate the points on a map. The map
must be in azimuthal equidistant projection, with the specified reference point. A scale
factor specifies the conversion between these map units and distance on the surface of the
Earth.

The following header commands must be included at the top of the overlay file:

Table 12 Overlay map unit header commands

Command Description

PROJECTION aed Informs system overlay is in relative coordinates.

IRIS and RDA Utilities User Guide M212925EN-D

128



Command Description

SCALE scale Sets the scale factor in km/map unit.

The SCALE n command must be used to specify how many kilometers
each map unit specifies.

For example, if a RADAR 100 200 and a SCALE 0.5 command are
used, then if later a point is specified as POINT 110 200, this point is
exactly 5 km due east of the reference position.

RADAR x y Sets the projection point in map units and specifies the location of the
reference point in the map units.

REFERENCE lon lat Sets the projection point in absolute coordinates.

DRAW_CENTER lon lat Same as latlon projection.

FILL_CENTER lon lat Same as latlon projection.

FILL_RANGE range Same as latlon projection.

For backwards compatibility, the old MIDDLE command still has the meaning of setting both
the draw center and the fill center.

9.5.2 Text strings and bitmap icons
Text

You can place many strings of text on the overlay. Use the full ROMAN8 character set. If you
wish to include embedded spaces, enclose the string in double quotes (").

You can place text on the overlay in terms of map units, specifying the justification: left,
center, right, top, or bottom. The justification remains in effect for all subsequent strings
until another justification is specified.

You can also place text on the overlay relative to the edge of the display screen. In these
cases, the position is in 10 000 ths of the screen measured from the lower left corner. For
example, a location of (5000, 500) is in the middle near the bottom.

Bitmap icons

The bitmap icons supported by IRIS are black and white icons (.xbm files). Color icons are
not supported (.xpm files).

Icons of any size are supported, but using large icons is not practical. If icons are larger than
16 by 16 pixels, they take up too much of the screen.

You can edit icons using the icon editor that comes with the UNIX system.

Once icons are edited in the icon editor, place the xbm files in the $IRIS_OVERLAY
directory and overlay files can make reference to them by name.
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Statements and commands

Table 13 Appearance statements

Command Description

SIZE # Set the text size in pixels, range 7 ... 26.

HIGHLIGHT Use highlighted text (reverse video).

NORMAL Use normal video text.

Table 14 Map unit justification statements

Command Description

TOP Text is top-justified.

BOTTOM Text is bottom-justified.

LEFT Text is left-justified.

RIGHT Text is right-justified.

CENTER Text is centered.

Table 15 Screen-relative justification statements

Command Description

SCN_CENTER Text is centered relative to the screen.

SCN_LEFT Text left-justified relative to the screen.

SCN_RIGHT Text is right-justified relative to the screen.

Table 16 String location and content statements

Command Description

TEXT x y str Places the text str at the specified location.

ICON_TEXT str Same as above TEXT command, but str is placed next to the bitmap
icon specified in the most recent ICON command.

TEXT x y str1 str2 Places the text str1 at the specified locations.The text str2 is available
in the tabulation key in the display options menu. Generally str1 is a
short abbreviation that fits cleanly on the screen and str2 is the full
string that is not printed on the screen, but is available in the tabulation.

ICON_TEXT s1 s2 Same as the above TEXT command, but s1 is placed next to the bitmap
icon specified in the most recent ICON command.
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Table 17 Icon command

Command Description

ICON x y name Places bitmap icon specified by name at position x y.

9.5.3 Map outlines
An overlay typically consists of many lines. You draw a line by specifying the beginning and
ending points.

Table 18 Map outline statements

Statement Description

POINT x y or x y Places a point at the specified coordinates along an overlay line;
expressed in map units.

GAP or* Marks a break or the end of an overlay line.

9.5.4 Layer functions and commands
Overlay files can be composed of a single layer, or divided into up to 32 different layers.

• When a single layer is used, the complete overlay is always displayed (this includes all
lines, text and icons).

• When multiple layers are defined, any combination of layers can be displayed at
runtime.

For example, there may be a main layer called coastlines that is always displayed and other
layers such as roads, rivers, power plants, that can be turned on or off individually. Each
layer can contain lines, text and icons.

When defining layers in an overlay file, all entries in the file that occur after the initial layer
command are applied to that layer. This continues sequentially through the file until the file
ends, or another layer command is encountered.

Table 19 Layer definition commands

Command Description

LAYER name Defines a layer called name.

All commands following in the overlay file (until another LAYER
command is encountered) are applied to this layer.

You can enable this layer at run time by selecting its name in the display
options menu.

LAYER_COLOR name color All lines defined in the layer called name are drawn in the color.

The color must be overlay1, overlay2, or overlay3.

The colors are defined in color_setup.
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9.5.5 Solid underlay regions
An underlay is a range with outer boundaries, a filled area, and a color number specifying
the color to use for the filled area.

We use the term underlay to indicate that this color is visible only when there is thresholded
radar data, so it seems to be under the data.

Overlay starts from each of the specified fill points and fills all contiguous areas, stopping at
overlay lines. You can enter many fill points for the same filled region. This is required for a
coastline with deep bays, so that the region fills correctly at all scales.

Many overlays contain coastline and use a blue underlay for ocean. To prevent the filled color
from leaking around the edge of the overlay limits, use the RANGE command to tell Overlay
how far you have drawn your overlay.

Table 20 Solid underlay statements

Statement Description

FILL_COLOR color Sets the color of the underlay region.

Color should be underlay2 or underlay3.

FILL x y Marks the starting point for the fill area.

9.5.6 GIF underlay regions
A GIF underlay is a full color picture used to fill the background between overlay lines and
features.

Like solid underlays, this is visible only when there is thresholded radar data. Areas outside
the radar coverage circle are displayed with a darkened version of the GIF underlay.

Do not mix GIF underlays and filled solid underlays.

Table 21 GIF underlay statements

Statement Description

UNDERLAY_CENTER lon lat Selects the center location of an underlay file.

UNDERLAY_PROJECTION AED Selects the projection of the underlay file.

UNDERLAY_REFERENCE lon
lat

Selects the projection reference location.

UNDERLAY_STDPAR par1 par2 Optional standard parallels.

UNDERLAY_ELLIPSOID rad 1/
flat

Selects the equatorial radius (km) and flattening of the earth. 1/
Flattening of 0 means circular.

UNDERLAY_SCALE x y Selects the projection scale in km/pixel.

UNDERLAY_FILE file.gif Selects the name of an underlay file. The file must reside in the $
{IRIS_OVERLAY} directory.
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The following table shows a summary of supported projections.

Table 22 Summary of supported projections

AED Azimuthal Equidistant

EDC Equidistant Cylindrical

GAUSS Gauss Conformal

GNOMONIC Gnomonic

LAMBERT Lambert Conformal Conic

MERCATOR Mercator

POLSTEREO Polar Stereographic

UTM Universal Transverse Mercator

PERSPECTIVE View from geosynchronous satellite

9.5.6.1 Installing GIF image in your overlay

1. Copy your .gif file to the overlay directory.

2. Create a new layer called Underlay using the Add/Delete menu.

3. Go back to the Options menu to turn on the new Underlay layer, so you can see it later.

4. In the Add/Delete menu:

a. Select Add underlay

b. Select Underlay layer, then

c. Fill in the underlay properties box.

The projection type is Equidist Cylinder.
The center and projection reference should be the center of your image.

d. Sometimes the downloaded image seems to be 1° or 1 minute off from the expected
value. To compute the underlay scale, first compute the range scale, which is the
number of km/degree at your center latitude, with the following equation:RangeScale = π180 × 6371km × cos Latitude

e. Divide by the GIF scale (in pixels/degree) to give you the underlay scale in km/pixel.

For example, an overlay centered at 45° north, has a range scale of 78.62 km/degree
(48.9 mi/degree), and at 120 pixels/degree, yields 0.65522 km/pixel (0.4 mi/pixel).

5. Apply and save.
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9.5.7 Example of an overlay file

; This is a sample overlay to demonstrate the overlay features.
; Put this in ${IRIS_ROOT}config/overlay and call it sample.ovr 
;
; The semicolon ";" is used at the beginning of comment lines.
;
; All distances are in arbitrary "map units" with coordinate points
; denoted with E-W first and N-S second. See overlay description.
;
PROJECTION AED
; The scale factor in km per "map unit":
SCALE 1.000
;
; The radar location in map units:
RADAR 0 0
REFERENCE -71.100 42.400
;
FILL_CENTER -71.100 42.400
DRAW_CENTER -71.100 42.400
; Next come the text strings:
; First the text size (Height in pixels, range 7 through 25)
SIZE 16
;
; Next the text justification (left, center or right)
SCN_CENTER
;
; Then the text location and text string (E-W first, N-S second)
HIGHLIGHT
TEXT 5000 8450 Examples
TEXT 5000 8000 Of
TEXT 5000 7550 Text
;
; Here are font and justification examples for many sizes
; First do the size 7
SIZE 7
RIGHT
TEXT -150 85 7Right
; The two lines above cause the text "7Right" to be positioned with
; its right at map unit position (250, 350).
CENTER
TEXT -150 70 7Center
; For center, there is no position dot and text "7Center" is centered
; at the specified location.
LEFT
TEXT -150 55 7Left
; For left, the dot is to the left of the text "7Left"
;
SIZE 9
RIGHT
TEXT -50 90 9Right
CENTER
TEXT -50 70 9Center
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LEFT
TEXT -50 50 9Left
;
; Now change the size to 10 and repeat the examples:
SIZE 10
RIGHT
TEXT 50 95 10Right
CENTER
TEXT 50 70 10Center
LEFT
TEXT 50 45 10Left
; Now change the size to 13 and repeat the examples:
SIZE 13
RIGHT
TEXT 150 100 13Right
CENTER
TEXT 150 70 13Center
LEFT
TEXT 150 40 13Left
; Now change the size to 16:
SIZE 16
RIGHT
TEXT -150 -35 16Right
CENTER
TEXT -150 -70 16Center
LEFT
TEXT -150 -105 16Left
SIZE 20
RIGHT
TEXT -10 -30 20Right
CENTER
TEXT -10 -70 20Center
LEFT
TEXT -10 -110 20Left
SIZE 25
RIGHT
TEXT 130 -25 25Right
CENTER
TEXT 130 -70 25Center
LEFT
TEXT 130 -115 25Left
;
; Here is a message in the lower left corner of the screen
SIZE 13
SCN_LEFT
TEXT 200 200 File:sample.ovr
; And finally the points for the map lines in map units:
; Example of a small rectangle to enclose text examples:
; E-W first, N-S second.
-230 -180
-230 180
230 180
230 -180
-230 -180
GAP
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; The word "gap" above is used to denote the last point of a map line.
;
; To start another map line, continue entering map coordinates and
; put "GAP" after the line is complete.
;
; Put "END" at the end of the file. Note that it is sometimes
; helpful during editing to put "END" in the middle of a file
; so that overlay will only plot the map lines and text up to
; that point.
;
; Here is a large rectangle around everything:
-250 -250
-250 250
250 250
250 -250
-250 -250
; Here are some underlay fill points. These points are used to start a
; region fill, and should be spaced about the area of concern.
RANGE 0
FILL_COLOR underlay2
FILL -240 -200
FILL -240 -100
FILL -240 50
FILL -240 150
;
FILL 240 -150
FILL 240 -50
FILL 240 50
FILL 240 150
FILL_COLOR underlay3
FILL -50 -50
END
; End of SAMPLE

9.6 Format of catchment files
Catchment files are similar in format to overlay files. They contain a series of points
connected by vectors. They also support a ";" for comments, and END to mark the end of
the file. There is only one file header command.

IRIS supports a maximum of 20 catchment files.

Table 23 Catchment file commands

Command Description

DRAW_CENTER lon lat Tells overlay where to center the image. Generally this is the either the
coordinates of the radar site, or the center of the catchment area.

SIZE size Sets the size to draw subcatchment names. This is the height in pixels,
and it applies until the next size command in the file.
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Command Description

WARNING threshold Specifies warning threshold in mm. An alert is issued if this is exceeded,
and it applies until the next warning command in the file. A value of 0
means no alerts.

Catchment files are divided into a series of subcatchments. Each starts with a header
specifying the name and label location followed by the data points. The datapoints must
define a closed polygon. Make sure the last point matches the first one. There can be a
maximum of 512 subcatchments defined in each catchment file.

Table 24 Subcatchments

Subcatchment Description

START number name Tells the number and name of the subcatchment area.

LABEL lon lat Specifies the location to draw the name when labeling the
subcatchment. This location must be inside the region.

9.7 Creating and editing overlay files

Creating and editing overlay files should be done only under the supervision of the system
manager.

1. Use a computerized geographic database to get the array of coastlines and political
boundaries you want.

2. Manually add the header commands, display it with overlay and make needed repairs.

3. Add the desired text and icon features.

4. Add underlay fill points. When doing this you may discover more breaks in the overlay
lines which need to be repaired.

5. Test the underlay filling by displaying over a broad range of image sizes, for example
50, 100, 200, 400, and 800 km (31.1, 62.1, 124.3, 248.5, 497.1 mi). It is usually necessary
to add fill points in lakes and bays pointing towards the display center.

6. When you are satisfied with your overlay, place it in the $IRIS_OVERLAY directory.

9.8 Assigning an overlay to a radar site
The IRIS system manager associates a default overlay file for each site connected to the
system. You can assign a different overlay to the site.
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1. In the Overlay menu, highlight the site you want to change.

A list of available overlays is shown.
The following figure shows an example with 2 overlays for the HEL site: HELSINKI and
KARTTA.

Overlay

XXX — KING

SIG — SIGMET

HUN — HUNTSVI
LLE

HEL — HELSINK
I

WND — SIGMET

Site Overlay Name

File   Menus   Commands    Help

HEL–HELSINKI

HEL–KARTTA

HUN–HUNTSVILLE

KNG–KING

SIG–SIGMET

WND–SIGMET

Figure 27 Site Overlay example

2. Select an overlay from the list.

The menu also shows the site IDs for which the overlay is valid.
If you try to display a product with an invalid overlay, IRIS displays the message,
Overlay origin more than 1000 km from radar location (1000 km = 621.4 mi). If
you get this message, check that the correct overlay is assigned to the radar site.
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10. Real Time Display

10.1 Real time overview
Real Time Display (RTD) is a diagnositc and monitoring tool that allows you to
instantaneously view data, ray by ray, as they are acquired.

The rays of data (for example, 1°) are shown on the display as the antenna scans with no
perceptible delay. Both PPI and RHI display styles are supported.

A real time display is used in a variety of ways:
• Observers: View immediate feedback on the weather situation.
• Manual task operation: Provides radar operators with immediate feedback during

manual antenna control (for example, using handwheels or the Antenna utility).
This is useful for probing rapidly changing weather features such as a developing hook
echo, or weak echo region.

• System managers: Provides feedback for tuning signal processor parameters.
• System managers and radar operators: Provides ways to verify that the system operates

properly and generates high-quality data.

Real time display is not practical for remote unattended radar sites with low-bandwidth
network connections (for example, <100 KBytes/sec).

10.2 Real Time Display data handling
The real time display (RTD) data are output by the IRIS system at the radar site, or directly
by the RVP. Ray-by-ray output packets are sent over the network using UDP broadcast
messaging.

Many workstations can monitor the RTD without placing any additional burden on the
network traffic. You can tune the number of data parameters and range bins to match the
available network bandwidth. For example:

• Transmitted parameters: Z, V, and W only (3 bytes)
• Number of bins: 500
• Scan rate 4 RPM: (24° per second)
• Scan resolution: 1°

In this case the data rate is 36 KBytes/sec or 288 kbps. This means that real time display can
easily be done for Ethernet (10 mbps) or T1 (1 mbps) connections.

For slower connections, you must reduce the number of bins, increase the resolution, and/or
slow the scan rate.

Note that the radar probably also sends processed or RAW products over the network link.
You must consider the bandwidth requirement for these products.

More information

‣ Setting-up Real Time Display (RTD) (page 167)
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10.3 Launching Real Time Display
1. Do one of the following:

• Choose Menus > Real Time Display from the IRIS menu bar.
You do not need to be connected to an IRIS server to start the display.
The real time display appears in the DEFAULT configuration with a blank (black)
background. If data currently are being sent by the radar workstation, then within 2
seconds, the display starts to paint and the green LED in the upper corner of the
display flashes.

• In the IRISNet, select your site (where you are sitting) and then the real time display
icon.

• In a terminal window, type the following:

$ rtdisp&

2. To view multiple displays simultaneously:

a. Create multiple saved configurations with each using a different port number.

b. Use the command line option to specify which file to use. For example:

$ rtdisp -file port30726&

$ rtdisp -file port30727&
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10.4 Real Time Display menu

Figure 28 Real Time Display

File menu

The File menu allows you to open and save files and print real time display images.

Saved config files are stored in the ${IRIS_CONFIG} directory with names ending
in .rtdisp.

Note that when rtdisp is started without an explicit configuration name, it uses the
DEFAULT configuration file.

Save as... is used to store your custom display configuration.
You must select File > Save as... to save your changes permanently.
NOTICE!
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Config menu

Use the Config menu to change some basic parameters.

Ranges
Modifies the list of available display ranges.
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RHI Display Opt ...

Sets the appearance of RHI displays:
• Max Height can be specified either in km or Kfeet, the latter is used if the horizontal

range scale is selected to be nautical miles. The aspect ratio adjusts automatically.
• Min Height is normally set to 0. You can set it negative to handle banking on

airborne radars.
• Use RHI for Manual-Type Scans

By default, IRIS Manual scans are displayed in PPI format. You can override the
default to cause manual scans to be displayed in RHI format.

• Depending on the antenna capabilities, select either a standard 90° scan or an "Over
the top" 180° scan depending on the antenna capabilities.

Text Colors
Chooses color for text in AZ/EL, and similar display.

The large format numerals in the Real Time Display are designed to be read from
several meters distance.
You can change the color of the numerals using Config > Set Colors.

Sweep Line
Enables/disables a line showing the radar sweep.
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Status LED

The LED at the top of the display shows the status of the data stream to the real time
display.

• Fixed red on start up indicates that no data are being sent, or that data have not been
received for 5 minutes (time-out). For diagnostic information, see Configuring Real
Time Display transmitter (page 147).

• Flashing green indicates that data are currently being received.
• Fixed green indicates that data are not currently being received, but data have been

received within the last 5 minutes.

 Site ID field for multiple radars

This field shows the 3 letter radar site ID. For installations that have more than one radar, this
field can be used to select which radar is viewed on the real time display.

If you have multiple radars, select the button to the right of the LED to get a list of sites and
select the site that you want to display.

 Time display

The data time (not the local workstation time) is displayed to the nearest second in large
format numerals.

This updates approximately once per second when data are arriving.

When no data are arriving, the display time does not update so that the time reflects the
data that remain on the screen.

The date of the data is displayed in smaller characters above the time.

 AZ/EL display

Azimuth and elevation angles are displayed to the nearest tenth degree in large format
numerals.

This updates approximately once per second when data are arriving.
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When no data are arriving, the angles do not update so that the elevation angle reflects the
data that remains on the screen.

 Maximum range

One of four maximum ranges can be selected by clicking on the numerical field under the
AZ/EL display.

To set these ranges and the units, use Config > Set Ranges.

 Data selection for display

Select this field to select the type of data for display. The choices are:
• dBZ
• Velocity
• Width

After you make your selection, the display resets and starts painting the new data type.

If the radar system IRIS is not configured to collect and transmit the selected
data type, then no data is displayed. See Configuring Real Time Display transmitter
(page 147).

NOTICE!

 Overlays

The overlay features for the real time display include:
• Geographic overlays
• Range rings or lat/lon lines

To access these options, select the Overlays button to access the Overlays menu.
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Select Geographic to select from a list of available overlays, or Off.

Select Range Rings to select among:
• Off
• On
• On with numeric labels
• Latitude/Longitude grid (with numeric labels)

 Color Scale

You can modify the colors used to represent the data.

Select the Colors button to open the Color menu. After making a change, the display resets
and is painted with the new color scale.
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See the Color Scale Tool section in IRIS Product and Display Guide (M212928EN) .

Entering a level step of 0 for velocity has the special meaning to display the full
unambiguous velocity range. This range is not known until data are received. The velocity
color scale show all zeroes in this case until data are received.

10.5 Configuring Real Time Display
transmitter

You must have operator privileges to configure the data transmission from the radar site.

10.5.1 Setup utility configuration
The setup/RVP utility has several questions relating to both the transmitter and receiver
ends of the real time display, for example:

• What data are sent (dBZ, V, W) by the transmitter.
• The maximum number of range bins to be transmitted.
• The socket port is used for transmission (typically set to 30730).
• What IP broadcast addresses are to be used for transmission.

More information

‣ Setting-up Real Time Display (RTD) (page 167)

10.5.2 Using rtd_echo
You can use the rtd_echo utility program to help configure real-time display transmissions
on complicated networks. This program reads the RTD socket traffic on a computer and
retransmits it to another address. It can change both the destination address and port
number.
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The configuration is available with command line options. To see the choices, run rtd_echo
-?.

Only one program can read from a socket port. If you are running rtd_echo on a machine,
then another rtd_echo, or the rtdisp utility cannot read from the same port.

Typical uses for rtd_echo are:
• Transmitting data to a target host which is not directly accessible from the source

system (that is no network route, you cannot ping directly).
• Transmitting data through network routers and switches which do not allow broadcast

addresses.
• Transmitting data once through a limited bandwidth line, then echoing with a

broadcast address, or multiple distinct addresses to lots of machines.
In this case, if you are echoing to a network address which includes the echoing
machine, you must use a different port number. This is to prevent rtd_echo from
reading its own output and producing an infinite loop.
Here is an example of how to configure:
• Radar machine: 2 outputs in setup/RVP: 127.0.0.1 Port 30730, 192.168.45.1 port 30731.
• Echo machine (192.168.45.1): Run rtd_echo –a:192.168.45.255 –i:30731

This gives the following features:
• All rtdisp programs can be configured the same to read from port 30730.
• rtdisp works on the radar machine (using the 127.0.0.1 address).
• rtdisp works on all the 192.168.45 network including the echo machine.

Once you have rtd_echo working fine from a shell command, add it to your /etc/rc.d/
rc.local file with a trailing & so it runs every time you boot.
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11. Setup utility

11.1 Setup overview
The Setup utility configures the software for the characteristics of the radar.

Because information from Setup is used by many other utilities, run this utility first.

You must have detailed information about your radar system to answer some of the Setup
questions.

More information

‣ Color Setup overview (page 96)

11.2 Invoking Setup and built-in error
checking

When IRIS starts, it performs configuration and bounds checks.

For new users, the Setup parameters are typically correctly set and do not cause any
configuration errors. If an error does occur, follow these steps.

1. In the terminal window, type: setup&
The Setup utility launches.

There are 2 variants of the Setup utility: one for IRIS and one for the RDA (RVP
signal processor or an RCP8 antenna controller).
The RDA variant does not show the IRIS setup features.

2. Select the part of the system setup you want to check or configure.

3. Make your changes and close the window for the selected part of the system.
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4. Select File > Save.

The configuration files are now updated.

5. To create a listing file of the Setup configuration:

a. Select File > List.

A listing file called YYYYMMDDHHMM.setup is created in the ${IRIS_LISTINGS}
directory.
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6. To take the configuration changes into effect, restart the application:

a. For changes made to the Setup > IRIS section, restart the IRIS daemons by typing:

qiris
siris

b. For changes to the Setup > RVP section, stop any running utilities with the
command systemctl stop <service unit>, for example:

systemctl stop iris rvp10 rcp8

c. Restart the utilities with the command systemctl start <service unit>,
for example:

systemctl start iris rvp10 rcp8

RVP has a configuration state accessible through dspx. Part of that state is local to
the processor and part of it is also visible in Setup > RVP.

d. For changes to the Setup > RCP section, in addition to the above, you must stop
RCP8 (if you have one), and stop the antenna daemons, by typing:

$ qiris
$ sudo systemctl stop rvp10
$ sudo systemctl stop rcp8
$ qant
$ sudo systemctl start rcp8
$ sudo systemctl start rvp10
$ siris

RCP8 has a configuration state accessible through Antx. These changes take effect
when you return to the top level prompt. You must save your changes.

License changes can affect RVP and IRIS.
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7. If an error list is displayed,

a. Check the error list for parameters that you have customized and correct these
customizations.

b. Select Repair to make corrections that are necessary for the software but do not
need to be customized for your operation.

c. Select File > Save.

11.3 Running Setup after upgrade
After upgrading, the Setup utility fills in default values for any new settings that were added.
Vaisala recommends reading the Release notes document and then checking the new
settings to make sure they are right for your system.

1. Login as radarop.

The default password is: Va1sala!
(Note that the first character is capital letter 'V', and the third character is number one
'1'.)

2. Launch the Setup utility.

At startup for an upgrade, Setup checks the parameters to verify that they are within
reasonable bounds and lists any problems.
The listing gives the name of the variable in question and prompts the user to consider
the repair command. Errors are usually related to new features that have not been
addressed or outdated features that do not conform to the current upgrade.

3. In the list dialog, select Repair to replace any mismatches with the appropriate default.

4. If you receive errors related to customized fields that are important to your operation,
see Invoking Setup and built-in error checking (page 149).

11.4 Radar video processor setup
To configure radar video processor (RVP) parameters, launch the Setup utility and select
RVP - Radar Video Processor.

For more information, see RVP10 User Guide (M212604EN).
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11.4.1 System type

Figure 29 RVP system type setup parameters

System has processor
• Select Yes for radar systems. When selected, additional configuration parameters

are shown.
• Select No for Analysis systems.

Interface type
• DspExport
• Native
• SCSI
For SCSI interfaces, type the SCSI device path in Device file.
For dspexport interfaces, you see the following questions:

dspexport host name or IP Address
Set the host name with the processor.

dspexport Port
Set the port number, normally 30740.

Processor type
Select your RVP.

Check byte order on powerup
The recommended setting is No.
Select No for systems with a pre-processor that does not support these
opcodes.
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11.4.2 Optional data parameters

Figure 30 RVP data parameters
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Polarization Diversity
Select whether your radar supports multiple polarizations.
The figure shows an example with polarization diversity turned on.

Polarization receiver scheme
Select the type of polarization receiver system you have. Choices are Single and Dual.
Select Dual for receivers on both the co- and cross-polarized channels. This allows
measurement of depolarized power, for example. For more information, see dual-
polarization processing algorithms in RVP10 User Guide (M212604EN).

Polarization transmit scheme
Select whether the radar has a single tranmitter or two transmitters.
”Polarization transmitter scheme” field active only when ”Polarization Diversity”
enabled.
If Polarization transmit scheme: single:
• In Calibration:

• Test signal gen. control in use
• Test signal level

• In Pulse Width #x:
• Burst power at calibration
• Digital filter loss at calibration

If Polarization transmit scheme: dual:
• In Optional Data Parameters: Burst power diff. (v/h) at calibr.
• In Calibration:

• Test signal gen. control in use
• Horiz test signal level
• Vert test signal level

• In Pulse Width #x:
• Transmit power at calibration (V)
• Burst power at calibration (H)
• Burst power at calibration (V)
• Digital filter loss at calibration

Burst power diff. (V/H) at calibr.
This field is active when Polarization Diversity is enabled and Polarization 
transmitter scheme is set to Dual.

Signal Quality Index
Select if you wish to allow the recording and display of SQI.
This enables SQI options in the task configuration menu and in Ascope.

Signal-to-Noise Ratio (SNR)
Select if you wish to allow the recording and display of SNR.
This enables SNR options in the task configuration menu and in Ascope.

Major mode 'User 1' custom name
Use these optional fields to take advantage of the extensibility of the RVP API and
specify customized Major modes.
See RVP10 User Guide (M212604EN).
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Single Polarization Radar
Polarization

For fixed polarization radars, enter the type of polarization here. Options are
Horizontal and Vertical.

Dual Polarization Radar

RVP requires a license to produce dual-pol data.

For radars with polarization diversity, the following configuration options are available:
ZDR Tx/Rx gain offset

This is an offset used on systems able to calculate ZDR if there is a difference between
the gain at the 2 different polarizations which results in a bias.
This number is added to the ZDRs otherwise computed. It is stored to the nearest 1/16
of a dB.

LDR Rx gain offset
This is an offset used systems able to calculate LDR if there is a difference between the
gain at the 2 different polarization receivers which results in a bias.
This number is added to the LDRs otherwise computed. It is stored to the nearest
1/100 of a dB.

Polarization Handling

The following parameters manage polarization handling:
HV off time before Polar change

When the transmit polarization is changed, the dsp library turns off the high voltage
this much in advance of the switch.
This is needed on some systems to prevent arcing while switching.
For Vaisala systems, the default value is 1.0 seconds.
To disable the feature, enter a value of 0.

Max Wait for Polarization change
Enter the worst case time it could take to switch polarization.
The dsp library waits for confirmation of the new polarization, up until this time is
exceeded.
If there is no confirmation, then this time is always waited. If the high voltage was
turned off before the switch, it is turned back on after the wait.
For Vaisala systems, the default value is 3.0 seconds.

XMT Supports...
Defines which transmit modes the transmitter supports (H only, V only, simultaneous
H+V, alternating H+V).
Vaisala radars support H only and simultaneous H+V.

Available Polarization Moments

Use the following parameters to select which types of polarization transmission are available
on your radar:
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• Differential Phase (PhiDP)
• Correlation Coefficient (RhoHV)
• Depolarization Ratio (LdrH&V)
• Covariance Magnitude (RhoH&V)
• Covariance Angel (PhiH&V)
• HydroClass (HClass)
• Signal Quality Index (SQI)

Enable all polarization parameters that can be measured by your radar system. There is no
question for ZDR, because that is available on most dual-pol radars.

HydroClass requires a license in RVP.

11.4.3 System parameters

Figure 31 RVP system parameters

Transmit Wavelength
Enter the wavelength in centimeters.

Transmitter Type
Choose the transmitter type of the radar (for example, Magnetron or SSPA). This
example illustrates that the phase control option displayed if a magnetron transmitter
is used.

Default PRF
Enter the PRF to be used by the utilities if the PRF is otherwise unspecified. Set it
below the maximum PRF for the longest pulse width to preserve the transmitter duty
cycle regardless of the pulse width setting.
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Noise Sample PRF
Enter the PRF in Hz for noise sampling (see RVP10 User Guide (M212604EN)).
Typically, a value of 200 Hz is adequate.

Number of Pulsewidths
Enter a number 1 ... 4 for the number of pulse widths that are supported.

HV off time before PW change and Wait time after PW change
Controls behavior if the pulse width and PRF values change by defining the following
conditions:
• How long to wait after changing the PW before changing the PRF.
• How long to wait after changing the PRF before changing the PW.
• How long to wait after changing the PW before we are sure we can detect the new

PW state.
• How long to wait after changing the PW before we turn on the HV, if it was turned

off.
See the following examples.

These delays protect magnetron radar transmitters, which take some time to
change their pulse forming networks, and protect systems using the RCP to control
the pulse width. When the RCP controls the pulse width, there may be a small
variable delay before the command takes effect.
For example, for magnetron transmitters, the suggested values are 0 for the HV off
time before PW change, and 0.5 seconds for the Wait time after PW change.

When IRIS changes the PRF only, and not the Pulse Width:

It freely changes the PRF without any delays.

When IRIS changes the Pulse Width only, and not the PRF:
1. Turn off the High Voltage (only if it was on, and the HV off time before PW change is

nonzero).
2. Wait the time specified in HV off time before PW change.
3. Set the pulse width to the new value.
4. Waits the time specified in Wait time after PW change.
5. If possible, checks that the pulse width actually changed.
6. Turn High Voltage back on (only if turned off in step 1).

When IRIS changes the Pulse Width and the PRF, and the new PRF is higher than
the old PRF:

1. Turn off the High Voltage (only if it was on, and the HV off time before PW change is
nonzero).

2. Wait the time specified in HV off time before PW change.
3. Set the pulse width to the new value.
4. Wait the time specified in Wait time after PW change.
5. If possible, checks that the pulse width actually changed.
6. Sets the PRF to the new value.
7. Wait the time specified in Wait time after PRF change.
8. Turn High Voltage back on (only if turned off in step 1).
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When IRIS changes the Pulse Width and the PRF, and the new PRF is lower than the
old PRF:

1. Turn off the High Voltage (only if it was on, and the HV off time before PW change is
nonzero).

2. Wait the time specified in HV off time before PW change.
3. Set the PRF to the new value.
4. Wait the time specified in Wait time after PW change.
5. Sets the pulse width to the new value.
6. Wait the time specified in Wait time after PRF change.
7. If possible, checks that the pulse width actually changed.
8. Turn High Voltage back on (only if turned off in step 1).

11.4.4 RVP calibration
The following parameters are shown when Polarization Diversity is enabled:
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Figure 32 RVP calibration parameters - Dual-transmitter radar

The following parameters are shown when Polarization Diversity is disabled:
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Figure 33 RVP calibration parameters - Single-transmitter radar

Horizontal beamwidth/Vertical beamwidth
Type the horizontal and vertical antenna half-power beam widths in degrees.

Antenna gain
Type the antenna gain on the axis of the antenna in dB.

Cal signal bandwidth
• For a normal signal generator enter Narrow.
• For a noise source enter Broad. For noise sources, enter the ENR value.
For noise source, you must use a single point calibration, for a signal generator you
must use multiple power levels.

Horiz/Ver Transmit loss
Type the transmitter power loss values in dB between the transmitter and the antenna
feed.

Horiz/Ver Receiver loss
Type the receiver loss values in dB from the feed to the receiver. This is usually the
same as the transmitter loss.

Horiz/Vert Test signal loss
In performing calibrations, a test signal generator is injected into the system. This
accounts for any loss of test signal power in the connection between the test signal
injection point and the receiver. Losses in the cabling and in the directional coupler are
usually included here. These losses may also be calibrated out when you set up your
signal generator.

Internal test signal gen. in use
Select whether internal test signal generator is in use.
Answering Yes activates the test singal level fields.
If Polarization Diversity is disabled in the optional data parameters, then only one
field is available.
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Horiz test signal level
Type the horiz test signal level.

Vert test signal level
Type the vertical test signal level.

For dual polarization radars, you can type loss values for the horizontal and vertical
channel to deal with differences in the waveguide, as well as correcting for transmitter
power effects.

Single polarization and simpler configurations have fewer loss values.

Example

In the following example, we assume that the horizontal and vertical powers are both
200 kW, with a 1.0 dB loss in the horizontal waveguide, and a larger 1.5 dB loss in the
vertical waveguide.

We also assume that in H+V mode, the power splits unevenly with 90 kW to horizontal
and 110 kW to vertical. This gives 3.5 and 2.6 dB losses over the full power case. This is
added to the waveguide losses to get 4.5 and 4.1 dB.
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11.4.5 Signal processing options

Figure 34 RVP signal processing parameters

Gaseous attenuation
The gaseous attenuation constant determines the atmospheric attenuation in dB/km
used by RVP when acquiring radar data. For a 5-cm radar, a reasonable default value
is 0.016 dB/km.

Power spectrum window
Select the type of window that the signal processor should use when power spectra
are computed. Choices are:
• Rectangular
• Hamming (Def)
• Blackman

AGC decay code
Enter the time constant of the exponential average applied to the log receiver to
produce the AGC signal. ONLY used on the RVP6 processor only, and it is typically set
to 3.

Dual-PRF / AGC delay
Enter the number of pulses to send through the clutter filters prior to the start of each
ray. These pulses stabilize the filters. Typically set to 2.

Parameter data width
• 8-bit
• 8&16-bit. In this mode, you can select the data width in the task configuration menu.

Velocity sign
• Normal.

Vaisala recommends that you set this parameter to Normal unless you have another
computer wired up to the signal processor which displays velocities reversed and
cannot be changed.

• Inverted.
IRIS inverts the velocities as they are read from the signal processor, and the Ascope
utility reverses the T and A signs on its display.
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Sync mode fuzz angle
The suggested value for this is 0.15°. If IRIS uses angle sync mode, this controls the
tolerance.

For more information, see RVP10 User Guide (M212604EN).

11.4.6 Data simulations

Figure 35 RVP data simulation parameters

The data simulator provides separate time series for every bin that is being processed.

Along with Ascope, this provides a convenient way to study the bias and uncertainty of
processing algorithms on simulated data.

Clutter width scientific units
Options are Normalized or meters/sec.

Clutter width (Gaussian model)

More information

‣ Digital signal and target simulators (page 65)

11.4.7 Pulse width definitions
The parameter window is different according to whether the Polarization Diversity
parameter in Optional Data Parameters is set to Enabled or Disabled.
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Figure 36 RVP Pulse Width Definition parameters: Polarization Diversity disabled

Figure 37 RVP Pulse Width Definition parameters: Polarization Diversity enabled

Each pulse width has its own set of configuration parameter values:
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Pulsewidth
Enter the first pulse width (usually the shortest) in microseconds.
Setup prompts for the other pulse widths.

Range Mask Spacing
Set this value to match to the spacing (in meters) between successive bins in the
range mask of your signal processor.
The value varies depending on the type of signal processor, and with the choice of
acquisition clock frequency.
The resulting bin spacing (that should be copied into this setup slot) is printed in the
RVP TTY dialog.

Output bit pattern
Enter the base 10 value of the 4-bit output signals that the signal processor uses to
control pulse width.
Recommended values are 1, 2, 4, and 8 for pulses #1 ... 4.
This has no effect on systems that do not use the signal processor to control the pulse
width.

Minimum PRF
Check with your manufacturer to see if there is a lower limit. A value of 160 Hz is
usually acceptable.

Maximum PRF
Enter the maximum PRF in Hz allowed for pulse width #1 (specified above).
Setup prompts for all pulse widths.
Use the PRF limit corresponding to the longest pulse width (this should be the lowest
maximum PRF). This guards against cabling errors.

Transmit power at calibration
Enter the peak transmit power (Watts) for each pulse width. Set unused pulse widths
to 0.

Burst power at calibration (H)

Burst power at calibration (V):

Digital filter loss at calibration

11.4.8 Custom Trigger Period Sequences
This is a feature only implemented on RVP7.

Always leave these lengths set to 0.
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11.4.9 Setting-up Real Time Display (RTD)

Figure 38 RVP RTD parameters

System Transmits RTD
This option enables or disables the transmission of the RTD and shows or hides the
RTD setup options.
When enabled you can specify up to 16 separately configured transmitter channels.
Choices are:
• No

RTD transmission is disabled.
• From App

An application program such as IRIS Ingest issues RTQ library calls to supply the
data stream.

• From RVP
RVP provides the data. In this case, the host application requires no modification to
support RVP generating a display.
A single computer cannot generate from both sources.
If you are using dspexport, then both the host computer and RVP can generate
data.

RTD transmitter priority

Maximum number of bins in display
This parameter limits the bandwidth of data transmitted over the network for the real
time display.
It is used only in rtd_v1_xmt.
The display is usually acceptable with only a few hundred range bins of data. The
maximum size of a ray that can be transmitted over the network is approximately 1500
bytes. Each data type takes up 1 byte. If there are more range bins in a task than can
be sent, IRIS sends only 1 out of every N bins, where N is the smallest number possible.

Chapter 11 – Setup utility

167



Number of RTD channels
Shows the number of RTD channels. You must increase this number each time you add
a new RTD channel to the configuration.

RTD Channel Parameters

Each RTD channel has its own set of configuration parameters:
Name of RTD transmitter #1

Specify the name of the executable program which is run to transmit the real time
display stream for this channel.
Vaisala recommends the default transmitter rtd_v1_xmt.
Vaisala also ships 2 other transmitter programs: rtd_v2_xmt and rtd_nids3_xmt.
You can also customize the format by writing your own program and entering it here.
The API and the existing transmitter programs are public.

Broadcast IP address #1
Specify the broadcast addresses here.
Generally only one is used, and it is your network address with the machine number
set to 255.
You can use the local loopback address 127.0.0.1 to display only locally. To find your
address, type netstat -nr to list your interfaces.
For example, if your interface is called eth0, type ifconfig eth0 to show your
broadcast address. If it is not there, you may need to turn on the broadcast feature.

UDP port #1
Specify your port number here. Any unused port number can be used, but Vaisala
suggests using 30730 as a default.

Data to send
Select Z,V,&W for minimal data types, Single Pol for all single polarization data, or
Dual Pol for all data types.
This control also only applies to the rtd_v1_xmt format.
Note that there is an internal limit of 10 data types.

More information

‣ Real Time Display data handling (page 139)

11.5 Radar control processor setup
To configure radar control processor (RCP) parameters, launch the Setup utility and select
RCP - Radar Control Processor.

For more information, see RCP8 User Guide (M212923EN).
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11.5.1 Interface to RCP

Figure 39 RCP Interface configuration parameters

System has an antenna
In most environments only the radar host systems have an antenna.
Select No for all analysis and display systems.

Main interface to RCP
• Network

This is the most common interface on RVP and RCP systems. It uses a multicast
network socket to send and receive information from the RCP.
For network interfaces you must enter the multicast address, port number, interface,
and network delay.

• Serial
This is the legacy serial cable interface. You must also enter the serial device file
name. For RVP systems using a serial tag interface to the RCP, enter Serial for the
interface and Normal RCP for the angle source.

• AntExport
Not recommended for general use. Allows a low-bandwidth remote host to get
antenna control and status. All the other setup questions are removed because that
information is automatically exported from the main RCP system.

• None
On an RVP systems with a hardware interface for angle input (either parallel tags or
synchro inputs) enter None for the interface, and Native RVP for the angle source.

For RCP and RVP interface configuration examples, see Network Export overview
(page 245).
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Antenna angle insertion source
Shows which angle source used to determine the current antenna position. Other
information, such as the status and control bits always comes from the Normal RCP
interface.
• Normal RCP

The antenna angles arrive in the normal network packets from the RCP.
• Native RVP

The RVP gets angles from a hardware source.
• Native RCP

The RCP inherently knows the antenna position.

Is this the 1 controlling host
Select one of your computers to be the controlling host.
This is the only computer that sends transmit packets to the RCP. These packets
control antenna position and other switches. If you configure more than one host as a
controller, you cannot be in full control.

Network Interface Configuration Options
Network Multicast Address

We suggest using the default address of 224.0.0.3. This is a "link-local" address which
by default is not passed through routers and instead goes through switches and hubs.
If you need to go through a router, consider using the site-local address
239.255.0.1.
The strength of the multicast addressing scheme is that the antenna position
information can go to several recipients simultaneously, so both the RVP and the IRIS
host can receive antenna information. However, the packets may travel to other
machines on the local network and cause network administrators to complain.
Be sure to set the same address and port number on RCP8 and RVP as needed. The
multicast addresses have many reserved values, so if you have more than one RCP8
system at a site, we recommend using different port numbers, rather than different
addresses.

Network Port Number
Suggested default of 30785. Increment from there if needed.

Network Interface
Specify which Ethernet interface to use for the RCP communication.
If the antenna information does not need to leave the local computer, then use the
loopback interface of lo.

Average Network delay
Vaisala recommends that you start with the default value of 0 ms here. This is the
packet transmission delay from the RCP8 to the local system. For slow networks
measure this by pinging RCP8 and enter half the average ping time.
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Serial Interface Configuration Options
Main serial device name

Type the pathname of the device file for the serial port wired to the RCP. For internal
simulation, set this to blank.
You can freely substitute FIFOs for serial device files. What to do is based on the
device name: If the device pathname ends in -x or -y, then IRIS assumes that we are
opening a FIFO pair to be used in some sort of loopback mode.
For example, first create the FIFOs:

$ cd /etc/vaisala/irisrda
$ mkfifo ant_fifo-x ant_fifo-y

Then choose /etc/vaisala/irisrda/ant_fifo-x as the device name. IRIS
writes to the specified FIFO, and reads from the other. If the RCP is a Vaisala RCP,
choose /etc/vaisala/irisrda/ant_fifo-y as the RCP8/SiteHost serial port.

Running at and with parity
Specify the baud rate and parity of the serial port.
For AntExport interfaces expect the following questions:

AntExport hostname/IP-Address
Type the host of the exporting system.

AntExport Port Number
Suggested default of 30745.

All Interfaces
Receive format from RCP

Enter one of the following antenna reception formats for both the main and auxiliary:
• No Reception
• rcv01 (Original RCP)
• rcv02 (Enhanced RCP)
• rcv03 (Shipboard Format)
• rcv05 (Dual System)
• Scientific Atlanta 3860

Transmit format to RCP
Enter one of the following antenna reception formats for both the main and auxiliary:
• No Transmission
• xmt01 (Original RCP)
• xmt02 (Enhanced RCP)
• xmt05 (Dual System)
• Scientific Atlanta 3860

Allow extended packets
For Vaisala radars, set this to YES.

For information on the reception formats, see IRIS Programming Guide (M212927EN).
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11.5.2 Advanced Interface features

Figure 40 RCP Advanced Interface configuration parameters

Antenna is on a moving platform
Use this to enable the INU related setup questions, and platform motion correction in
the real-time display.

INU info insertion source
This tells which INU source we are using. Normally we use RCP8. If we are getting INU
information from a custom extended header library, then enter Custom Header. Only
visible on moving platform systems.

Auxiliary receive/transmit format
Some systems have 2 serial lines each for transmitting and receiving RCP control
information.
Only the primary line is used to receive information. If your system uses 2 lines,
configure the second line as the auxiliary.

Auxiliary serial device name
Available when a Auxiliary receive format is set to something other than No 
reception/transmission.
Enter the auxiliary serial device file when used.

Start RCP Simulator
Used for simulated systems to automatically start up the antenna simulator when the
antenna driver starts.

Receive/Transmit Subprocess Priority
On UNIX systems, set the priority to -15.
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Timezone of time packets
Some RCPs are configured to send the current time to IRIS over the serial link.
Use this value to set the time of the radar computer at the safest times. This specifies
the timezone of that data stream.

Trust timestamps in RCVxx
Some RCP serial formats include a timestamp used to accurately time sequence the
received data.
Set this to No on systems attached to RCPs that do not fill in those numbers.

Extended header format name
Set this to blank for systems with no custom extended header.
If you have custom extended headers, enter the name of the extended header shared
library.

11.5.3 Packet and data logging

Figure 41 RCP packet and data logging configuration parameters

Produce log files on disk
Choose either Yes or No.
You can use antenna log files to debug errors in the antenna position, BITE packets,
Time packets, and INU packets.
When enabled, a log file called ${IRIS_LOG}antlib.log is created. This log file is
rotated using log rotate, as configured by /etc/logrotate.d/sigmet-antlib.
These files are also used to produce the BITEX histograms.

Log incoming Antenna I/O Packets
Choose either Yes or No to log incoming Antenna I/O Packets in the antenna log file.

Log incoming BITE I/O Packets
Choose either Yes or No to log incoming BITE I/O Packets in the antenna log file.

Log Incoming Time I/O Packets
Choose either Yes or No to log incoming Time I/O Packets in the antenna log file.
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Log unrecognized I/O Packets
Choose either Yes or No to log unrecognized I/O Packets in the antenna log file.

Log AZ/EL data insertions
Choose either Yes or No to log the AZ/EL position of the antenna in the antenna log
file.

Log INU data insertions
Choose either Yes or No to log INU data in the antenna log file.

11.5.4 Radar site and antenna placement
To check or update radar placement information, select Setup > RCP Radar Control 
Processor.

Figure 42 RCP radar site and antenna placement configuration parameters

Ground height above sea level
Enter the height above sea level (in meters) of the ground at the radar site. All product
heights are referenced to this value.
If you wish to make products relative to sea level, enter 0 and put the ground height
and tower height into the next question. If the radar is on a ship, then a value of 0 is
appropriate.

Antenna height above the ground
Enter the height of the radar antenna above the ground height chosen above. 1)

Default Latitude of antenna
Enter these values in decimal degrees with as many places of accuracy as desired (N
and E are positive). 1)

Default Longitude of antenna
Enter these values in decimal degrees with as many places of accuracy as desired (N
and E are positive). 1)

1) If you are using RCV03 format, this number (set in meters) is overridden by the altitude reported from the antenna controller.
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Moving platform systems
Antenna position ...

Enter the distance in meters from the inertial navigation unit (INU) location to the
antenna location. This is recorded with the data and used for platform motion velocity
corrections.
For example, if the INU is located in the middle of a ship at sea level, and the antenna
is 10 meters (32 ft 10 in) above the sea, 15 meters (49 ft 3 in) to the stern and centered,
enter the values -15, 0, and 10.

INU height offset
For moving platform systems that do not correctly measure the height of the INU, this
number is added to what is reported by the antenna controller.

Antenna Scan geometry
Choose from: Traditional and Aircraft Tail.
For an Aircraft Tail radar, the elevation angle scans continuously and the azimuth
angle is the angle of the scanning cone, where 0 is perpendicular to the elevation axis.
See IRIS Product and Display Guide (M212928EN).

11.5.5 Antenna characteristics

Figure 43 RCP antenna configuration parameters - Vaisala example

Elevation can spin 360
Set this to Yes to remove the need for the following 2 questions.

Minimum/Maximum elevation
The minimum and maximum elevation position in degrees that the antenna can safely
reach.
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Maximum azimuth/elevation velocity
The maximum velocity in degrees per second that the antenna can safely rotate on
each axis. This limit applies to both clockwise/counterclockwise and up/down motion.
The antenna should be able to achieve the velocity limits set here.

Initial mode for Azimuth/Elevation axis
This parameter sets the mode of the antenna when IRIS is first started. Select one of
the following values:
• Stop

The antenna is not moving when IRIS is started. This should be the antenna's initial
mode at sites where there is a possible hazard to personnel.

• Position
The antenna is moved to its initial position when IRIS is started.

• Velocity
The antenna is rotated at its initial velocity when IRIS is started.

If the initial mode for Azimuth/Elevation axis is not set to Stopped, the following
options are shown:

Initial Azimuth/Elevation position
Enter the position in degrees that the antenna should take when IRIS is started.
Used when the initial mode is set to position.

Initial Azimuth/Elevation velocity
Enter the degrees/second that the antenna should rotate when IRIS is started.
Used when the initial mode is set to velocity.

11.5.6 Timing features

Figure 44 RCP timing configuration parameters
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Radiate toggle period
IRIS automatically toggles the radiate control off for this time, then on again, once per
task if the following conditions are met:
• IRIS can control the radiation.
• IRIS can sense the radiation state.
• IRIS is requesting the radiation to be on, but it is actually off.
• Radiate has been requested on more that the Warmup time for transmitter

set in the ingest setups.
• Less than the Stop radiate toggle after time has passed since the transmitter was

not following the request.
Setting either parameter to 0 disables toggling. The recommended values are 1
second and 5 minutes.

Stop radiate toggle after
IRIS stops toggling radiate on and off after this time. That is, if radiate doesn't go on
after a certain time, it stops trying to turn it on.

Noise toggle period
When the INGEST process or the Ascope utility take noise samples, the signal
generator bit in the antenna controller is set for this amount of time after IRIS is
through with its noise tasks.
This value is used by Gematronik radars for calibration purposes.
Set this parameter to 0 if you do not need this feature.

Signal generator minimum /maximum value
The lowest and highest power output of the signal generator in dBm.

Signal generator warmup time
Time allowed after the signal generator is turned on before the signal level is assumed
to be correct.

Signal generator settle time
Time allowed after the signal level is set before the received power is measured. A
value of 1 second is recommended.

Initial signal generator value
Enter the signal generator level to use when IRIS is started.
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11.5.7 Control bit definitions

Figure 45 RCP control bit configuration parameters
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Pulse Width Control
Select either Disabled or Enabled. On driver powerup, the pulse width is not set until
it is also set in the signal processor.

Don't Overwrite Pulse Width

Polarization Control
Select either Disabled or Enabled. On driver powerup, the polarization is not set until
it is also set in the signal processor.

Servo Power Control
Choose either Disabled or Enabled to indicate whether the antenna controller can
control the servo power. 2)

Transmit Radiate Control
Choose either Disabled or Enabled to indicate whether the antenna controller can
control the transmitter radiation. 2)

T/R Power Control
Choose either Disabled or Enabled to indicate whether the antenna controller can
control the power to the transmitter and receiver rack.2)

Signal Generator Control
Choose either Disabled or Enabled to indicate whether the antenna controller can
control a signal generator for calibration purposes. 2)

Siggen Cont. Wave Control
Choose either Disabled or Enabled to indicate whether the signal generator can be
switched between Continuous Wave (CW) and pulse mode. 2)

Master Reset Control
Choose either Disabled or Enabled to indicate whether the antenna controller can be
reset. 2)

Noise Generator Control
Choose either Disabled or Enabled to indicate whether the antenna controller can
control a noise source for receiver testing and calibration purposes. 2)

2) If enabled is selected, an option for Active HIGH or Active LOW appears as well as an option for Initially Off or Initially On.
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11.5.8 Status bit definitions

Figure 46 RCP status bit configuration parameters
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Pulse Width Status
Select Enabled or Disabled to indicate whether the antenna controller can detect the
pulse width.

Polarization Status
Select Enabled or Disabled to indicate whether the antenna controller can detect the
polarization.

Servo Power Status
Select Enabled or Disabled to indicate whether the antenna controller can detect that
the servo power is turned on.
If enabled is selected, an option for ON: HIGH or ON: LOW appears.

Transmit Radiate Status
Select Enabled or Disabled to indicate whether the antenna controller can detect that
the transmitter is trying to radiate.
If enabled is selected, an option for ON: HIGH or ON: LOW appears.

T/R Power Status
Select Enabled or Disabled to indicate whether the antenna controller can detect that
the power is turned on to the transmitter/receiver rack.
If enabled is selected, an option for ON: HIGH or ON: LOW appears.

Signal Generator Status
Select Enabled or Disabled to indicate whether the antenna controller can detect
whether the signal generator is turned on.
If enabled is selected, an option for ON: HIGH or ON: LOW appears.

Siggen Cont. Wave Status
Select Enabled or Disabled to indicate whether the antenna controller can detect
when the signal generator is in continuous wave or pulse mode.
If enabled is selected, an option for ON: HIGH or ON: LOW appears.

Siggen Fault Status
Select Enabled or Disabled to indicate whether the antenna controller can detect if
the signal generator is in fault state.
If Enabled is selected, an option for Fault: HIGH or Fault: LOW appears.

RCP Shutdown Status
Select Enabled or Disabled to indicate whether the antenna controller can detect if
the RCP is turned on.
If enabled is selected, an option for Fault: HIGH or Fault: LOW appears.

Low Airflow Status
Select Enabled or Disabled to indicate whether the antenna controller can detect if
the airflow is low.
If enabled is selected, an option for Fault: HIGH or Fault: LOW appears.
You also can select whether the fault is treated as a normal or critical fault. Normal
faults are marked with yellow, while critical faults are marked with red, and can cause
mode switching and window alerts.

Low Waveguide Pressure Status
Select Enabled or Disabled to indicate whether the antenna controller can detect if
the waveguide pressure is low.
If enabled is selected, an option for Fault: HIGH or Fault: LOW appears.
The fault type is also specified.
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Antenna Local Mode Status
Select Enabled or Disabled to indicate whether the antenna controller can detect if it
is in local mode.
If enabled is selected, an option for Local: HIGH or Local: LOW appears.

T/R Local Mode Status
Select Enabled or Disabled to indicate whether the antenna controller can detect if
the transmitter/receiver is in local mode.
If enabled is selected, an option for Local: HIGH or Local: LOW appears.

Safety Interlock Status
Select Enabled or Disabled to indicate whether the antenna controller can detect if
the safety interlock is open.
If enabled is selected, an option for Fault: HIGH or Fault: LOW appears.
The fault type is also specified.

Standby Status
Select Enabled or Disabled to indicate whether the antenna controller can detect if
the transmitter is in the standby mode.
If enabled is selected, an option for Standby: HIGH or Standby: LOW appears.

Magnetron Current Status
Select Enabled or Disabled to indicate whether the antenna controller can detect that
the magnetron current is incorrect.
If enabled is selected, an option for Fault: HIGH or Fault: LOW appears.
The fault type is also specified.

Azimuth Encoder Status
Select Enabled or Disabled to indicate whether the antenna controller can detect that
the azimuth encoder calibration is correct.
If enabled is selected, an option for Cal: HIGH or CAl: LOW appears.

Elevation Encoder Status
Select Enabled or Disabled to indicate whether the antenna controller can detect that
the elevation calibration is correct.
If enabled is selected, an option for Cal: HIGH or CAl: LOW appears.
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11.5.9 Network status reports

Figure 47 RCP network status configuration parameters

Reporting
Select Enabled or Disabled. If enabled, the following options appear:
• Status fault polarity

Select either Active HIGH or Active LOW.
Since the site status bits in the XMT02/04/05 formats are set to 1 when a site is
okay, the recommended fault polarity is Active LOW.

• Initial state of sites
Select the initial fault status of all four sites as either All Okay or All Faulted.

• Radar Workstation 'A' site code, ...
Enter the site codes whose fault status is to be reported to the RCP for each of the
possible Radar Workstation sites and Data Processor sites.
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11.5.10 Radar status timing mode requests

Figure 48 RCP RST mode request configuration parameters

Use these questions to define up to 7 modes. Each mode has a number and a name,
corresponding to a Radar Status menu configuration.

When the configuration is changed in the Radar Status menu, the mode is reported back to
the RCP. Unrecognized configurations are reported as mode 0.

RCP can also send this mode to the Radar Status menu to change the configuration. A
request for mode 0 denotes automatic switch mode, which automatically switches
configurations based on warning products.

Radar Status name for MODE (1 to 7)
For each 3-bit nonzero mode value, enter the name of an IRIS configuration that is to
be activated when that mode is requested.

Mode to use when RCP is dead
This mode is automatically requested by the IRIS antenna driver if it detects that the
RCP is dead, that is, that the genuine desired mode cannot be determined.
This is valuable in dual/redundant systems that must switch to a known state when
certain errors occur. Setting the mode to 0 does not cause a mode change to occur for
a dead RCP.
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Mode reporting delay
To make sure that the RCP mode is never ahead or behind the IRIS task scheduler
mode, IRIS stops the old task, waits the set delay time, reports the new mode to the
RCP, waits again for the delay, loads the new task schedule, and runs it.
If your system does not use the RCP mode report, then the default setting is 0. Note
that if the RST menu switches modes, both modes have the same task schedule, the
tasks are not stopped and no delay is applied. The same is true for the product
schedule.

11.6 IRIS input setups
IRIS allows you to configure up to 16 input devices. Each input is a separate process
watching a special directory looking for files to arrive. When a file arrives, the process
invokes a conversion program, and adds the resulting data to the IRIS product inventory.

The netCDF and HDF5 input pipes require 16-bit data.

Number of input devices

Enter the number of inputs you wish to configure for your system. The maximum number
supported is 16.

Menu alias

Enter a name for this input.
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Pipe program name

Enter the name of a conversion program run when a file arrives.

IRIS checks for this program in the ${IRIS_PIPES} directory.

If you enter a blank name here, then it is assumed files are in IRIS product format, and are
directly inserted into the inventory after byte swapping.

Source directory

Enter the directory to monitor for files.

Each input channel must have a separate directory. At startup, all files found in the directory
are deleted. The input process then checks every few seconds for files. If it finds a file with
the same size as last time, it runs the pipe conversion program and deletes the file.

All files starting with a "." are ignored. If you are copying between computers you should use
"rename notification". In that scheme, the file is first copied to a temporary filename starting
with at ".". After the slow copy is completed, the file is renamed to the final name. This
prevents the input from reading a partial file. If the filename ends with .gz then gunzip is
applied before processing. If the file name with .Z, uncompress is applied.

The following table shows the input pipes supplied with the IRIS system You may also
choose to write your own. For more information, see the Antenna utility section of IRIS
Programming Guide (M212927EN).

Table 25 Supported IRIS input pipes

Name Supported
product types

Supported
data types

Syntax Purpose

Archive2toIris RAW Z, V, W   

BMPSatToIris USER None (Image
RGB or Grey
Scale)

Pipe Converts satellite image to IRIS
USER product.

BufrToIris PPI, CAPPI,
TOPS, MAX
RAIN1, RAINN

V, W, ZDR,
LDRh, Rain
Rate, RAIN

Pathnames Converts WMO BUFR format to
IRIS cartesian products using
OPERA guidelines

IMDSatToIris   Pathnames Converts India Meteorological
Department (IMD) satellite
data from HDF5 format to an
IRIS product.

The pipe is no longer officially
supported.

hdf52iris BASE, PPI,
CAPPI,Hydro
Class,
TOPS,HMAX,
MAX, RAIN1,
RAINN,
RHISRI, VVP,
VIL, XSECT,
RAW

 Pathnames Converts ODIM HDF5 file to
IRIS product.
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Name Supported
product types

Supported
data types

Syntax Purpose

HDFSatToIris USER  Pathnames Converts HDF4 satellite image
to an IRIS USER product.

KmaRadToIris CAPPI  Pipe Converts an array to an IRIS
CAPPI product.

KmaSatToIris USER  Pipe Converts satellite image to IRIS
USER product.

KnmiHDF5ToIris   Pathnames  

odimhdf52pb    Converts ODIM HDF5 2.4
polar data to IRIS Focus
protobuf format.

pb2raw    Converts IRIS Focus
protobuf format to IRIS Raw
format.

PBMSatToIris USER  Pathnames Converts a PBM, PGM, or PPM
satellite image to an IRIS USER
product.

PictureToIris IMAGE None (Image
RGB or Grey
Scale)

Pathnames Converts, for example, TIFF
files to IRIS IMAGE product.

RainbowToIris RAW T, Z, V, W, ZDR, Pathnames Converts Gematronik Rainbow
format to an RAW product.

The pipe is no longer officially
supported.

UfToIris RAW T, Z, Zc, V, w,
SQI, ZDR,
PhiDP, KDP,
RhoHV, LDRh,
LDRv

Pathnames Converts UF format to IRIS
RAW product.

Command line syntax

Use one of the following options to determine how IRIS runs the pipe program:
• Pipe:

pipe-pathname input-filename <input-pathname >outputpathname

• Pathnames:

pipe-pathname ip:input-pathname if:input-filename op:output-pathname
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Notification scheme

Use one of the following options to determine how IRIS detects that a new file has arrived:
• Polling:

IRIS checks every few seconds to see if a new file has arrived. If the file size is the same
as last time it checked, then the file is processed.

• TCP/IP Socket:
IRIS expects to receive a socket message on the specified port number every time a file
arrives. This allows immediate input without the delays due to a polling period.
The socket message syntax is the same as for a normal IRIS network receiver, that is
FILE followed by the filename and a null.

11.7 IRIS general setups

11.7.1 Modes and Protocols

Figure 49 IRIS Modes and Protocols

Timezone for data recording
Controls if the task schedule and the product schedule run on UTC or on local time as
well as the times shown in the menus and in the file names.
In both cases, you should set your computers system clock to the correct local time
zone.
In both cases, IRIS records all the information needed to display the data using either
UTC or local time.
If set to Local Time, you must use a local time zone that does not switch to and from
summer time.
If set to UTC, it is OK to have the summer time switch.

IRIS and RDA Utilities User Guide M212925EN-D

188



Operating system's time
Select Select from RCP to indicate whether the INGEST process should set the system
time from the RCP serial line time reports if the time difference is 2 ... 20 seconds. For
higher values, it signals a message.
If your RCP does not report the time, select Unaffected by IRIS.

Memory mapped I/O
Select either Available in OS for most systems or unsupported for HP9000/800,
which does not support a memory mapped I/O file.

External RCP mode change
Answer enabled if you want to allow the RCP to control the IRIS configuration that is
loaded into the Radar Status menu. This is only available on radar systems, set to
disabled on analysis systems. If enabled, then the External socket mode change
feature below is not available, and the automatic mode switch button on the Radar 
Status menu is not manually controlled.

External socket mode change
Answer enabled if you want to allow socket messages to control the IRIS
configuration that is loaded into the Radar Status menu. If enabled the automatic
mode switch button on the Radar Status menu is not manually controlled.

Status product mode change
Answer enabled if you want to slave your system's mode to another IRIS system.
When a status product arrives from the selected system, your IRIS changes to match
the mode. This is used for redundant system switching. If enabled, you see:
• Supplied by (Site Code)

Enter the site you wish to slave to.

Response to fatal errors
Select Restart Processes or No Action to indicate whether you want IRIS processes to
restart automatically after a fatal error occurs.

Maximum number of IRIS Clients
Enter the maximum number of IRIS client menu programs that can be connected to
the IRIS server at one time. A suggested value for this is 10.
IRIS takes about 30 seconds to free a client slot upon disconnection, so this parameter
should be set slightly larger than the actual maximum number you want.
The menus display the message IRIS is not running on the selected node if the
client table is full.
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11.7.2 Speech and Signaling

Signal network warnings less than
When a product that contains a warning is received over the network, a signal and
beep is produced if the data time is within the following number of seconds of the
current time.
Zero means do not signal at all. The default setting is 600 seconds old.
IRIS can be configured to generate spoken output for important messages. Warning
instances are configured in the PRODUCT configuration menu.
You configure other possible speech options.
The sigaudio program can configure if you use spoken text, or play a waveform file.
Any of the options can be turned off by selecting No.
This setup can be overridden by the newer message configuration file.

Speak/Beep text products on arrival
IRIS has a special product type called "Text products". These products consist of an
IRIS header plus an ASCII string.
This causes the string message to be spoken when it arrives on a system.

Speak/Beep mode changes
Audio alert when a mode change is made.

Speak/Beep fatal errors
Audio alert when an IRIS product crashes. This can happen with a program error such
as divide by 0, or with the kill command.

Speak/Beep BITE faults
Audio alert when a critical BITE fault is signaled.
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11.7.3 File and System Quotas

Total space for INGEST files
When the INGEST data exceeds this level, old data is automatically deleted.
It is important to keep at least 10 % of the disk free when the INGEST, RAW, and other
product files have reached their maximum usage.
To estimate the available space for these files, delete all the files, then find out how
much disk space is available by typing df.
Take the free size minus 10 % of the full size and divide by 2000 to convert blocks to
megabytes.

Kept INGEST file space
Enter the percentage of the total disk space that can be used for kept ingest files (files
that cannot be deleted by the Watchdog process). When the kept files exceeds this
quota, the oldest are deleted first.
A reasonable value is 50 %.

Total Space for RAW Products
When file space used by RAW product data exceeds this level, old data are
automatically deleted.

Kept RAW-Product File Space
Enter the percentage of the total disk space that can be used for kept raw product
files. When the kept files exceeds this quota, the oldest are deleted first.
A reasonable value is 50 %.
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Total space for Other-Products
When the file space used by non-RAW product data exceeds this level, old data are
automatically deleted.

Kept Other-Product file space
Enter the percentage of the total that can be used for kept product files. If the kept
files exceed this quota, the oldest are deleted first.
A reasonable value is 50 %.

Maximum products on Disk
This is the maximum number of products which allowed on the disk at one time. It is
used to allocate memory for the inventory.
A typical value is 10000.

Maximum products on Archive
This is the maximum number of products allowed on an archive media. Configure this
dependent on your media capacity.
A value like 20000 would be a good starting point.

Maximum number of output devices
Enter the maximum number of output devices that can be entered in the field (see
Output device general specifications (page 219)).
The larger the value, the longer it takes for IRIS to startup. For example, if you have up
to 10 output devices, IRIS starts very quickly at startup time. If 200 output devices are
required, IRIS takes longer to startup.
If the number of configured devices is exceeded, you receive an error message:
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11.7.4 Run-Time Priorities

Set the priority of each IRIS process.

This is called the nice priority on UNIX systems.

Almost all the normal processes run at nice priority 0. Valid numbers are in the range
-20 ... +20. The smaller the number, the higher the priority, suggested values are shown.

The ps command shows these numbers with 20 added to them.

11.7.5 Window Alert Configuration

Window alerts display important fault information by showing a large, X on top of the
display, possibly with a text message indicating the reason for the fault. These faults indicate
that the displayed data is suspect.
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Multi-site fault rule
Controls the widow alert, and the summary shown on the RST menu.
You can display a fault if either any one system has failed, or require that all systems
fail. The list of sites to consider is selected below in the site name section.

Alert Style
Select one of the following: Disabled, Red X and Text, Red X Only, and Text Only.
Select Disabled to turn off the feature and the remaining questions.

Display alert for site faults
Enable alerts based on the site fault summary shown on the RST menu. Note that an
alert is shown for timeout and critical faults only. Normal faults do not alert.

Display alert for stale image
Enable an alert when the image displayed on the screen is not current.
In auto-update mode, this prevents operators from seeing an old image for many
hours without realizing it.

11.7.6 Radar Site Names and Site Codes

These values are case-sensitive.

Unrecognized site code
The recommended value for the unrecognized site code is "XXX". This is used for all
data that does not match anything else in the table.

Check for Fault
Only sites marked are included in the RST summary and window alerts. This allows
you to exclude unimportant display systems.
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Site #(1 to 127) name
Site # name must exactly match the license Site Name. The Site Name is stored in the
ingest, product and product raw files.
You can define up to 128 sites defined, the unrecognized site, plus 127 others.

Code
The 3-character Code is used throughout the IRIS Menu for referencing to the Site 
Name. The codes appear in the Ingest Summary, Product Summary and Product 
Output Menus. IRIS prepends ingest, product and product raw files with the 3-
character Code.
If the typed code is less than 3 characters, then "_" will fill the missing characters.

To remove a site, enter "" for the site name and code.

11.8 License and Site Information Setups

Licenses are machine-dependent. To get your license, call Vaisala with your machine code.
To display the machine code, in the operating system prompt, type
show_machine_code.
If the machine code changes due to a change in the site name or if you install a new
version of the operating system, you must request a new license.
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1. In the Setup utility, select License.

The License and Site Information window opens.

Figure 50 License Setup example
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2. Check or update the license and site information.

License #1 to #6
Type the software licenses you received from Vaisala, including operational and
backup licenses and IRIS.
Also, if you are testing new features using a temporary license from Vaisala, IRIS
automatically grants the cumulative features based on all of the licenses. When
the temporary license expires, IRIS defaults to the original operational license.
The license file you receive from Vaisala includes a Features and a Products
license, and possibly an RDA license. These licenses can go in any of the 6 license
fields, but Vaisala recommends using the first 2 fields for organizational purposes.
These licenses consist of a 32-character string plus a user comment or
description:

XXXXXXXX-XXXXXX-XXXXXX-XX-XXXXXX comment

IRIS Style
Select a style to configure the menu selections and remove unneeded fields:

• Radar
Full IRIS/Radar system.

• Analysis
IRIS/Analysis systems.

Site name
Type a site name using up to 16 characters.
The Site name is saved with the data and used in displays and printouts.

You must choose the site name carefully.
If the site name changes, you must request a new license from Vaisala.

Hardware name
Normally this is the same as the Site name.
In a dual computer system in which 2 computers have the same IRIS site name,
Hardware name indicates which computer is running.
When making status products, Hardware name is used as the site name.

Site code
Type the site code for this site.

QLW
Type a password of up to 15 characters.
Quick Look Window users must provide this password to access operator
features.
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11.9 IRIS Ingest Setups

11.9.1 Data source selection

Define the data source by selecting:
From DSP

For normal radar operation select From DSP.

Simulated
For simulated data, IRIS supports simulation of a data field of winds and storm cells
which move about the radar.
You can use the options shown in the previous image to configure options for testing
compositing, the location and time offsets of the simulated data.
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11.9.2 Signal processing and data storage

Data truncation height
Any data calculated to be above this height are removed to save disk space. This is
typically set to 20 km (12.4 mi). This is height above the radar dish. This truncation is
not applied to manual scans.

Type of angle syncing
Select the method of angle syncing as Static, None, or Dynamic.

Source of recorded time
Enter one of the following values:
• RVP Tags

Time for each CPI is logged on RVP8. This feature is only available on RVP8 systems.
Active Ingest task scheduling is still based on the IRIS host computer, so such
systems should be time synched.

• IRIS Host
Time for each CPI is taken directly from the IRIS host computer. Because of
buffering, data arrives and is time tagged in groups of 2 or 3 CPIs.

DSP parameter computations
Choose either R2 algorithms or R1 algorithms.
Use the R2 processing algorithms to estimate SNR and spectral width.
You must set the RVP TTY Setup R2 processing question to user for this selection to
take effect.

Extended header format
Enter one of the following values:
• Not recorded

Doesn't record extended ray headers.
• V0

Records time and calculations
• V1

Records time and navigation.
Vaisala recommends not recording extended ray headers if they are not required.
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11.9.3 Scanning options

Reset the RCP on Ingest Startup
Causes an Error Reset command to be sent to the RCP when the INGEST process
starts. The reasons that you might want to do this are:
• In dual/redundant systems, the reset clears any error conditions that may

accumulate while the RCP was inactive. These generally are not real faults, and it is
safe to clear them automatically.

• In single radar systems the reset helps to insure that the RCP is ready to respond to
ingest's commands.

• With the reset enabled, you can then clear RCP shutdown conditions easily from the
IRIS Radar Status menu by toggling the INGEST process Off/On.

The main reason not to select the automatic reset is that you may prefer a policy in
which RCP shutdowns are always manually handled by an operator, after first
determining that the original cause of the failure has been repaired.

Task Scheduling Control
Normally set this to Active Only.
IRIS supports a Passive mode of data collection in which it is slave to other radar
control software. In this mode, IRIS monitors the azimuth, elevation, and PRF of the
radar and attempts to match it with the tasks in the task schedule, and to record data.
See IRIS Radar User Guide (M212926EN).
If Passive Only or Active/Passive is selected then the Passive Type is specified.
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Passive Type
The choices are:
• Multi-Tasking

Used for PPI Full scanning when the system controlling the antenna does one or
more volume scans. In this case there can be more than one task in the task
schedule.

• Single Tasking
Used for any scan mode (Sector, RHI, PPI Full, Manual). In this case there may only
be one task in the task schedule.

• Status Slaving
Can be used for any scan mode (Sector, RHI, PPI Full, Manual) and there can be
multiple tasks in the schedule.
The controlling computer must send a STATUS product to IRIS to signal which task
is about to start. In this case, there is an additional question to provide the Slaved 
to Site Code (three letter site code of the site sending the STATUS products.

• TS Playback
This can be used for any scan mode (Sector, RHI, PPI Full, Manual) and there can be
multiple tasks in the schedule. Use with tsarchive to play back recorded data.
The task is selected based on the name recorded with the data.

RHI elevation speedup ratio
During RHI scans, the antenna velocity is increased at higher elevations in order to
save time. This parameter controls how much faster the antenna goes at 90° elevation
compared to 0°. This is typically set to 10.

Permissible AZ/EL error during scans
The IRIS system insists that the antenna get to within this angular distance of any
desired position before proceeding. The tolerances are in degrees, and are typically
set to about 0.5°.

AZ/EL maximum speed at end positions
These speed limits work in together with the above position limits.
When the antenna is positioned within the angle tolerance, it must also be moving at a
speed less that these maximums. This prevents falsely proceeding in the case of an
underdamped antenna which moves quickly through its settling position several times
before coming to a stop. The speed limits also help to remove the initial elevation
"starting trail" during continuous PPI scans.
Vaisala recommends the setting of 0.5°/s.

AZ speed tolerance
At the start of each sweep, IRIS waits until the antenna speed is within the value of the
requested speed. This prevents the sweep from starting while the antenna may be still
moving too fast.

EL speed tolerance
Same as above for RHI Full sweeps.
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AZ/EL Min expected moving speed
When IRIS is positioning the antenna using the above angle and speed criteria, it is
possible that success is never attained. This can happen if the antenna gets stuck
before reaching the destination, or if it oscillates endlessly around that point.
During any repositioning operation, IRIS first calculates a maximum time to wait based
on the angular distance to be traveled and the minimum moving speed given here.
Five seconds are added to compensate for edge effects.
IRIS proceeds after this time limit expires, regardless of what the antenna is doing.
This prevents endless waits resulting from antenna defects.
Typical values are 1.0 to 5.0°/s. A value of 0 result in a fixed 5-second maximum wait.

AZ/EL min settling time between sweeps
These minimum times allow IRIS to work better when the step between tilts is very
small. In addition to the above criteria for determining that the antenna is close to a
desired position, IRIS waits these minimum times.

Direction of continuous scans
You can specify whether continuous PPI scans go clockwise or counterclockwise.
To equalize the wear on the gears, Vaisala recommends that you change this every
few months.

Coasting time between tasks
If the number of seconds between 2 continuous scan PPI tasks is less than this
number, IRIS does not stop the antenna between the tasks. This can prevent wear on
the antenna.
Set this value to 0 to always stop between tasks.

Optimize for continuous output
If set to Yes, the following changes are made compared to the legacy behavior:
• Leave the DSP in continuous output mode between tasks.
• If the same task is running continuously, skip reading the gparm data at the start of

the task. This means it would not detect faults like burst pulse missing.
• Do not set the sweep number value between sweeps.
Set the value to No unless you want continuous real-time displays.
For continuous displays, disable the noise sample in ingest.
When set to Yes, you should see only about 1 ray missing between tasks at 3 rpm 1°
resolution. Consider using instead the real-time data sent directly from RVP.
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11.9.4 DSP noise sampling

Perform noise sampling
Use this flag to disable automatic noise sampling done by IRIS. This is appropriate for
passive ingest. It can save scan time, and avoid contaminated samples.
Modern IF receivers do not have a noise level drifting problem. When disabled, noise
samples are taken from the values stored inside the RVP, be sure to type in and save
the powerup noise levels for each pulse width. Operational noise levels are not taken
from the value found on the last zauto calibration.

Time between noise samples
When a task starts, if it has been at least this long since the last noise sample, a new
sample is taken. This is typically set to 10 minutes.

Azimuth/Elevation during noise sample
Select either Don't care or Minimum Angle.
If you select Minimum Angle, an entry box appears where you can specify the azimuth
in degrees at which to take the noise sample.

Take sample whenever PW changes
If the signal processor cannot store separate noise levels for each pulse width, then
you must select Yes.

Retry bad noise samples and Noise retry wait
Use these questions to configure the noise sample interference detection.
Ingest attempts to detect the case in which during the noise sample you get
interference from another pulsed radar. This interference causes a higher noise
sample, and cause uncalibrated data, similar to hitting the sun at noise sample time.
Each time Ingest detects interference it sends the message Interference in noise
calculations.
Ingest then waits the retry wait time (typically 1 second) and tries again. This is
repeated up to the specified number of times.
The assumption is that the other radar is a scanning radar, so if you wait 1 second, it
should no longer be pointed at you. After the last attempt, if it still detects
interference, it still runs the scan. If you are getting false positives, you still get the
correct data.
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11.9.5 Transmitter control

Idle time to shut off transmitter
If no task is scheduled to run for this number of seconds, then the transmitter is
switched to standby to extend its lifetime (only in radiate automatic mode).

Warm-up time for transmitter
Each time an IRIS task starts, we wait this long since the radiate was turned on. This
allows time for a slow on circuit, and also time for the RVP to detect the burst pulse
power.
Many systems pulse with and polarization changes require radiate to be turned off. In
such cases this warmup time is triggered. If radiate is set to automatic and the
transmitter is off, it is turned on this many seconds before the task starts. Be sure to
set this less than the idle time above.

Pulsewidth and PRF are set
Ingest can set the pulsewidth and PRF. This allows the transients to settle if there is
time between scans.

11.9.6 Clutter suppression
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Excess power needed for valid dBZ
This configures IRIS ingest clutter map. If the Task Configuration Menu clutter map
button is pressed, IRIS looks for a ingest file marked as the residual clutter map. All
range bins containing data in the clutter map file are thresholded unless the current
data is at least this much higher. If we exceed the threshold, the dBZ value is passed
unchanged.

Elevation tolerance for matchup
When looking for the corresponding range bin in the clutter map file, the nearest
elevation angle is used up to this maximum difference. If none is found, then no
correction is applied.

Non-zero velocity criterion
If this is set to Check Velocity then data which would pass the excess power test is
thresholded if the velocity is near 0.

Clutter map in ReINGEST
If this is set to Enabled, the Clutter_map filter is applied to the data in reingest. The
filter is only applied if no other clutter map filter has been used. The ingest file from
that radar site must have the same task name and be marked as the clutter map.

11.9.7 Beam blockage

Beam blockage in Reingest
Enables applying IRIS's partial beam blockage algorithm when data arrives on a
system at reingest time.
The beam blockages config file must contain information individually for each radar
site to be processed.
See IRIS Radar User Guide (M212926EN).

11.9.8 DP intervening attenuation

This allows turning on/off the Dual-Polarization attenuation correction.

The DP attenuation is based on the principle that the attenuation is proportional to the
PhiDP. Because of noisy PhiDP at low SNR, the details are fairly complicated.
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You can fine-tune the configuration in the dpolat-ten.conf file.

11.9.9 Z-based intervening attenuation

You can configure the coefficients used for the intervening attenuation correction.

When enabled, the corrected reflectivity Zc is computed from Z using the following
equation:dBZc = dBZ + 2CΔrΣZE
Where C is the constant above, and E is the exponent. All values of Z are clipped at the
maximum Z before the calculation, and the total correction is clipped at the maximum
cumulative value.

We have default values for C and X band radars. We recommend no correction be used for
an S-band radar.

These numbers are used in both the ongest process if turned on in the task configuration
menu, and at reingest time when data arrives over the network, if the Atten correction in 
Reingest button is pressed.

DP-Attenuation takes precedence and we do not apply both attenuations to the same
data.

11.9.10 Target detection

This computes Zc with uniform weather removed. Any input signal of more than 2 range bins
in a row is smoothed and then only peaks are passed.

The goal is to pick out targets against a weather background.
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Only use this for target tracking. This can also be computed at ingest time as configured in
the task configuration menu.

11.9.11 Velocity unfolding

Maximum age of the "UNFOLD" VVP7
IRIS can be configured to automatically unfold velocity data, producing a data type
called Vc based on a VVP product on the disk which must be called UNFOLD.
This is the maximum time difference between the data and the time of the UNFOLD
product.
A 0 value disables the check.
See the NDOP product in IRIS Product and Display Guide (M212928EN).

Maximum separation to the VVP
The maximum distance between the radar location of the VVP product and the data
being unfolded. It might be necessary to unfold based on a different radar when one
radar's data is imported.

Velocity unfolding in ReINGEST
If enabled, Vc using unfolding is computed at reingest time, overriding any previous
values.
The recommended setting is Disabled, if unfolding is required, specify it in the task
configuration.

11.9.12 Velocity fallspeed correction
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Vt-Z Constant above melting layer
These questions allow you to specify Vt-Z relationship above and below the melting
layer, where Vt is the terminal velocity of the precipitation.

We use an exponential equation like: Vt = Constan tZExponent
See the NDOP product in IRIS Product and Display Guide (M212928EN) .

Fallspeed correction in ReINGEST
If enabled, then Vc using fallspeed correction is computed at reingest time, overriding
any previous values.
The recommended setting is Disabled, if fallspeed correction is required specify it in
the task configuration.
Note that if either Fallspeed correction in ReINGEST or Velocity unfolding in
ReINGEST are enabled, Vc is made at reingest time.

11.9.13 Storm relative velocity

Maximum age of the "STORM" FCAST
IRIS can be configured to automatically compute storm relative velocity data,
producing a data type called Vc based on an FCAST product on the disk which must
be called STORM.
This is the maximum time difference between the data and the time of the STORM
product. A 0 value disables the check.

Maximum separation to the FCAST
This is the maximum distance between the radar location of the FCAST product and
the data being processes.
It might be necessary to a different radar when one radar's data is imported.

Storm Relative Velocity in ReINGEST
If enabled, then Vc of storm relative velocity is computed at reingest time.
The recommended setting is Disabled, if wanted, specify it in the task configuration if
possible.

11.9.14 HydroClass
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Hydrometeor classification is called HydroClass in Vaisala documentation.

When enabled here, IRIS computes HydroClass data at reingest time.

HydroClass calculations in RVP are controlled by the Task Configuration Menu.

This is a separately licensed feature.

11.9.15 Melting levels

Enter an estimate for the melting level for each month. These are heights above mean sea
level.

The monthly values are default values, we assume you are changing these values
dynamically while IRIS is running. The melting level is used in several algorithms, such as fall
speed correction and HydroClass.

These melting levels on an IRIS/Radar system are loaded on the RVP processor, and are also
recorded with the RAW radar data. This allows downstream product generators to have
access to the correct melting level.

If you are not using this feature, and the numbers are set incorrectly, they disable melting
levels.

More information

‣ Reflectivity profile and wind (page 212)
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11.10 IRIS product setups

11.10.1 Product generation

Products from partial INGEST scans
Select yes or no to indicate whether products can be made from partial INGEST
volume scans.
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Default Z/R relationship constant/exponent
The system uses the following equation to express the relationship between
reflectivity and rainfall rate:Z = aRb
Z

The linear reflectivity

R
The rainfall rate in mm/hr

a
Relationship constant, empirically determined for each site.

b
Relationship exponent, empirically determined for each site.

IRIS usually solves for R to convert the radar's reflectivity data to rainfall rate, as
follows:R = Za 1b
Typical values for rain are a = 200 and b = 1.6. Using these values, suppose reflectivity
is measured at 20 dBZ. To solve for R, IRIS first converts dBZ to Z:20dBZ = 10log 10Z ∴ Z = 100
Then solve for R:R = 100200 .63 = .65mm/ℎr
An increase in dBZ, from 20 to 50 for example, creates an increase in rainfall rate:

The values you enter for the constant and exponent depend on the climate at the
radar site and experience gathered through use of the IRIS system.

Product arrival wait time
Scheduling timeout for products that require several inputs, but which can run when
some are missing.
Products which use this are: COMP, NDOP (with 3 inputs), and RAIN1.
For example, if a composite product requires 3 radar site inputs within 5 minutes. It
gets 2 of those inputs, then the 5 minute interval expires. If the Product arrival wait
time is set to 1 minute, then it waits for 1 more minute before running. This time is
meant to cover possible time differences between the radars and differing network
transfer speeds.

Raingage data arrival wait time
The time to wait for raingage data to arrive is set separately. This is used in the rainfall
correction of the RAIN1 product.

Alternating polarization features
This question enables the listing of the data types ZDR and KDP, and also the listing of
the K/R relationship in many of the menus. It also enables the following questions on
the K/R relationship below.

Default K/R relationship
These number allow control over the default KDP-R relationship, similar to the Z-R
relationship above.
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Read Cache size
The IRIS memory mapped I/O library routines support caching file read. It only
operates for reading files. Making this size nonzero disables memory mapping and
uses the specified cache size in the product generator.
If your system supports memory mapped I/O, then you may want to keep the caching
size at 0. If you do not have memory mapped I/O, then benefits can result by setting
the cache size to the approximate size of the INGEST volume scans that are being
processed. However, if there is not enough main memory to hold these cached data,
then the product generator is swapped to disk and no performance benefit are
achieved.

Zero Reference Height
Enter the height in meters above MSL used for 0 in the product generator. Generally
this should be 0 for mean sea level, but for radars far inland, you might want a
different reference. All radars to be composited together should have an agreed upon
reference. All heights displayed with the user cursor are relative to this reference.

11.10.2 Reflectivity profile and wind

This pane defines the reflectivity profile of a gradient above the melting level, a gradient
below the melting level, a melting layer thickness, and a melting layer intensity. The melting
layer height, is the intersection of the two gradients, and the top of the bright band.

These numbers are used in the SRI product profile correction, and in the CAPPI and XSECT
smoothing.

For more information, see IRIS Product and Display Guide (M212928EN).

You can change these numbers while IRIS is running.
Use Gradient in CAPPI & XSECT

Enables a vertical gradient extrapolation in product generation for CAPPI and XSECT
products.
This smooths out the top of the products using the Gradient Above Melting value in
the reflectivity profile.
This is the minimum value used when a lower sweep has valid data and the upper
sweep is below threshold.
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Gradient Above/Below Melting
Defines the gradient setting above and below the melting layer.

Melting Layer Thickness

Melting Layer Intensity

Default Wind
The default wind is recorded with the ingest data and can be used for adjustments to
the bird detection algorithm.
To use this feature you must automatically detect the wind speeds and enter them in
the radar system.

More information

‣ Melting levels (page 209)

11.10.3 Configuring IRIS status products
STAT (status) products are typically made on all IRIS systems that are critical to system
operation, such as the radar host, the product generator, and or critical display systems.
Instead of containing radar data, status products contain information about how well the
IRIS system is working.

These products are shown in the product output menu, and can be transferred to other IRIS
systems using the product output menu.

When transferred to another IRIS system, the receiving system becomes aware of faults or
problems with the sending system. For example, the radar-host status products are
distributed to most systems in a radar network, and the red-X is displayed on various
windows based on these status products.

The status product lists faults if any of the following occurs:
• BITEX critical faults
• RCP communication failure (RCP DEAD)
• RVP signal processor error
• IRIS internal critical fault. These are internal errors that are flagged as critical in IRIS.

If there is a change in status such as a critical fault, the Status product is generated
immediately.
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1. In IRIS Setup > Product, enable status product generation and configure the product
parameters.

Status product generation
If enabled, IRIS also generates status products when the overall system status
changes from OK to Fault, or the other way around.

Time between status products
Define how often you want to generate status products (in minutes). Select 0 if
you do not want to generate these products.

Make product for each task
Instructs IRIS to make a new status product each time a task starts.
This is useful if you wish to do status product task slaving.

Status Prod maximum file count
Type the number of status product files to be kept on the system.

STATUS product receive timeout
Select Disabled or Enabled.
If enabled, set this time slightly longer than the time between status products.
The default value is 11 minutes with products mode every 10 minutes.
This allows IRIS to detect failures of other networked systems. If it has been more
than the specified time since a status product has arrived from another system, it
is marked as Timeout on the network status display.

2. Identify critical systems.

3. Identify separate receiving system(s).

4. To configure the network identifiers, select IRIS Setup > RCP > Network Status 
Reports to RCP.

This makes it possible to identify the reported sites.

5. Output status products to receiving systems.

6. Determine which status products are referenced by the SIGNALS.DAT file for action.

7. Configure the SIGNALS.DAT file to take the appropriate action.

8. In the Product Output menu, configure the status products for output.
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The status products now enable IRIS systems to alert other systems on the network that
there are problems or that a particular event has occurred.

These messages can be parsed by the SIGNALS.DAT file and actions can be taken such as
sending an email to a cell phone.

11.10.4 Product transmission and display

WARNING max time difference
IRIS allows the automatic display of a warning overlay on top of any PPI or earth
projection product.
When the product is displayed, the WARN product with the nearest time is overlaid.
However, if the time difference exceeds this value, it is not overlaid.
The recommended value is 15 minutes. A value of 0 disables the check.

TRACK max time difference
If the time difference between the most recent point in the TRACK product and the
data time of the image exceed this limit, then the overlay is not drawn.
A value of 0 disables the check.

FCAST max time difference
Similar for forecast products.

Default max time difference
Similar for all other product types.
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Network send timeout
Each time IRIS starts a network transfer, a timer is also started. If the timer completes
before the transfer completes, the transfer is aborted. This prevents an infinite lockup
of the system in some cases where the network stops working in the middle of a
transfer.

Maximum files queued for send
Enter the maximum files that IRIS queues for sending to a network output device,
other devices have no limit (for example, in the event of a network failure). When the
link is restored all of the queued files are sent. The order of transmission is as follows:

1. All STAT products, oldest first.
2. All RAW products, oldest first.
3. All other products, newest first.

The receiving machine must then catch-up by processing all the data.
For critical real time applications, keep the number of backlog files in the queue small
(for example, 2 or 3) so that real time operation can resume quickly.
For a system where the data archive is important, set the number to be large, for
example, to 50, or to 0. A value of 0 means the maximum feature is disabled, and files
are queued with no limit. This limit applies only to network devices.

Centroid value signal
When WARN products are generated or arrive over the network, they can optionally
generate a signal if a warning is detected in a protected area.
Select here if the signal is based on the maximum or average data value. Vaisala
suggests using the average value.
All the warning generating products can show the warning message on the bottom of
the display window. Use these buttons to enable that feature, if desired.
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11.10.5 Product scheduling priority

Define the relative priorities for each product type using the range from 0 (lowest priority)
to 100 (highest priority).

The product generator sorts the full schedule of products and determines the next product
to run according to the following hierarchy:

1. User-defined product priority. All products of a given priority run in favor of products of
a lower priority.

2. Oldest data time. Within a given priority, the product that runs on the oldest input data
is scheduled before any others.

3. Order within the schedule, from top to bottom.

Different radar sights require different settings.
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Typical Schedule

A typical schedule might set:
• XSECT products to priority 30
• WARN products to priority 40
• All others to priority 20

Schedule Optimizing RAW Data Output

A site that must output raw data quickly would increase the priority of RAW products or
decrease the priority of products considered "background."

11.10.6 Protected areas

The IRIS warning product (WARN) allows you to define up to 32 protected areas.

If the warning results fall into one of the selected protected areas, a signal is sent to all the
IRIS terminals.

Each protected area consists of a rectangle. You can define the location, size, and
orientation.

If the area you wish to protect is of an irregular shape, you can piece it together with
several areas.

Name
Type a name for the region. The name can be up to 12 characters long. If the name is
blank, then the region is undefined and disabled.
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Center East/North of radar
Type the location of the center of the protected region in kilometers relative to the
radar.
Type values for West and South as negative numbers.

Width East-West
Enter the width of the region in kilometers. These numbers cannot be negative.

Height North-South
Enter the height of the region in kilometers. These numbers cannot be negative.

Orientation
You can rotate the region specified with the previous questions by up to 180°
clockwise from the straight orientation.

11.11 IRIS output devices setups

11.11.1 Output device general specifications
You configure the output device in Setup Utility > Output.

Number of output devices

Before adding an output device, update the Number of output devices field with the new
total number of output devices for your system setup.

The maximum number supported is 200. For information on increasing the value, see File
and System Quotas (page 191).

General output device questions

For each output device, the questions vary depending on the device type, the following
questions always appear.
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Device type
Enter the device type Archive, Link,Network, Printer, Window, or UNUSED.

Menu alias
Select a text alias that is displayed in the pull down menus where you are selecting an
output device.
The alias allows easy identification of output devices. For example, you may have
window outputs on several different workstations, and you could place the node name
here.

Min time between output
For slow network outputs, you can pace the outputs such that some of the outputs are
skipped by selecting a pacing time here.
To enable this feature, you must also tag the product header lines with the Time
Filter bit in the Product Output Menu.

11.11.2 Printer specific parameters

This setup is for printer output devices selectable from the Product Output Menu. Screen
dump style printing is configured from the printer/setup menu. Only Postscript printers
are supported.

Paper Size
Select the size of paper in your printer.
Choices are 8.5 × 11, 8.5 × 14, 11 × 17, A4 and A3.
If the paper size is wrong, the printer does not print.

Queue Name
Enter the name of your printer queue.
To see a list of available choices, type lpstat -a at the UNIX shell.
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Width and Height of image
Enter the dimensions of the print image to be generated and sent to the printer.
Postscript printers do not rescale to fit the screen.

11.11.3 Window specific parameters

Minimum time between output
Adds a "skip" for products sent to a particular destination.

Device movie length
Enter the number of frames in the Quick Look movie for that device, usually 20.

Width and Height of image
Specify the width and height of the target image.
This is the initial size and the size can be changed by the mouse. The space reserved
for Quick Look movies is based on the movie length and default image size.
If you change the image size during operation, the maximum movie length changes

Horizontal and Vertical offset
Specify the initial position of the window on the screen. This is the upper left corner.
On SGI systems an offset of 0, 0 places the window such that the window manager's
border is not visible.

Slide Show
Specify if the window should power up in slide show mode or not.

Display Name
Specify the workstation display and screen number on which the window is to appear.
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11.11.4 Network-specific parameters
You can configure network parameters in Setup Utility > Output.

File format

Enter the format of the file transferred. The recommended format for IRIS-to-IRIS transfers
is IRIS.

Table 26 IRIS Output File Format Options

Choice Description

IRIS File copied without conversion.

NORDRAD1 File converted to NORDRAD1 format

BMP -

GIF -

TIFF TIFF format with GeoTIFF header information, you can view the GeoTIFF
information with listgeo.

JPEG -

PNG -

Postscript -

None File is not copied. Notification is sent.
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Choice Description

Pipe User-specified pipe program

Pipes are programs are run separately from IRIS. This gives flexibility because you
can install your own, and you can upgrade the program without interrupting IRIS.

Note that detailed error messages cannot be signaled to the IRIS error log. Instead,
a generic fault signal is logged saying to look for an error log file. These pipes write
a *.log file in the ${IRIS_LOG} directory.

The pipe configuration tuning cycle consists of:

1. Attempting to output a file.
2. Checking the log file.
3. Editing the .conf file.
4. Trying again.

Header File header is copied.

Pipe program name

This parameter is shown if you select a pipe file format.

You can specify the name of a user supplied pipe program used to format the output file.
The program must be placed in the ${IRIS_PIPES} directory.

The following table shows the output pipes supplied with IRIS.

For information on writing your own pipe see IRIS Programming Guide (M212927EN).

Table 27 Supplied IRIS output pipes

Name Supported
products

Supported data
types

Syntax Purpose

cfrnc2iris    Converts NetCDF
CfRadial 2.0 to IRIS
Raw

cfrnc2iris_fo
cus

   Converts NetCDF
CfRadial 2.0 to IRIS
Focus protobuf format

IrisToAdids PPI, CAPPI,
TOPS, BASE, MAX,
RAIN1, RAINN,
SRI, VIL,VIR,
LAYER,
HMAX,SHEAR

T, Z, Zc, Ze, V,
Vc, W, SQI, ZDR,
ZDRc, PhiDP,
KDP, RhoHV,
LDRh, LDRv,
PhiDPh,
PhiDPv, HCLAS,
VIL, Rain
Rate, RAIN, H,
SHEAR, SNR

Pipe Converts IRIS product to
ADIDS format.

IrisToArchive
2

RAW Z, V, W Pathnames Converts IRIS RAW product
to NEXRAD Archive2
format.

IrisToAsterix   Pipe Converts IRIS product to
Eurocontrol ASTERIX
format.
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Name Supported
products

Supported data
types

Syntax Purpose

IrisToBufr BASE,PPI,
CAPPIHydroCla
ss,HMAX,MAX,
RAIN1,
RAINN,RAW, RHI,
SRI,VVP, VIL,
VIR, TOPS

V, W, ZDR, LDRh,
Rain Rate,
RAIN

Pipe Converts IRIS cartesian
product to WMO BUFR
format using OPERA
guidelines.

IrisToEwis RAW   Converts IRIS to EWIS
format

IrisToGrib1 CAPPI, TOPS,
BASE, RAIN1,
RAINN, SRI, VIL,
HMAX, USER

Z, V, W, ZDR, Rain
Rate, RAIN, H

Pipe Converts IRIS Cartesian
product to WMO GRIB
version 1 format.

IrisToHDF5 PPI(NORDRAD),
CAPPI, TOPS,
MAX, RAIN1,
RAINN, RHI VVP,
XSECT, RAW

Z, V, W, SQI, ZDR,
PhiDP, KDP,
RhoHV, LDRh,
VIL, Rain
Rate, RAIN, H

Pathnames Converts IRIS product to
HDF5 format using
NORDRAD2 guidelines.

IrisToMcIdas PPI, CAPPI,
TOPS, BASE, MAX,
RAIN1, RAINN,
SRI, VIL, HMAX,
SHEAR

Z, Zc, V, Vc, W,
ZDR, LDRh, LDRv,
VIL, Rain
Rate, RAIN, H,
SHEAR

Pathnames Converts IRIS product to
McIDAS area files.

IrisToNetCDF RAW T, Z, Zc, V, Vc, W,
SQI, ZDR, ZDRc,
PhiDP, KDP,
RhoHV, LDRh,
LDRv, PhiDPh,
PhiDPv, HCLAS

Pathnames Converts IRIS RAW product
to NetCDF files.

iris2odimhdf5 BASE, PPI,
CAPPI,HydroCl
ass, TOPS,HMAX,
MAX, RAIN1,
RAINN, RHISRI,
VVP, VIL, XSECT,
RAW

T, Z, V, W, SQI,
ZDR, PhiDP, KDP,
RhoHV, LDRh,
VIL, Rain
Rate, RAIN, H,
SNR

Pathnames Converts IRIS product to
ODIM HDF5 format using
OPERA guidelines.

IrisToUf RAW T, Z, Zc, V, W,
SQI, ZDR, PhiDP,
KDP, RhoHV,
LDRh, LDRv

Pathnames Converts IRIS RAW product
to UF format.

IrisToUKMO   Pipe Converts IRIS RAW product
to UKMO format.

pb2cfrnc    Converts IRIS Focus
protobuf format to
NetCDF CfRadial 2.0
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Name Supported
products

Supported data
types

Syntax Purpose

raw2pb    Converts IRIS Raw to
IRIS Focus protobuf
format

VilToVir   Pathnames Converts an IRIS VIL
product to average Z.

For more information on configuring pipes, see the comments in the appropriate .conf
file for the pipe in the config_template/init directory.
During development, copy it to your configuration directory and edit as required.

Command line syntax

This parameter is shown if you select a pipe file format. The choices for how IRIS runs the
pipe program are shown below. In addition, the output process sends the color seam values
and number of colors.

• Pipe:

pipe-pathname input-filename <input-pathname> output-pathname

• Pathnames:

pipe-pathname --ip:input-pathname --op:output-pathname

In addition to these arguments, the pipe program is supplied with the following arguments:

-seams=1:2:3:4 Specifies the seams between colors

-colors=12 Specifies the number of colors

-device=0 Specifies the output device number, origin 0.

Filename format

Enter the format of the file name produced. The choices are:
• Default

Node YYMMDDHHMMSS.PPPNNNN.
• Native

The same format used in the IRIS internal inventories (with a new random suffix).
Node SSSYYMMDDHHMMSS.PPPXXXX.

• 8.3
Node .NNN.
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• METPS
Is node ATYMDHMS.

• Original
Original is the same format with the same name used in IRIS internal inventories.
The purpose of the original format is to allow a program to reference the original data
files later.
Original is node SSSYYMMDDHHMMSS.PPPXXXX.

• IIA
Node PPP_D_PSI_RNG_YYYYMMDDHHMMSS.

The recommended format for IRIS-to-IRIS transfers is Native. Note that pipe programs have
the power to override the output filename, so these choices may be effectively ignored.

The node formats and syntax are as follows:
SSS

3-letter site code

YYYY
4-digit Year

YY
2-digit Year (modulo 100)

MM
2-digit Month

DD
2-digit Day

HH
2-digit Hour

MM
2-digit Minute

SS
2-digit Second

PPP
3-letter Product type

XXXX
4-letter Random characters

node
Source system's node name, limited to 8 chars in 8.3 format

NNNN
4-digit base 10 number incrementing for each file

AT
Letters "AT"

YMDHMS
Year–1990, month, day, hour, minute, second, all base 62.

D
1 or 2-letter data type
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PSI
3-digit product specific information

RNG
3-digit maximum range in km

Compression scheme

Select one of the following:
• None
• Compress

The filename gets a .Z suffix.
• Gzip

The filename gets a .gz suffix.
• TIFF PackBits

Only applicable to outputs in TIFF format.

NORDRAD files are always compressed with the NORDRAD scheme. For IRIS-to-IRIS
transfers we recommend compressed if it is bandwidth limited, otherwise normal.

Notification scheme

IRIS supports the following network output notifications:
• None
• NORDRAD1
• TCPIP (a socket message is sent to the receiver, using address format INET)
• RENAME (the file is renamed after the copy is complete so a polling program finds a

complete file)
• UNIX (a socket message is sent to the receiver, using address format UNIX)

The recommended notification for IRIS-to-IRIS transfers is TCPIP.

The UNIX address format can only be used to communicate with a program on the same
computer that IRIS is running on. Therefore it can be used only for communication with a
UPI program, and not for communication to another IRIS. It creates a socket file with path
name ${IRIS_KEYS}iris_portXXXXX, where XXXXX is the port number.

Target directory

Specify the directory where the file is to be copied. The directory should be a maximum of
56 characters long. The recommended directory for IRIS-to-IRIS transfers is the $
{IRIS_PRODUCT} directory on the receiving machine.

Copy Scheme
None

The product file is not copied at all. Use this to just notify another program about your
product.
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Copy
The file is copied using program I/O, with fopen, fread, and fwrite.
The recommended copy scheme for IRIS-to-IRIS transfers is RSCP.
Use Copy only if either: You are copying to the source computer or if SCP does not
work, and you are using NFS.

RCP
Use the rcp secure copy shell command.

SCP
Use the scp secure copy shell command.

Script
A user-specified copy script program is run to do the copying.

User name

This question is shown for script copy schemes and RCP copy schemes.

It is the user name supplied to the script, and used in the rcp command before the "@" sign.

The recommended value is operator.

Password

This question is shown for script copy schemes.

It is the password supplied to the script. The value is not displayed, and is encrypted in the
configuration file.

Copy script name

This question is shown for script copy schemes.

You can specify the name of a user supplied program used to copy the file to the target.

You must place the program placed in the ${IRIS_PIPES} director with the following
arguments:

SourcePath DestPath DestHost User Password [RenameName]

The source path is in a temporary directory. The destination path is the directory specified in
above. The following table shows the copy scripts supplied with IRIS.

Table 28 Copy scripts supplied with IRIS

Copy script Purpose

sig_ftp Runs the FTP program to copy files

N2RelayOut Uses N2 library to store products to NORDRAD2

Notify port number

This question is shown for TCP/IP and UNIX notification.

For output to an IRIS on another computer use port number 30725.
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For output to a UPI program on any computer, use port number 30726. This allows the UPI
program to run on a computer node which is also running the IRIS network receiver.

Node name

This question is shown for TCP/IP notification.

Enter the name of the machine to notify.

NORDRAD1 Example

If you are outputting to a NORDRAD1 system, the following table summarizes the system
configuration.

Parameter Value

File Format NORDRAD

Filename format Default

Compression Scheme None
Nordrad packing is done automatically

Notification scheme NORDRAD

Target directory /usr/iris_data/nordrad

Copy scheme Copy

Recipient host name <blank>.

The NORDRAD hostname is configured in
the NORDRAD_AREAS.DAT file.

11.11.5 Archive specific parameters
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Type of archive media
Select Tape, Magneto-Optical, Large Disk, or DVD (Linux only) to specify the type of
archive device.

Tape

If you chose Tape, the following question appears:
Device file

Set the name of the device file for the tape. Note that this often takes the form of a
name like /dev/rmt/c1t2d0. This means SCSI controller card 1, SCSI address 2,
device 0.

Magneto-Optical

If you chose Magneto-Optical, the following questions appear:
File system type

Applicable to HP systems only. Set to HFS or VXFS to match your systems root file
system type.

Device file
Set the name of the device file for the disk. Note that this often takes the form of a
name like /dev/dsk/c1t2d0. This means SCSI controller card 1, SCSI address 2,
device 0.

MO Disk mount point
Specify the point for the MO disk. The recommended value is /modisk, but any value
could be used.

Raw Device file
Usually the same as the device file, but with a rdsk in the path.

Large Disk

If you chose Large Disk, the following question appears:
LDA directory

Specify the LDA directory, typically something like /usr/iris_data/lda1.

DVD

If you chose DVD (Linux only) the following questions appear:
Device File

Specify the device file used for the DVD drive. Typically it looks something like /dev/
scd0 or /dev/scd1.
You can determine this by typing as admin sudo cdrecord -scanbus. Identify
the entry for your DVD. The middle number of the leading group of 3 numbers
identifies your device, for example, 3,0,0 corresponds to /dev/scd0 while 3,1,0
would be /dev/scd1.

DVD Disk mount point
This is usually /mnt/dvd.
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Buffer Size
To make the DVD writing more efficient, files are written to a temporary buffer
called /usr/iris_data/temp/DvdArchive1 (for DVD 1). When the buffer size
specified here is exceeded, then the files are written as a block to the DVD. During the
write, IRIS "locks-out" sending new files to the buffer. After the files are written, the
contents of the buffer are all deleted and the process repeats automatically. Files
queued for send to the DVD are not lost. Note that the buffer is flushed to the DVD if
IRIS is stopped (by qiris). Typical buffer size is 200 MB. DVD's can hold
approximately 4 GB.
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12. Suncal utility

12.1 Suncal overview
The sun may serve as an external radiation source for calibration of a radar system. This
technique is simple and requires no external hardware to the radar system. The sun's
position can be calculated from any point on Earth at any given time provided that accurate
time and lat/lon information is known. This provides a convenient check for the antenna
pointing accuracy. The sun's power can also be a useful technique for monitoring the
calibration of the receive chain of the radar when used in conjunction with independent
measurements of solar flux density. Solar flux densities are known to vary with frequency
and are measured accurately over the 100 to 10000 MHz band from various solar
observatories. Antenna beam width can also be computed from sector scans of the sun.

The Suncal utility performs sector scans of the sun's position and outputs calibration data.
The utility is supplied with both the RDA and IRIS releases and works with the RVP signal
processors and any antenna controller accessible through the antenna library. The Suncal
utility can be run interactively from a command line and does not use a graphical interface. It
can also be inserted into the Task Scheduler as an Exec Task and run on a routine basis.

The Suncal utility outputs a BEAM product. The BEAM product contains SNR data with no
thresholding and can be viewed on an IRIS system, but is not automatically inserted into an
IRIS product directory. The BEAM product is then processed to produce a final calibration
results file.

On dual-polarization radars, Suncal can output a second BEAM product containing LDRH
data. This is used to compute the LDR offset.

12.2 Invoking Suncal and options
To invoke Suncal, type the following command:

$ suncal

Suncal was designed without a graphical utility so it can be run as an IRIS Exec Task.

When running automatically from the IRIS task scheduler, Suncal produces an IRIS error
message for an error (such as the measured sun peak power is below a specified threshold),
or a configuration drift (such as the antenna offset errors are larger than desired, or the LDR
offset is to big). This is useful for running Suncal routinely without operator interaction and
still being able to monitor the calibration of the receive chain.

The 2>&1 | signal_iris command causes IRIS to signal the error output from Suncal.
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Figure 51 Suncal Exec Task

Suncal may also be run interactively from the command line. If run interactively, the current
status is reported on the terminal as well as reporting the calibration results. There is also an
option to process an input BEAM product(s) that may have been created earlier. This is
useful for remote testing. For example, you can run Suncal and then send Vaisala the
resulting BEAM product which we can then process for analysis.

Table 29 Suncal command line options

–auto Do not log progress on the terminal, skip update.

The –auto option is normally given when running as an Exec Task to preclude output
to a terminal window.

–full Do full scan, process, and update phases (default).

–help Print this list.

–process:<path> Process an existing BEAM product.

–resave Reads and saves the suncal.conf file with comments and all new fields filled with
default values.

–update[:<file>] Interactive update from results, most recent if blank.

–version Prints the version number.

12.3 How Suncal works
Solar scans can provide you with an antenna pointing offset, antenna beam width
measurements, receive chain and LDR offset calibration.

Variation in the solar flux of the sun has little effect on the antenna pointing and beamwidth
measurements. Changes in the solar flux density affect the power measured by the receiver.
However, you can use independent measurements of the solar flux density to verify changes
in relative peak power and to calculate the antenna gain for a radar system.

Suncal operation is broken down into 3 phases, each of which produces an output used by
the next phase:

1. The scan phase runs the antenna and collects data which is stored in IRIS format BEAM
products.
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2. The process phase reads in the BEAM product(s) and calculates a results file.
3. The update phase reads the results file and interactively allows the operator to update

the radar calibration.

12.3.1 Antenna Scanning Sequence
The Suncal utility uses the antenna library to control the antenna scan.

We normally expect that the antenna angles are input to the RVP processor, which is the
case for IRIS. The current UTC time is taken from the local computer system's time to
compute the sun's position. You must check that the time is correct to within a few seconds.

A Suncal PPI sector scan is created and starts centered at the sun's initial position minus half
of the elevation span given in the suncal.conf file. This scan starts below the sun's
position and scans back and forth at the resolution requested in the file.

You control the PRF, sample size, range bin spacing, and number of bins. This task is not
angle synced. The azimuth scan speed is half that implied by the requested PRF and sample
size. The data nearest to the desired azimuths are stored.

The first defined pulse width of the signal processor is used. The quality of the sun
calibration should not be affected by different pulse widths because the sun is broad band,
just like the noise. The recorded data is SNR (which in IRIS is dBT with range normalization
turned off).

To account for the sun's movement during the scan, some corrections need to be made so
the output is similar to a non-moving radiation source.

To do this, the sun's position is recalculated at the start of each sweep. The change in the
sun's position is subtracted from all angles for that sweep. This correction is output to the
terminal window during each sweep when run interactively.

For example, if the sun moved towards the horizon by 0.10° during the Suncal task and there
were 5 sweeps the elevation angle increment of each sweep would be numerically
decreased by approximately 0.02°. Similar angle corrections are done in the azimuth
direction.

12.3.2 BEAM product generation
BEAM is a full screen cross-section format image showing range-averaged intensity in
azimuth and elevation coordinates.

BEAM is used during calibration and alignment and to verify antenna patterns.

A BEAM product is automatically produced upon the completion of the sector scan.

This BEAM product range averages most of the bins. You can selectively skip nearby bins to
avoid clutter.

The azimuth and elevation limits of the BEAM product are chosen to be slightly larger than
your sector scan.

The BEAM product is placed in the specified directory.
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• If you have an IRIS system running, place this in the /usr/iris_data/input
directory, and configure a blank input pipe to read them. This means you can display
them in IRIS.

• If you do not have IRIS, use the productx utility to view the BEAM product numerically.

If you requested a dual-polarization calibration, a second LDR BEAM product is produced,
covering the same area.

12.3.3 Processing BEAM data into results
The measured location of the sun in the BEAM product is calculated by first thresholding the
SNR data above a certain signal-to-noise level which is configured in the suncal.conf file.

A 2D second order polynomial is fitted to the resulting data. Note that this fit fails if you set
the threshold too low (everything passes), or set it too high (nothing passes). Take care with
selecting the threshold and the radars operating noise level. This is best done after checking
some produced BEAM.

The peak power of the sun measurement, and target beam width are determined from the
polynomial fit and finding the peak and width. Note that the azimuthal target beam width
appears larger than expected by 1/cosine of the elevation angle because an azimuth degree
corresponds to less than a degree of a great circle as you get nearer to the zenith. Because
of this, we recommend that you keep the azimuth sector width at least 8°.

The RAW value is what is measured from the BEAM product. The other value is corrected for
this effect. The peak power is also converted to dBm and stored in the results. All other
areas are corrected for this effect.

From now on, only data with a signal strength greater than 3 dB below the peak value are
used. Again a 2D second order polynomial is fitted to the Zh SNR data. The sun's position is
determined by solving that polynomial for 0. The position is then compared to the sun's
calculated position at the start of the scan and antenna pointing offsets are given in both
azimuth and elevation.

For dual-pol data, the second LDR BEAM product is also processed. We compute the
average LDR in the 3 dB peak region, and store it in the results. This number should be near
0. This number, when added to the current LDR offset is the new estimate for what the LDR
offset should be. A polynomial fit is also calculated for Zv by adding the LDR to the Zh
values. The sun's position in V polarization is also printed so you can check the alignment.

Note that you can skip the scanning phase, and pick up processing at the BEAM product
phase by calling Suncal with the –process: command line arguments. For dual-pol data
supply 2 –process: arguments, 1 for the SNR BEAM, and 1 for the LDR BEAM.

12.3.4 Interactively updating configs from results
Interactive update is only available for the LDR offset.

This is a feature which automatically changes your LDR offset in the setup_dsp.conf file,
and put it into use. It displays the difference, and prompt you to answer y if you want to
make the change. It is up to the operator's judgement to determine if this is a normal drift, or
if something has broken in the receiver and the change should not be applied.
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When changes are made, they are logged to the /var/log/irisrda/messages
and /var/log/irisrda/sigmet.log files.

You can skip the BEAM processing phase, and pick up processing just at the Interactive
Update phase by calling Suncal with the -update command line argument. This reads in
the most recent suncal_results file.

If you run Suncal automatically from the IRIS task scheduler, if a change is detected, you are
prompted to run suncal -update manually.

12.4 Using Suncal results
The calibration results file contains information derived from the calibration including, for
example:

• Housekeeping information about the radar, such as the time, location, and site name.
• Radar calibration numbers such as the noise level and the receiver bandwidth.
• Numbers calculated from the sun such as the observed position of the sun, the pedestal

angle errors, the area of the sun above threshold, the beam widths, and the peak power
of the sun.

You can use the antenna offset errors to adjust axis offsets in RCP8 and the beam width to
verify manufacturer's stated widths.

The following is an example results file. Your results file may be different.

results.sVersion = "8.12"
results.sSitename16 = "SIGMET, dry2"
results.sSitename3 = "DRY"
results.VolumeYmds.isec = 80657
results.VolumeYmds.imills = 2915
results.VolumeYmds.iyear = 2006
results.VolumeYmds.imon = 3
results.VolumeYmds.iday = 24
results.BeamYmds.isec = 80709
results.BeamYmds.imills = 2374
results.BeamYmds.iyear = 2006
results.BeamYmds.imon = 3
results.BeamYmds.iday = 24
results.FileYmds.isec = 80709
results.FileYmds.imills = 2382
results.FileYmds.iyear = 2006
results.FileYmds.imon = 3
results.FileYmds.iday = 24
results.fRadarLon = -70.99999996
results.fRadarLat = 41.10000003
results.fRadarAltitude = 95
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# Expected location of the sun.
results.fSunAzPos = 263.0827948
results.fSunElPos = 21.18174355
# Results from processing the BEAM product.
results.fTargetArea = 1.483424239

# If 1, then continue processing.
results.bTargetAreaValid = 1
results.fFitError = 0.3933128975

# If 1, then continue processing.
results.bTargetFitValid = 1
results.fTargetAzPos = 263.0988999
results.fTargetElPos = 21.2056663
results.fTargetPowerSnr = -3.364420032
results.fTargetWidthAzRaw = 1.152942299
results.fTargetWidthAz = 1.074832609
results.fTargetWidthEl = 1.07264875
results.fTargetPowerTotal = -80.85394878
results.fTargetPowerSun = -85.86442003
results.fTarget3dBArea = 0.8191843212

# If 1, then continue processing.
results.bPositionsValid = 1
results.fAzError = 0.01610509038
results.fElError = 0.02392274305

# If 1, then the Az and El errors were within tolerance.
results.bAzElErrorsOK = 1

# Results from the Cross Pol BEAM product.
results.bXpolProcessed = 1
results.fXpol3dBArea = 0.8191843212

# If 1, then offset was calculated.
results.bXpolLdrOffsetValid = 1
results.fXpolLdrMeasured = -2.841477054E-15
results.fXpolLdrOffset = -0.9
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# If 1, then the LDR offset error was within tolerance.
results.bXpolLdrOffsetOK = 1

# If 1, then positions were calculated.
results.bXpolPositionsValid = 1
results.fXpolTargetAzPos = 263.0988999
results.fXpolTargetElPos = 21.2056663

# Calibration numbers.
results.fI0Horiz = -81.15
results.fCalNoiseHoriz = -79.98
results.fRadarConstantHoriz = -33.26
results.fActNoiseHoriz = -82
results.fActNoiseVert = -82
results.fReceiverBandwidth = 1
results.iXmtPolarization = 0
results.fWaveLength = 5.4
results.fPulseWidth = 1
results.fOldLdrOffset = -0.9
results.fOldZdrOffset = 0.25

12.4.1 Antenna beamwidth Calculation
The target width measured by Suncal is a function both of the antenna beamwidth and of
the width of the sun.

If both signals were Gaussian, it would be a simple matter to correct for the sun's width.
Unfortunately the sun is a disk of constant power, and the background noise is within a few
dB. Here is a table for approximate conversions:

Table 30 Antenna and sun beamwidths

Antenna beamwidth (Degrees) Measured beamwidth (Degrees) Difference

0.200 0.522 0.322

0.300 0.534 0.234

0.400 0.574 0.174

0.500 0.636 0.136

0.600 0.711 0.111

0.700 0.794 0.094

0.800 0.881 0.081

0.900 0.972 0.072
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Antenna beamwidth (Degrees) Measured beamwidth (Degrees) Difference

1.000 1.064 0.064

1.100 1.158 0.058

1.200 1.253 0.053

1.300 1.349 0.049

1.400 1.445 0.045

1.500 1.542 0.042

1.600 1.640 0.040

1.700 1.738 0.038

1.800 1.835 0.035

1.900 1.938 0.033

2.000 2.035 0.031

12.4.2 Using results to calculate antenna gain
The solar peak power can be used to compute the gain of the antenna. This gain can be
monitored over time to determine the stability of the receiver calibration.

For solar calibration, antenna gain can be written as:G = 4π × PsFsBnλ2
G

Antenna gain (dimensionless) on beam axis.

Ps
Received sun peak power (dBm) (fTargetPowerSun)

Fs
Solar flux density (Wm-2Hz-1)

Bn

Noise bandwidth (Hz) (fReceiverBandwidth)

λ2

Transmit wavelength (m)

The calculated antenna gain must be corrected to determine the true gain of the system.
Solar flux measurements include all polarizations so 3dB must be added to the gain as half
the power is lost due to receiving in a single polarization. An additional beam filling
correction must be made because the sun radio diameter (0.56 ... 0.580) is considerably
smaller than most antenna's 3 dB beam width. A beam filling correction for Gaussian main
beams is given below:K dB = 20log 1 + 0.18 UsUa 2
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For example, a 1.00 beam has e a filling correction of 0.49 dB. Experience has shown about
#mnplus#0.5 dB fluctuation in true antenna gain due to solar flux and receiver
measurement uncertainties.

Observations of solar flux density (Fs) are available publicly on the internet for several
frequencies, locations, and times of day. Suggested sites are the Solar Environment Center
(SEC), National Oceanic and Atmospheric Administration in Boulder, Colorado; the
Dominion Radio Astrophysical Observatory at Penticton, British Columbia, and the IPS Radio
and Space Services Observatory in Australia.

To read the suncal results file into the C++ memory structure, use the
LoadSuncalResults() function.

12.5 Suncal configuration file
The Suncal utility uses information within the suncal.conf file stored in the $
{IRIS_CONFIG} directory.

You can adjust your configuration by editing this file with a text editor such as emacs or vi.

In the file users, you can add details of the scanning strategy, data output directories,
whether to create a log file, and IRIS messaging signal thresholds.

Optional sun simulation is built in to the utility to help testing.
You must turn this off for operation.

–resave
Running the Suncal utility with the –resave option reads in the old suncal.conf file, fills
in all new fields with default values, and writes out the file including comments.

You can run suncal -resave when there is no file to create a default file.

It is a good idea to do this also when you are first using Suncal after an upgrade. The user
can then change parameters within the suncal.conf file to suit their needs. When
designing the sector task, remember that tasks are limited to 40 elevation angles.

Configure Logging

The options to create logging while the Suncal utility runs, the source of the angle tags,
simulation, and minimum sun angle are at the top of the file.

If you wish to run with radiate turned off, and your RVP processor does not sense the radiate
control signal, then it faults with burst pulse missing. To allow operation in this case, set
lAbortOnMessages to 0.
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sun_cal.sVersion = "8.12"

sun_cal.lLogToFile = 1

sun_cal.lLogToTerm = 0

sun_cal.lAbortOnMessages = 1

# 1=RVP Tags, 3=Antlib.

The Suncal utility also checks the elevation angles to ensure they are not outside the
position limits of the antenna. A maximum sun angle of 85° has been hard coded into the
utility.

The following example shows an excerpt of the suncal.conf file where these fields are
configured.

sun_cal.iAngleSource = 1

# Add a simulated sun, set to 0 for operation.

sun_cal.lSimulateSun = 0

# Will not run if the sun is below this angle in degrees.

sun_cal.fMinimumSunEl = 5

Configure PRF, Start Range, Range Bin Spacing, Input Bins, and Pulse Samples

In the following section of suncal.conf are the options to configure the PRF, start range,
range bin spacing (km), number of input bins, and pulse samples.

We suggest that you select a fairly large start range (like 100 km / 62.1 mi) to avoid
interference from weather, clutter, and airplane returns. The azimuth scan speed is half that
implied by the requested PRF and sample size. If you have a dual-polarization radar, you
configure the transmit polarization here. You must specify a valid polarization which you can
transmit.
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# Configure the recording task here.

sun_cal.fPrf = 800

sun_cal.fRangeStart = 100

sun_cal.fRangeStep = 0.150000006

sun_cal.iBinCount = 1000

sun_cal.iSampleSize = 64

# Choices are 0=Horiz, 1=Vert, 2=Alt, 3=Simul.

sun_cal.iTaskXmtPolarization = 0

Configure Resolution and Sector Span

In the next section the resolution and sector span are configured for azimuth and elevation
in degrees.

# Spacing between rays in degrees.

sun_cal.Az.fSpacing = 0.200000003

# Span of the sector in degrees.

sun_cal.Az.fSpan = 8

# Spacing between rays in degrees.

sun_cal.El.fSpacing = 0.200000003

# Span of the sector in degrees.

sun_cal.El.fSpan = 8

Configure BEAM Products

Next we configure the BEAM products.

Specify a directory to write the BEAM products. If the BEAM product is added to the $
{IRIS_PRODUCT} directory it is eventually removed by the watchdog process.

It is often a better choice to put the BEAM product somewhere else so it is retained for future
reference.

To view the BEAM product in the QLW, then a nice plan is to place this in the /usr/
iris_data/input directory, and configure a blank input pipe to read them.
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# Configure the BEAM product here.

# Write the beam products to this directory.

sun_cal.sBeamDirectory = "/usr/iris_data/input/"

If you wish to make an LDR calibration from the sun, then specify a second BEAM product
data type. Choices are to transmit horizontal, and generate LDR, or transmit simultaneous
and generate ZDR. You should be able to get both the LDR offset, and the vertical position
offset. If you wish to calculate the vertical beam width, run a vertical polarization scan.

# Second BEAM data type: 0=none, 25=LDR, 5=ZDR

sun_cal.iBeam2DataType = 25

The final section of the suncal.conf file configures the processing to produce the results
from the BEAM products.

# Configure the results processing here.

# Write the results file to this directory.

sun_cal.sResultsDirectory = "/usr/iris_data/suncal/"

# Power above this level (in SNR)

sun_cal.fBeamPower = -2

# must cover at least this area (in square degrees).

sun_cal.fBeamArea = 1

# The 3dB beamwidth of the sun must be at least this area (deg**2).

sun_cal.fBeam3dBArea = 0.200000003

# The peak power must be at least this, in SNR.

sun_cal.fBeamPowerThresh = 0

# Alert if the sun's position error is larger than this, in degrees.

sun_cal.fBeamPosThresh = 0.5

# Alert if the LDR offset error is larger than this, in dB.

sun_cal.fBeamLdrOffsetThresh = 0.200000003
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12.6 Configuring syslog.conf for Suncal
The Suncal utility logs calibration changes using syslog to puts a message into
the /var/log/irisrda/messages file. If you wish to put these in a separate file,
perform the following steps.

1. Log in as admin.

2. Edit the /etc/vaisala/irisrda/syslog.conf file by adding the following at the
end of the file:

sudo log user.info messages to sigmet.log
user.info /var/log/irisrda/sigmet.log

3. Send kill -hup to the syslogd process.
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13. RVP and RCP Network Export
Utilities

13.1 Network Export overview
RVP communicates to a host computer through a standard TCPIP Ethernet connection.
RCP8 communicates through Ethernet or serial line.

The following utilities can be used for the network communication:
• DspExport exports the dsp library over the network to separate host computers. This is

the only way to interface to RVP from a separate computer.
• AntExport exports the antenna library internal state over the network to a separate

host computer. This is a low-bandwidth alternative to running programs like Antenna
and Bitex over the network. This allows multiple computers to control the antenna
simultaneously.
Vaisala does not recommend using this in most environments.

These utilities provide flexibility for implementing RVP, RCP, and IRIS under different
network and hardware platform scenarios. For example, RVP and RCP running on separate
PCI systems or in various combinations on the same PCI system.

You can also use the DspExport and AntExport utilities to run remote maintenance utilities
over low-speed or high-latency network links for which the X-window export technique is
not effective.

13.2 DspExport overview
DspExport works as follows:

• When it receives a socket connection request, it establishes a connection to the radar
server computer (RVP10SRV) and initially allows multiple connections.

• DspExport handles the INFO, SETUP, and OPEN commands.
• When the OPEN command is sent, an exclusive connection for I/O to RVP10SRV is

established.
If a second OPEN request arrives while the first is still active, it fails, and returns the
message Device allocated to another user.

The source code and examples for DspExport and the dsp library are provided with the RVP
release software.

Table 31 DSP Files

Example File

DspExport ${IRIS_ROOT}/src/rda/dsp

dsp library ${IRIS_ROOT}/base/dsp_lib
In the library, the example codetalks to DspExport in the OpenSocket.c,
dsp_read.c, and dsp_write.c files.
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Search for the string SOCKET to see how the code differs between SCSI interface and
socket interface.

1. To check if DspExport is running, type:

$ ps –aef | grep DspExport

DspExport is usually configured to run all the time.

2. You can start the application from the terminal window by typing: DspExport
3. For detailed logging, start the daemon with the –v option

4. The default port is 30740.

To use another port, start it with an option such as –port:12345.

5. To view the options, type –help.

13.3 Starting and stopping DspExport and
AntExport

If DspExport or AntExport are used on a platform, then they should be configured to start
automatically when the computer boots.

Vaisala software runs as services in the Linux operating system in order to take advantage of
built-in management tools for starting and stopping services. This includes a graphical user
interface for controlling services and built in support for controlling services at different run
levels of the operating system.

Enable the software for the following levels (indicated by an *).
• 0 Halt
• 1 Single–user mode
• 2 Not used (user–definable)
• 3* Full multi-user mode
• 4* Not used (user–definable)
• 5* Full multi–user mode (with an X–based login screen)
• 6 Reboot

When configuring how services are started, Vaisala recommends using a command-line
utility such as systemctl .

DspExport automatic start and test

As admin, type:
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sudo cp /etc/vaisala/irisrda/templates/init/dspexport /etc/init.d/
sudo cd /etc/init.d
sudo chmod +x dspexport
sudo chkconfig --add dspexport

Systems delivered from the factory or installed using sigconfig on the IRIS/RDA
release software DVD automatically make sure that all of the necessary files and
permissions have been set for items in /etc/init.d/.

To verify that the DspExport service starts automatically, as admin, type:

sudo chkconfig --list dspexport
antexport 0:off 1:off 2:off 3:on 4:on 5:on 6:off

At this point, DspExport has been configured to run the next time the computer is restarted.
To start DspExport immediately, type the following command as admin:

sudo service dspexport start
starting DspExport: PC Linux [OK]

The OK message is displayed if start-up occurs smoothly. If this message is not displayed,
make sure the above steps have been taken and that the service is not already running.

To verify that DspExport is running type the following line and check that the response
matches the one shown below.

$ ps -eaf | grep DspExport
UID PID PPID C STIME TTY TIME CMD
operator 4019 1 0 16:05 ? 00:00:08 /usr/sigmet/bin DspExport
-daemon
$

To stop DspExport, run the following command as admin:

sudo service dspexport stop
Stopping DspExport: [OK]

The OK message is displayed if shutdown occurs smoothly.

AntExport start-up and test

For AntExport the configuration is similar to DspExport. As admin, type:
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sudo cp /etc/vaisala/irisrda/templates/init/antexport /etc/init.d/
sudo cd /etc/init.d
sudo chmod +x antexport
sudo chkconfig --add antexport

To verify that the AntExport service will start automatically, as admin, type:

sudo chkconfig --list antexport
antexport 0:off 1:off 2:off 3:on 4:on 5:on 6:off

At this point, AntExport has been configured to run the next time the computer is restarted.
To start AntExport immediately, type the following command as admin:

sudo service antexport start
Starting AntExport: [OK]

The OK message is displayed if start-up occurs smoothly. If this message is not displayed,
make sure the steps above have been taken and that the service is not already running.

To verify that DspExport is running type the following line and check that the response
matches the one shown below.

$ ps -eaf | grep AntExport
operator 4019 1 0 16:05 ? 00:00:08 /usr/bin/AntExport -daemon

To stop AntExport, run the following command as admin:

sudo service antexport stop
Stopping AntExport: [OK]

The above message is displayed if shutdown occurs smoothly.

13.4 Non-network antenna angles to RVP
RVP supports the following techniques for bringing-in antenna tag angles:

• Parallel binary or BCD "TAGS"
• S/D convertor
• From RVP internal simulator

For information on the mc > Live Angle Input question, see RVP10 User Guide (M212604EN).

In these selections, you must configure the setup/RCP section of the RVP Setup utility to
specify the serial line input as follows:
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Table 32 RCP serial line input

setup/RCP  

System has antenna Yes

Main Interface to RCP None

Antenna angle insertion source Native RVP

Alternatively, use a serial line input to RVP. In this case, you must set the mc > Live Angle 
Input response to None. Also, you must configure the setup/RCP section of the RVP Setup
utility to specify the serial line input as follows:

Table 33 RVP serial line input

setup/RCP  

System has antenna Yes

Main Interface to RCP Serial

Antenna angle insertion source Normal RCP

Is this the 1 controlling host No

Main serial device name /dev/ttyS1

Running at 19200

With parity None

Receive format from RCP RCV01

13.5 RCP8 on Serial Interface
The RCP is connected through a serial line directly to the host computer. The following must
be configured for this:

• RCP TTY setups. See RCP8 User Guide (M212923EN)
• Host computer setup/RCP configuration (for example, for IRIS)

setup/RCP  

System has antenna ¨

Main Interface to RCP Serial

Antenna angle insertion source Normal RCP

Is this the 1 controlling host Yes

Main serial device name /dev/ttyS1

Running at 19200

With parity None
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setup/RCP  

Receive format from RCP RCV02

Transmit format to RCP XMT02

On RCP8 itself, set Setup > RCP set to:

setup/RCP  

System has antenna Yes

Main Interface to RCP None

Antenna angle insertion source Native RCP8

For more information on setting-up a serial line interface, see RCP8 User Guide
(M212923EN).

The AntExport utility may be run on the host computer to export control to another
computer.
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14. Zauto utility

14.1 Zauto overview
The RVP Doppler signal processors output calibrated values of the equivalent radar
reflectivity factor. Zauto is an interactive graphic utility for calibrating the reflectivity offset
of the signal processor. The results are stored in a calibration file that is loaded into the DSP
for use during programmed radar data collection.

For information on the theory of signal processor calibration, see RVP10 User Guide
(M212604EN).

To perform a calibration, a calibrated RF signal generator (siggen) must be used. Zauto can
be used with a manually controlled siggen or a siggen controlled by the RCP. For manual
operation, it is most convenient if the signal generator control can be located near the
workstation where Zauto is run. The siggen should be configured for CW operation rather
than pulse mode.

Setup allows you to input any losses that are present in the system, such as:
• Loss between the transmitter and the antenna feed
• Loss between the antenna feed and the receiver
• Loss between the test signal injection point and the receiver

This must include the loss suffered in the cable that connects the siggen to the injection
point, the coupler loss, and any calibration required for the signal generator.

More information

‣ Zcal overview (page 269)

14.2 Invoking Zauto
1. Run the Setup utility.

a. Verify the setup information to make sure Zauto calibrations are accurate.

For an automatic siggen, use the Antenna utility to verify that the siggen is setting
the correct values.

b. For magnetron systems, check/adjust the STALO and signal generator frequencies:

• Set switch 2 to the A position to run the normal receiver signal into the burst
channel.

• Use RVP TTY ps command to plot burst frequency spectrum. Turn off AFC while
you are there.

• Set siggen frequency to an appropriate level.
• Adjust siggen frequency until it reads out the correct IF frequency (often 30 MHz)

to within 100 KHz. Alternately use MFC to adjust the STALO frequency. It is worth
checking that you are not off by a multiple of 18 MHz, or on the wrong side lobe
of the transmitter.

c. Exit Setup.
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2. In the command line, type: zauto&
If needed, use one of the following options:

Option Description

-burst_pwr  

-BW_is_invPW Optional parameters for the –cal option.

-cal Performs an automatic calibration without displaying the zauto
menu. The results are saved to the calibration file, unless there is a
value outside the tolerance range. This option is available only with
an automatic siggen.

-debug Use this to debug Zauto.

-demo
-demo2

Runs the utility without the signal processor, for testing and
demonstration purposes.

-pol H or V Forces polarization to horizontal or vertical in Zauto startup.

-pw_idx 1 - 4 Select the pulse width index used for defining the pulse width for
automatic calibration.

-display display_name  

3. For magnetron systems, when you are done with Zauto, recheck the frequency for drift.
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14.3 Zauto menu

Figure 52 Zauto Utility

Calibration Parameters
Displays calibration parameters defined with the Setup utility.

Calibration Plot
Displays a plot of the IF measured power against the signal generator setting.

Calibrate Pane
Lets you control the calibration using the fields and buttons in this pane.

Results Pane
Shows the temporary calibration information, such as the current noise and Zcal
values for the specified pulse width.

14.3.1 Calibration parameters
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All of the calibration parameters are taken from the Setup utility, and they serve as a check
that Setup was properly configured.

If you see an error in these parameters, exit the Zauto utility, and correct the error in Setup
before attempting a calibration. Otherwise, the calibration will be incorrect.

The following Setup parameters are displayed:
• Radar wavelength (cm)
• Transmit power (kW)
• Digital filter loss at calibration (dB)
• Horizontal and vertical beam width (degrees)
• Antenna gain (dB)
• Burst power at calibration (dBm)
• Transmit loss (dB)
• Receive loss (dB)
• Siggen loss (dB)

These values remain fixed throughout the Zauto procedure.

14.3.2 Zauto calibration plot

Zauto displays a plot of the IF power in dBm against the signal generator setting, similar to
the plot shown in the reflectivity calibration section of RVP10 User Guide (M212604EN).
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Here, the horizontal axis of the plot is the input signal power at the antenna, which accounts
for antenna-to-receiver loss and signal generator loss.

Zauto corrects for these effects, based on the setup information. In performing the
calibration, it displays the signal generator value on the horizontal axis.

Left and Right Plot Limits
Plot range fields at the lower left and right of the calibration plot define the lower and
upper limits, in dB, of the signals to be generated.
You can change the limits, and Zauto rescales the plot for the new range.
Zauto does not allow a new range limit when there would be data points outside the
range.

Left and Right Fit Limits
Vertical red lines mark the limits of the least squares fit. They can be moved
independently by pointing with the mouse on the graph and clicking the left mouse
button.
If the fit limits lie outside the plot range, they are shown as colored lines at the
corresponding edge of the graph. The default limits are taken from the calibration
configuration settings. See Defining Zauto configuration parameters (page 258).
Usually, the fit limits are set after a number of points have been plotted and before
doing a least squares fit.
You should set the limits so that the fit is made to the linear portion of the plot,
typically 15 dB above noise to the saturation point of the LOG receiver. Points that lie
outside the fit limits are displayed in red to show that they are not be included in the
next fit. The limits can be reset and another least squares fit performed to fine tune
the plotted line. When the limits are changed, the last fit and noise lines are removed,
along with the appropriate information in the results display.

Plot Points
Plot points are the dots that mark the strength of the signal sampled at a number of
specified settings. A black box is drawn about the low and high point used to calculate
the dynamic range.

Fit Line
Shows the least squares fit of the plot points that fall within the fit limits.

Noise Level Line
The noise level line is a horizontal line drawn when the siggen is not generating a
signal.
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14.3.3 Calibrate pane

Pulse Width
Begins a new calibration at the specified pulse width, which you select from a menu.
When you switch to a new pulse width, any prior data points and temporary results
are discarded. Zauto lets you choose whether you want to save the calibration.

Polarization
On dual polarization radars, calibration must be performed separately for each
polarization channel. Do not change this for other radars, as changing the polarization
erases the current calibration points.

Delete
Select Delete to delete the last calibration point. Select Delete many times to delete
successive points, in reverse order.

Noise
Select Noise to take a noise sample and plots the result. The noise sample must be
taken after the least squares fit is done. For a manual siggen, you must turn the siggen
to its lowest setting or disconnect it before taking a noise sample. Zauto does this
automatically when the siggen is controlled by the RCI.
When you take the noise sample, a red line is drawn at the A/D noise level. If the noise
level is outside the range of 10 to 30 A/D units, align the LOG channel A/D converter
by adjusting the appropriate offset pot on the DSP. This can be done using the Ascope
utility. Make sure that the A/D converter gain has been adjusted as well.
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Sample
Select Sample to generate and plot the specified test signal. In the field to the right of
this button, you enter the desired siggen setting in dBm. For a manual siggen, you
must set the siggen to match this setting. Zauto measures the power at IF, and plots
the point on the calibration graph.
The siggen setting can be entered in one of the following ways:
• Type a number directly into the field.
• Move the slider within the sliding scale until the desired value is displayed in the

field.
• Click inside the scale to move the slider in steps. The size of the step is defined in the

AutoCal Configuration menu (see below).

Siggen ON/OFF
Use this button to toggle the siggen off before taking a noise sample, then toggle it on
again.

ID
Identify which siggen is used in the calibration. This is helpful in the future when you
want to compare new results to old calibration files.

Fit
Select Fit to cause Zauto to perform a least squares fit to the data points that lie
within the specified range limits. The resulting line is drawn on the calibration plot. At
least two points are needed. The Results display shows the slope and intercept values
for the line.
The fit is a straight line. The fit range limits should be set so that only the points in the
linear region of the calibration curve are included. The signal processor corrects for
the curved portion of the calibration, which corresponds to weak signals.

Automatic Calibration
Automatic calibration is available only if you have an automatic siggen.
Select AutoCal to generate a series of signals (beginning at the high end, ending at
the low end) and plots them on the graph. When it is finished, a noise sample is taken
and a least squares fit of the data points is taken. The calibration is then saved. See
Defining Zauto configuration parameters (page 258).
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14.3.4 Defining Zauto configuration parameters

1. Select Config.
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2. Define the automatic calibration procedure parameters:

Cal Pulse Width
Select the pulse width to be calibrated automatically.

Update other PW
As an alternative to recalibrating for each pulse width, choose Yes to copy the
results of a calibration at one pulse width to other pulse widths, scaled by the
different radar constants for the 2 pulse widths. For the most accurate results,
however, the radar should be re-calibrated at each pulse width.

Polarization
Only to be changed for dual polarization radars.

IF Power Plot Limits
The range of measured signal plotted on vertical axis.

Sig Gen Plot Limits
The range of signals to be plotted on horizontal axis.

Sig Gen Fit Limits
The range to be included in the least squares fit.

Siggen Steps
This controls interval between generated signals. We may want to fine steps at
the 2 roll-off regions in order to get an accurate measure of the dynamic range.
Thus you can enter steps for 3 different power ranges.

Slope and dBZo Tolerance %
These are positive integers between 1 and 100, used for the comparison with the
reference calibration information during an automatic calibration. If the new
calibration differs by more than these percentages, AutoCal does not update the
calibration.

Range Tolerance dBm
If the dynamic range changes by more than this value, alert and do not update.

3. Select Apply and Save Config.
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14.3.5 Zauto results

The Results pane shows the temporary calibration information such as the current slope and
dBZ or Zcal values for the specified pulse width. These values apply to the most recent
squares fit and noise sample. This pane is updated every time a new noise level is taken, or
any time the data used for linear fit changes.

Update
Select Update to store the current calibration for the selected pulse width. The slope
result is copied regardless of pulse width. The calibration reflectivity is copied over for
the specified pulse width.

Radar Constant
Displays the calculated radar constant. See RVP10 User Guide (M212604EN).

Slope
Displays the slope of the straight line fit to the data values in dB per machine number
(A/D value) The slope should be close to 1. Less than 1.02 is a reasonable threshold. If
a reasonable value is not acquired, adjust the fit range limits.

Noise
Displays the noise level in dBm.

Io
Displays the calibration intercept.

ZCAL
Displays the Zcal value computed from the radar equation. See dBZo in RVP10 User
Guide (M212604EN).

Fit SD
Displays the standard deviation on the least squares fit in dB. This should be under 1
for a good fit. If a reasonable value is not acquired, adjust the fit range limits.
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Dynamic Range
Displays the dynamic range of the processor at this pulse width. The dynamic range is
defined as the difference in input signal power between a signal measuring at least
1 dB above the noise level, and a signal which is starting to saturate the receiver such
that we have 1 dB roll off from the idealized linear fit.

View Calibration
Select View Calibration to show a list of current results, the last results saved to a file,
and the reference calibration set by the Zcal utility.
Select Exit to close the window.

14.4 Zauto commands
The Zauto utility provides the following commands:

File
Save writes the calibration information to a file.

Print creates an X-window dump of the menu you are running, as follows:
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• Print > to Printer sends the output to the postscript or color printer specified in the
Printer Setup menu.

• Print > to File sends the output to a file in your default home directory.
• Print > Setup lets you configure the printer on your system.

Exit exits the utility.

Calibration information is stored in the config directory in a file called zcalib.conf. You
are prompted to save the file before you exit from the utility.

Help
On Utility displays information about the utility.

Contents and Index provide access to the online help.

14.5 Manually calibrating signal processor

For manual signal generation control, it is best if the control for the signal generator and
the workstation are located next to each other. Otherwise, two people and some
coordination are required to perform a calibration.

The sensitivity and dynamic range of the radar can be affected by the gain of
the IF signal entering the IFD. First adjust the IF signal level (see the test procedure in
RVP10 User Guide (M212604EN)).

NOTICE!

To protect the signal generator, the radar is not usually set to transmit during calibration.
Check with your manufacturer. If it is OK to transmit while the siggen is connected, it better
simulates operating conditions. If transmitting is not recommended, turn everything on, but
do not set the transmitter. This assures that all sources of noise are accounted for.

1. Set the antenna elevation greater than 20° to reduce the effect of earth temperature
noise which is detectable by modern, sensitive receivers.

If you are transmitting, this eliminates the possibility of weather signals interfering with
the calibration.

2. Check that the signal generator is set for the CW (continuous wave) operation and not
for pulse mode operation.

3. Select a pulse width.

Note that the pulse width lines of the DSP issue the appropriate signal. If this control is
implemented on your system through the antenna controller, it is set correctly.

4. Set the plot range limits.

If you do not know what limits to set, use the system defaults. You can adjust them later
without losing data.
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5. Collect the plot points for the calibration:

a. Enter the siggen value in the unlabeled field next to Sample. You can use the slide
bar.

b. If the siggen is not controlled by the RCI, set the signal generator output to match
the specified value. Otherwise, this is done for you.

c. Select Sample.

Zauto draws the point on the calibration plot

Repeat these steps until you have collected a sufficient number of points (for example,
6 points in the linear range of the curve). If you make a mistake, select Delete to
remove the point or reset the pulse width and start again.

6. After you have collected the points, set the plot limits to include only those points in
the linear range.

7. Turn down or disconnect the signal generator and select Noise.

A horizontal line is drawn at the average noise level.

8. Select Fit.

Check the line and results to make sure they are reasonable.
Reset the limits or collect more data as required to get a representative fit to the
straight line portion of the curve (typically from 15 dB above noise to 70 dB above
noise).
The calibration results are filled in each time you select Fit.

9. When you are satisfied with the calibration, select Update to update the View
Calibration display.

You can use results from one pulse width to update other pulse widths. However, for
the most accurate results, you should perform a separate calibration for each pulse
width.
Errors are likely to be less than 3 dB if the update technique is used.

10. Move on to the next pulse width, if necessary, starting with step 3.

11. When you are finished, check that the View Calibration display shows the values that
you want to save.

12. Select File > Save and then File > Exit.

You can also modify the calibration file, using the Zcal utility to enter the calibration
reflectivity by hand.
You typically use the Zcal for testing or after a component has been replaced by another
with known calibration.
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14.6 Automatically calibrating the signal
processor

The Zauto utility can automatically calibrate the signal processor output, from either:
• Zauto utility

If you perform the automatic calibration from the utility, Zauto plots each point on the
graph and draws the least squares fit and noise sample lines on the display.

• Command line
If you perform the calibration from the command line, Zauto displays a series of
messages indicating each siggen setting and DSP value.

In both cases, the new slope is calibrated, and the results are saved in the calibration file.

Zauto uses the reference information from the calibration file to determine whether to
accept the new calibration information. If the new calibration deviates too much from the
reference settings, it is not used. This prevents loss of data if the signal generator should fail.

You can change the reference calibration information with the Zcal utility.

1. Select Zauto > Config.

The AutoCal Config menu appears.

2. In the AutoCal Config menu, choose the pulse width for the calibration, the siggen
(signal generator) step, and other calibration parameters.

3. Use the Slope Tolerance % and the dBZo Tolerance % fields to define the permitted
deviation between the reference information and the new calibration.

A higher percentage allows for a larger deviation, with 100% allowing any results to
replace the old calibration values.

4. Select Save Config.
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14.6.1 Calibrating the signal processor from Zauto
1. Select AutoCal.

Zauto checks a series of signal values and plots the points.
If the new results deviate too far from the old results, Zauto displays the message:

Update Anyway

New Calibration Reflectivity is too far from the ref value.

New      0.4000            Reference    0.4400

Don’t Update

2. For each message, choose to either update the calibration file or reject the new
calibration information.
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14.6.2 Calibrating the signal processor from the
command line

1. In the terminal window, type: zauto -cal
The utility displays a series of messages indicating the siggen (signal generator) values
and DSP values used in the calibration, such as the following:

Setting           -110.00           DSP Val           25.00
Setting           -105.00           DSP Val           37.50
Setting           -100.00           DSP Val           50.00
Setting           -95.00            DSP Val           62.50
Setting           -90.00            DSP Val           75.00
Setting           -85.00            DSP Val           87.50
Setting           -80.00            DSP Val           100.00
Setting           -75.00            DSP Val           112.50
Setting           -70.00            DSP Val           125.00
Setting           -65.00            DSP Val           137.50
Setting           -60.00            DSP Val           150.00
Setting           -55.00            DSP Val           162.50
Setting           -50.00            DSP Val           175.00
Setting           -45.00            DSP Val           187.50
Setting           -40.00            DSP Val           200.00
Setting           -35.00            DSP Val           212.50
Setting           -30.00            DSP Val           225.00
Setting           -25.00            DSP Val           237.50
Setting           -20.00            DSP Val           250.00
Setting           -15.00            DSP Val           262.50
Setting           -10.00            DSP Val           275.00
Setting           -5.00             DSP Val           287.50
Setting           0.00              DSP Val           300.00
Setting           5.00              DSP Val           312.50
Setting           10.00             DSP Val           325.00

Slope New: 0.4000 Ref: 0.4400

Reflectivity Pulse Width:0.5 New:-39.4354 Ref:-20.5000
file saved

2. If the new values deviate too far from the reference information, the file is not saved. To
accept the new values:

a. Run Zauto.

b. In the AutoCal Config menu, change the tolerance fields.

c. Rerun the utility
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14.7 Siggen calibration file
The Zauto utility can read a calibration file containing information on the power level for
each nominal setting of the signal generator. This provides an accurate calibration of an
automatic signal generator that is controlled by IRIS.

For example, a requested value of -30 dBm may actually be -30.2 dBm.

The Zauto calibration display shows the nominal requested setting and the calibrated value
(with a resolution of 0.1 dB).

You can create the calibration file through a calibration program or typed in an editor. The
file is SIGGEN_CAL.DAT in the IRIS_CONFIG directory (for example, /etc/vaisala/
irisrda).

For manual calibration with a calibrated signal generator you do not typically need this
feature.

The following is a partial example.

#
# First set the date of the calibration in the following format
# Note the D in Date is capitalized.

Date: 10:15:00 20 OCT 1995

#
# Next the signal generator ID string
#

ID: XX aaa_BBB-CCC
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#
# Now include a table of the integer nominal siggen values
# followed by the calibrated value as a floating point value.
# Start with the largest value.
#

0 0.1
-1 -1.1
-2 -2.1
-3 -3.1
-4 -4.1
-5 -5.1
-6 -6.1
-7 -7.1
-8 -8.1
-9 -9.1
-10 -10.1
-11 -11.1
-12 -12.1
-13 -13.1
-14 -14.1
-15 -15.1
-16 -16.1
-17 -17.1
-18 -18.1
-19 -19.1
.
.
.

Siggen data handling

Only the 128 dB span immediately below the first entry in the file is used. All values outside
this range and all missing values are treated as correctly calibrated.

If the file is missing, then all values are treated as correctly calibrated, and the ID string is set
to No siggen file.

If the file exists, but does not contain an ID string, the ID string is set to No ID in file.

The ID and date are displayed in the Zcal utility.
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15. Zcal utility

15.1 Zcal overview
Use the Zcal utility as an alternative to the Zauto utility to display and enter reflectivity
calibration numbers in the calibration file when:

• First setting up a system, before final calibration.
• Resetting reference calibration information.

Reference information is applicable only on systems that automatically run calibration.
If a new calibration deviates too much from the reference, it is not used. This prevents
loss of data if the signal generator fails.

Zcal does not have a graphical interface. There are separate calibrations for each pulse
width and polarization as applicable.

For information on the reflectivity channel calculations, see RVP10 User Guide (M212604EN).

More information

‣ Zauto overview (page 251)

15.2 Invoking Zcal
1. To invoke Zcal, on the command line type: zcal

15.3 Zcal commands
Zcal displays the stored and reference calibration information for each pulse width, then
prompts you to enter a command.

The number of pulse widths may vary, depending on your system.

For a large number of pulse widths, use a large width terminal window.

All dates shown are in local time as configured on your computer.
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----------- Horizontal Calibration -----------
                 Sto 1.0us   Ref 1.0us
Fit Slope:       1.1838      1.1838      dB/dB
Cal:             -34.51      -34.51      dBZ
Std Dev:         0.00        0.00
Noise Level:     -93.11      -93.11      dBm
I0:              -57.66      -57.66      dB
Constant:        68.84       68.84       dB
XMT Power:       200.00      200.00      KW
Burst Power:     -10.10      -10.00      dBm
Dynamic Rng:     nan         nan         dB
Siggen Low:      -34.00      -34.00      dBm
Siggen High:     nan         nan         dBm
IF at Low:       -86.74      -86.74      dBm
IF at High:      nan         nan         dBm
IF Maximum:      -50.42      -50.42      dBm
Flag:            0           0
Cal Time:        12:27:21    12:27:21
Cal Date:        24 OCT 2002 24 OCT 2001
Siggen Date:     24 OCT 2012 24 OCT 2012
Siggen ID:       189-111     189-111

            Current Siggen ID: 189-111
      Current Siggen cal date: 24 OCT 2012
 ZCAL command (? for help):

The following table lists the commands that you can enter at the prompt.

Table 34 Zcal commands

Command Description

Cal Enter a new calibration reflectivity

ID Set siggen ID

List Print out current numbers on terminal

Polar Switch between horizontal and vertical polarization

Quit Quit

Refer Set reference to Stored values

Write Write calibration file

? Print help
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15.4 Changing calibration reflectivity
1. In the command prompt, type cal

Zcal displays the prompt:

Enter pulse width (choices 1):

2. Enter the pulse width in microseconds (for example, 1, 1.0, 1.00).

Zcal displays the prompt:

Enter new cal reflectivity (old was -34.51):

3. Enter the calibration reflectivity (dBZ0) in dB.

Typically this is a negative dB number, such as -35, which corresponds to the minimum
detectable dBZ at 1 km (0.6 mi).
Zcal displays the prompt:

Enter new cal noise (old was -93.11, nan for none):

4. Enter the new value for the calibration-time noise level.

If you do not know this number, you enter nan (short for "Not a Number"). This
disables the feature for adjusting the calibration if the noise level changes from that
observed at calibration time.

Zcal redisplays the calibration information, showing the new calibration reflectivity and
noise that you entered.

15.4.1 Changing reference values
Issue this command when you are happy with the current calibration.

IRIS/Open always uses the current calibration when configuring the DSP. It uses the
reference calibration only when performing an automatic calibration. If the new calibration
deviates too much from the reference, it is not used.

1. In the command prompt, type: refer
Zcal copies the current calibration to the reference calibration and redisplays the
calibration information with the new reference information settings.
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15.4.2 Writing the calibration file
1. In the command prompt, type: write

Zcal writes the calibration information to the file, then prints the message:

File updated successfully.

15.4.3 Switching polarizations
Zcal displays information for only one polarization at a time.

If your radar can transmit in either horizontal or vertical polarization, you can calibrate both
channels in Zauto.

1. To switch the displayed polarization is display, type: polar
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16. Zdrcal utility

16.1 ZDR measurement
The differential reflectivity (ZDR) is a relative power measurement of the signals acquired in
the horizontally and vertically polarized channels in the polarimetric weather radar.

ZDR measurement accuracy must be at the level of 0.1 dB for applications of quantitative
rainfall and echo identification. Such accuracies are challenging if pursued through absolute
power calibrations of each radar channel independently. Accounting for this, RDA calculates
the differential reflectivity independent of the reflectivity dBZ, and the related calibration
coefficients, while a tunable offset parameter is reserved to maintain the balance of the ZDR
calibration, explicitly.

Depending on the radar system stability, regular and semi-continuous monitoring of the
ZDR calibration and occasional update of the offset parameter are necessary to maintain an
accurate ZDR calibration.

It is operationally feasible to maintain the relative power balance of two radar channels at
sub-decibel accuracy, by using the external 0 dB reference defined by the atmospheric echo
inputs that are averaged over rapid full rotations of the vertically pointing antenna ("bird
bath" scans).1)

16.2 Zdrcal utility overview
The Zdrcal utility:

• Performs sequences of vertical scan measurements, accumulates and analyzes qualified
data for monitoring the radar ZDR calibration.
The utility is configured to trigger a message for operator attention when the sampled
data allows it to conclude that the radar ZDR calibration has drifted beyond a user
configurable threshold for alarm.

• Reports calibration data at a precision which keeps the false alarm rate below 5 %.
To establish this, the data samples are collected long enough to meet the configured
precision. The run durations can be steered in part by the task parameters, while the
actual total sample lengths adapt to variable atmospheric conditions. The lengths may
vary from a single full sweep (in case of significant precipitation at the radar) up to a
configurable upper time limit.

• Provides a tool for responding to the utility alarm and updating the radar ZDR offset
parameter from the specified previous results.
The update action implies that the subsequent ZDR observations of isotropic scatterers
are adjusted to 0 dB, which is the goal of ZDR calibration. The action has minimal
inference with normal radar operation, as restart of IRIS/RDA processes is not needed.

1) J.J. Gourley, P. Tabry, J. Parent du Chatele, 2006: Data Quality of the Meteo-France C-Band Polarimetric Radar, Journal of
Atmospheric and Oceanic Technology, Vol. 23, pp. 1340–1356 and R. Keränen, P. Puhakka, and H. Pohjola, 2008: Multi season
characteristics of the channel power balance at a polarimetric weather radar, 5th European Conf. on Radar in Meteorology and
Hydrology, Helsinki, Finland
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Zdrcal distributed with RDA and IRIS, and works with RVP signal processors and any
antenna controller accessible through the antenna library, at polarimetric weather radars.

Running Zdrcal

Zdrcal is designed to run either as a stand-alone non-graphic utility, or as part of IRIS
scheduler (as an IRIS Exec Task).

In both modes, Zdrcal reports its progress, processing, and result quality into an output
stream which is routed either to the terminal window, or into the zdrcal log history file
$IRIS_LOG/zdrcal.log.

Zdrcal RAW products

For each completed task, the Zdrcal utility outputs a RAW product, to serve as a reference
for detailed quality checks and to allow for (off-site) post-processing, which is equivalent to
the run-time analysis.

The Zdrcal RAW products are composed of one or up to forty full rotations of vertical
sweeps.

You can use the productx utility can to view the RAW headers for the full information of the
radar settings during the calibration task.

The data records contain the differential reflectivity ZDR, accompanied by the standard
moments dBZ, V, spectrum width (W), and the co-polar correlation coefficient RhoHV, which
are used in Zdrcal specific quality considerations and as input to sampling uncertainty
estimates in analysis. Through reingest of the Zdrcal RAW products in IRIS, the data are
available for graphical viewing (Quick Look Window, or standard IRIS products).

The measured data, used in Zdrcal analysis, are subject to standard RDA quality
thresholding (LOG, CCR, SQI, SIG) with configurable settings for typical operational tasks.

By default, the Zdrcal RAW products are not inserted in IRIS product inventory
($IRIS_PRODUCT_RAW). You can configure them to be added by activating an input pipe.

16.2.1 How Zdrcal works
The zdrcal data acquisition step resembles that of the Suncal utility, except that a PPI task
consisting of one or more full rotations of the antenna is acquired, instead of automated
sector scan around the anticipated sun position.

The zdrcal task is similar to a standard PPI task, except that all elevations are in the
vertical position. The data outcome of the vertical scans are formatted as RAW product files
for subsequent analysis.

The zdrcal data analysis step consists of retrieval of the RAW product containing the ZDR
data fields subject to configurable IRIS/RDA quality thresholding, supplemented with
standard moment data of reflectivity dBZ, Doppler velocity (V) and spectrum width (W). The
data of co-polar correlation coefficient RhoHV completes the input to estimate ZDR offsets
and associated uncertainties reported as dedicated result files.

Auxiliary variables

Uses of the auxiliary variables dBZ, V, W, and RhoHV include:
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• zdrcal-specific quality criteria are applied gate-to-gate, to enhance the echoes of
atmospheric scatterers in the ZDR data sample.
The ground clutter residuals which may remain after Doppler filtering, and other
spurious signals such as radio frequency interference, and macroscopic object echoes
are diminished.

• The expected variances of ZDR data values are computed as gate-to-gate sampling
variations, by referencing the ZDR distribution as echoes from continuous precipitation
in the sampling volume.2)

ZDR offsets estimates

The ZDR offsets estimates are weighted medians of the qualified ZDR data points, checked
for consistency with a maximum probability estimator of the same data set.

The check rejects estimates that appear disturbed by excessive non-Gaussian tails or other
asymmetries biasing the median estimator from the most plausible ZDR offset value.

The weighting is based on expected gate-to-gate ZDR variances. Data points of high co-
polar correlation and large spectral width are favored, which associate with narrowly
distributed ZDR data. The weighting approach is statistically optimal in the sense that it
maximizes the precision of the ZDR offset estimates, given variable input quality.

The ZDR offsets estimates are reported with estimates of uncertainty, which are derived
from actual observed distributions of the ZDR data sample. Also, the input distributions are
characterized in terms of expected and actually observed widths, allowing easy quality
control. All estimates of uncertainty are expressed at 68 % confidence level ("one sigma"
uncertainties, equivalent to root means square widths RMS of normally distributed data).

Post-processing

The zdrcal –process:file triggers a post-processing mode of zdrcal analysis using
an existing zdrcal RAW product. The RAW product resides in the directory specified in the
zdrcal.conf file.

The outcome of post processing is equivalent to the run-time result, pending the conditions
that the RAW data are appended on the same ZDR history sample, and that the same
zdrcal analysis settings are configured.

This is option is not used at most operational radars.

This command mode is useful for general quality control for example the effects of
variations in quality criteria can be studied. The option allows for monitoring ZDRCAL
calibration remotely for example at analysis centers of a radar network. Note that the RAW
product does not need to originate from another Zdrcal utility run, but can be a standard
IRIS RAW product, with requirement that the specified data dBZ, V, W, ZDR, RhoHV are
available (and only those data fields).

2) The formalism in reference V.N. Bringi and V. Chandrasekar, 2001: Polarimetric Doppler Weather Radar, Principles and Applications,
2001. 636 pp. Cambridge University Press is applied.
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16.2.2 Typical use cases
Moderate accuracy with high data availability in stable radar operation

The default Zdrcal configuration settings aim at moderate accuracy (warning threshold at
0.3 dB) with high data availability in stable radar operation (integration limited to 4 days,
maximum).

The vertical task consists of a single sweep intended for regular repetition as part of the
radar scheduler, once in an hour for example.

Initial ZDR offset estimation during radar commissioning and start-up

Typically, a first estimate of ZDR offset is checked to confirm the radar system state.

An adequate precision suffices (warning threshold 0.4 ... 0.5 dB). The radar can be allocated
full-time to Zdrcal runs, for limited time.

Operation can be interactive, typically. In this case the utility can be configured to make
several sweeps, each run.

At fair weather, you can increase the number of sweeps (max 40 sweeps).

You can set the TASK Scheduler to run Zdrcal, continuously, to collect as much observations
as possible, in a limited time.

High accuracy monitoring in stable radar system

Having obtained good knowledge of the proper settings and stability of the ZDR offset, you
can configure the stability of the radar, Zdrcal to high accuracy and to very low false alarm
rate, with some compromise on monitoring temporal coverage. To this end, it is recommend
to:

• Tighten the quality thresholds (LOG, CCR, SQI, SIG)
• Apply harder Doppler filtering and tighten Zdrcal specific quality criteria (raise RhoHV

threshold, require more qualified gates in each ray
• Discard incomplete seeps at high percentage.

Eventually, the utility can be limited to run adaptively to selected weather cases
(precipitation on radar) using the mode switching feature of IRIS.

16.3 Running Zdrcal from a command line

Operating a radar interactively through command line Zdrcal requires the DSP and
antenna to be available.
If DSP is reserved for other use, a message <Export channel is busy> is generated.
Also, the ingest process must be switched off in IRIS. IRIS can stay on.
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1. To invoke Zdrcal from the command line, type: $ zdrcal
If needed, add an extra operator

Zdrcal operators Description

-auto Do scan and process phases, but skip the interactive update and do not log
progress on the terminal.

This is meant to be run from a scripting environment.

Warnings are reported out on the error output

-full Does full scan, process and update phases.

Same as –auto followed by –update, except you get progress reports on
the terminal.

Note that the update step uses the latest Zdrcal result file available, that is,
the update can proceed even if there are no new results. This is the default
behavior if no command line option is given.

-help Prints a version of this table.

-process:<path> Triggers a post-processing mode of zdrcal analysis using an existing Zdrcal
RAW product.

-resave Reads and saves the zdrcal.conf file with comments and all new fields
filled with default values. See Zdrcal configuration file (page 279)

If zdrcal.conf is missing, the utility uses default settings. .

Run the Zdrcal utility with the –resave option to read in the old
zdrcal.conf file, fill in all new fields of current IRIS/RDA version with
default values, and write out the file including updated comments.

You can run zdrcal –resave to create a fresh default file by removing the
existing file first.

It is a good idea to run the –resave option when you first use Zdrcal after an
IRIS/RDA upgrade to see new features.

-update[:<file>] This triggers an interactive update of the current radar ZDR offset using the
latest Zdrcal result file available for the current radar site.

Specify a file name to select a desired (older) result.

The specified file resides in the configured Zdrcal directory and cannot to
originate in data ingested at other radar.

-version Prints the version number.

16.4 Running Zdrcal as an IRIS Exec Task
Running Zdrcal as part of the standard scheduler allows the ZDR calibration status to be
routinely monitored without operator interaction.

When Zdrcal is added the IRIS Task Scheduler as an Exec Task, it runs routinely either at
regularly scheduled times, or it can be set to run at specified weather events, in which a IRIS
mode switch is triggered by WARN products.

Chapter 16 – Zdrcal utility

277



Figure 53 Zdrcal Exec Task

1. To run Zdrcal as an IRIS Exec task, type:

zdrcal –auto 2 > &1 | signal_iris

-auto
Sends the progress report output to a terminal. The utility performs the data
acquisition and analysis part in –auto mode, that is the calibration status is
monitored, not updated.

2 > &1 | signal_iris
Reroute the utility warnings to IRIS message log and popup, including the
warning issued if the calibration offset drifts beyond the specified alarm
threshold.

16.5 Using Zdrcal results
The Zdrcal ZDR offset estimates are reported in result files *.zdrcal_results.

You can use these files to help maintain an accurate radar system level calibration of
differential reflectivity ZDR.

1. To respond to an alarm about a significant deviation of the ZDR offset observed from
the current radar setting, check the Zdrcal result file associated with the warning in the
configured Zdrcal result directory.

To find the file, check the warning date and time in the result file name (typically, the
file is the most recent one) If more recent result files have been generated, the
recommended procedure is to inspect the later evolution of the offset estimate and
judge the most likely current and future stable setting.
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2. To view the most likely offset estimate:

a. In most cases, the most recent result file carries the most likely offset estimate.
Retrieve the latest Zdrcal result by typing: zdrcal –update
To specify an earlier result file, type:
zdrcal –update:XXXyymmddHHMMSS.zdrcal_results
Zdrcal looks for the most recent *.zdrcal_results file in the directory
configured in Zdrcal (See Zdrcal configuration file (page 279)).
When it has retrieved the result information, Zdrcal inspects the result quality,
including:
• Internal consistency of the estimate
• Consistency of the radar site and data time span with respect to the current site

and time
• Whether the current ZDR offset setting is consistent with the setting used during

the data sampling
• Whether the result deviates from the configured alarm, significantly

b. When prompted, define how the utility should proceed (that is continue the update
process, or terminate it).

If you continue the update process, the utility updates the current radar settings in
the signal processor, as well as updates the radar setup files to guarantee the
continued use of the new setting after restart of IRIS/RDA processes.

You may also want to perform this task to verify the results of running Zdrcal.

16.6 Zdrcal configuration file
The Zdrcal utility uses information retrieved in the zdrcal.conf file, which is in the $
{IRIS_CONFIG} directory.

You can adjust the local configuration by editing this file with a text editor such as gedit to:
• Re-specify the main parameters of the monitor accuracy and the maximum time span

of the sample sequence.
• Specify details of the scanning strategy, Zdrcal-specific quality criteria, and data output

directories, and control the log files.

Version information

Do not modify the version information at the start of the Zdrcal configuration file.

The default technical settings for Zdrcal logging at $IRIS_LOG/zdrcal.log are
recommended, particularly in the introductory phase.

Note that the Zdrcal utility appends consecutive run logs in zdrcal.log. In longer runs, it
is recommended to rename the log file from time to time.
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# ZDRCAL version. Log settings
zdrcal.sVersion = "8.12"
zdrcal.sLogToFile = "YES"
zdrcal.sLogToTerm = "NO"

Threshold for ZDR offset warning

The primary configurable parameter of Zdrcal is the threshold for user warning about a
significant deviation of the observed ZDR offset from the current radar setting. The max
time span prevents Zdrcal accumulating data unreasonably long.

In field tests, the utility analysis has been found robust up to several days of integration
(hourly sampling).

# Threshold for ZDR offset warning (dB).
zdrcal.fThresholdForAlarm_dB = 0.3

# ZDRCAL run duration will be adjusted, accordingly,
# in order to keep false alarm rates below 5% (ZDRCAL_FAR_CL).
# ZDRCAL run will be limited to a max time span (hours), however.

zdrcal.fMaxTimeSpan_hours = 96

Task parameters

The relevant Zdrcal task parameters are configurable.

With all the radar task settings, keep within the site specific hardware limitations, listed in
the Setup menu, RVP section.

The maximum number of sweeps is limited to 40 in IRIS/RDA, in addition.

During the first try, adjust the quality thresholds LOG, CCR, SQI, SIG to be adjusted similar
to the typical operational task settings, while they can be tuned tighter for optimal quality,
or relaxed modestly for optimal result availability.

The data fields in zdrcal RAW products are thresholded with the configure settings.
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# Pulse width index, referring to the PWs specified in
setup_dsp.conf.
zdrcal.Task.iPW = 0

# Pulse repetition frequency (Hz).
zdrcal.Task.fPrfHz = 1200

# Range of the first gate, range spacing, and max gate range in
signal processing (km).
zdrcal.Task.fRangeStartKM = 0.1
zdrcal.Task.fRangeStepKM = 0.1
zdrcal.Task.fMaxRangeKM = 10

# Number of complete antenna rotations.
zdrcal.Task.iNrRotations = 1

# Number of rays (inverse of Az resolution) in a rotation.
zdrcal.Task.iNrRays = 360

# Number of pulses in a ray.
zdrcal.Task.iSampleSize = 64

# Data resolution in bytes. Recommend:2 in long term use
zdrcal.Task.uiBytes = 2

# Standard RDA quality criteria (all measurands LOG, CCR, SQI;
width SIG in addition)
zdrcal.Task.fLOG_thr = 1
zdrcal.Task.fCCR_thr = 18
zdrcal.Task.fSQI_thr = 0.29
zdrcal.Task.fSIG_thr = 5

# Index of the Doppler filter, specified in setup_dsp.conf.
zdrcal.Task.iDopplerFilter = 1

Data analysis

Zdrcal applies additional quality checks in data analysis, for qualified ZDR data points to be
included in offset estimation.

Note that even the lowest reflectivity data have significant signal to noise ratios as they
originate at short distances (<20 km / <12.4 mi). Avoid the highest practical reflectivities due
to receiver saturation at very close distances.

Note also that the default settings presume Doppler velocity is negative for incoming
(falling) echoes. The minimum co-polar correlation coefficient is set, because for low
correlation echoes ZDR distribution is excessively broad. Non-atmospheric echoes (RF
interference, and similar) are diminished by requiring several qualified bins in each ray. It is
imperative for unbiased measurement that data of full antenna rotations are included only.
The fraction of incomplete (or missing) rays must be kept low.
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# Minimum reflectivity (dBZ)
zdrcal.Analysis.fMinimumDBZ = -15

# Maximum reflectivity (dBZ)
zdrcal.Analysis.fMaximumDBZ = 35

# Minimum fall speed (m/s, v_rain > 0)
zdrcal.Analysis.fMinimumV = -6

# Maximum fall speed
zdrcal.Analysis.fMaximumV = 0.5

# Minimum co-polar correlation coefficient (RhoHV)
zdrcal.Analysis.fMinimumRhoHV = 0.6

# Minimum number of qualified bins required in a ray
zdrcal.Analysis.iMinBinsRay = 2

# The closest range considered (km)
zdrcal.Analysis.fMinRangeKM = 0.850

# The fraction of missing rays allowed in the sample.
zdrcal.Analysis.fMaxMissingRays = 0.001

Result files

The Zdrcal utility result files summarize the ZDR offset obtained in analysis of a given data
set.

Result reporting is not bound to each radar task (that is each RAW product) performed, but
the utility integrates over consecutive samples (proximate in time) until the anticipated
precision passes the alarm threshold with a safety margin, or reaches the max time span.
The offset estimate, it's intrinsic consistency, and actual uncertainty are then evaluated, and
the sample is reset.

In this scope, the results can be generated at configurable pace and quality using the
following options:
0

Implies that a result file is generated for each complete integration. Result file quality
flags may indicate if the result is inconsistent (bResultValid = 0) or if the actual
uncertainty was lower than anticipated (bResultPrecise = 0).

1
Omits reporting inconsistent results.

2
Reports only the highest quality results.

The 5 % false alarm rate can be expected for levels >0. The tight settings tend to require
smooth precipitation on the radar, and result availability is limited in dry periods.
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# Level of result reporting:

# -1: result file from each task (RAW). Not recommended in normal use.

# 0: all available results reported in result files.

# 1: all consistent results reported in result files.

# 2: results at target accuracy (or max sample) reported, only.
zdrcal.Analysis.iReport = 1

Quality settings

The Zdrcal utility expects homogeneously selected data input, and changes in quality
settings are to be avoided.

During commissioning phase, such changes may be necessary and the utility has the default
policy "YES" to switch to new quality settings and to restart a fresh analysis.

During stable operation, it is recommended to switch the policy to "NO" which allows the
processing exceptional RAW files (or run special tasks) of different quality as individual runs,
while keeping the current main data archive separated, that is the data and settings
unchanged.

# Policy in case these quality criteria conflict with the history settings.

# YES: Reset the history statistics, and assume the new criteria in future 
runs.

# NO: Omit the history data, the new settings used in the current sample, 
only. The history unchanged.
zdrcal.Analysis.sUpdate = "YES"

Miscellaneous

Zdrcal miscellaneous parameters are technical. Typical users do not need to modify them.

# 1=RVP Tags, 3=Antlib.
zdrcal.Misc.iAngleSource = 1

RAW Product Files

The Zdrcal utility reports RAW product files as intermediate results, allowing for detailed
quality checks and distributed analysis.

The default setting is a typical IRIS path for polling incoming data.

When activated in the setup menu, input section, RAW products appear in IRIS product
menu for network distribution and for visual inspection after automatic reingest.
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In this operation mode, the RAW files are wiped automatically.

If no input pipe is configured, RAW files accumulate indefinitely and regular clean up is
necessary.

# ZDRCAL RAW product directory:
zdrcal.sRawPath = "/usr/iris_data/input/"

Result files

The Zdrcal utility reports result files in directory created during standard IRIS/RDA
installation.

It is recommended that Zdrcal result files are redirected to a dedicated data directory, such
as /usr/iris_data/zdrcal, which you must create.

# ZDRCAL results directory:
zdrcal.sResultDirectory = "/usr/iris_data/log/"

Data history

The default setting of Zdrcal utility is to use data history for obtaining high data availability
at specified precision.

# ZDRCAL accumulates data over subsequent runs (recommended: YES)
zdrcal.sRunArchive = "YES"

For testing purposes, you can set the utility to process each RAW product as an
independent sample (setting "NO")

16.7 Configuring syslog.conf for Zdrcal
The Zdrcal utility logs calibration changes using syslog to put a message in the
default /var/log/irisrda/messages file.

To put the messages in a separate file, do the following.

1. Log in as admin.

2. Edit the /etc/vaisala/irisrda/syslog.conf file by adding the following at the
end of the file:

sudo log user.info messages to sigmet.log
user.info /var/log/irisrda/sigmet.log

3. Send kill -hup to the syslogd process.
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17. Network Manager

17.1 Network Manager overview
Vaisala Observation Network Manager NM10 enables remote monitoring and management
of your weather observation networks on one central and secure platform. Easy access to all
essential device status and event information helps to identify and solve problems quickly,
ensuring continuous high-quality observations and shorter site visits with correct actions.
From implementation to long-term maintenance, a network management solution
optimized for your needs improves operational efficiency and reduces the lifetime cost of
managing and maintaining all your observation sites.

The system includes the capability to receive status data and alerts directly from Vaisala
weather radar sites.

The weather radar sites authenticate and register via HTTPS, and the status data from the
radar sites shows in the NM10 web user interface after both systems have been correctly
configured, including creating the authentication key in NM10.

17.2 Creating Network Manager
authentication keys

Authentication keys are security tokens needed when establishing connections to NM10
from other systems (“incoming authentication key”) and from NM10 to other systems
(“outgoing authentication key”).

Typically, the keys are needed for the connection with the AUTOSONDE, MW41, weather
radar, and lightning sites. The authentication keys consist of two parts; the authentication
key and the authentication secret.

You create the authentication keys in Network Manager.

1. Select Security > Authentication in the administrator view.

A list of the existing authentication keys is displayed.

2. Select Generate new key.

3. A pop-up window shows the created key. Copy or export the key:

• Copy the key from the pop-up window, including both the "incoming authentication
key" and the "authentication secret".

• or export the key to a text file by clicking Export. This is needed, for example, when
you cannot copy the key directly to the source site software but instead have to
transfer the key on a memory stick.

This is the only time that the "authentication secret" is displayed, so make sure to
make a note of it either by copying or exporting it.
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4. Close the pop-up window by selecting Close.

5. The generated "incoming authentication key" is displayed in the list. Check that the
Enabled option is selected and continue with registering the source.

17.3 Adding a radar site to Network Manager
Before adding a radar site to Vaisala Observation Network Manager:

• Make sure Network Manager is installed.
• Generate the Network Manager authentication key. See Creating Network Manager

authentication keys (page 285).

1. Make sure the radar hardware and software is installed, configured, and fully
operational.

2. If you have not done so already, in the IRIS Setup utility, select License and define the
Site Name.

See License and Site Information Setups (page 195).

You must choose the site name carefully.
If the site name changes, you must request a new license from Vaisala.

For existing sites, you can retrieve the site name from the terminal window by
typing: show_machine_code

3. If you have not done so already, in the IRIS Setup utility, select License and enter the
license information provided to you by Vaisala.

4. Provide the IRIS machine code portion of the license key you entered in the previous
step to Network Manager.

The following image shows an example of the machine code.

5. If you are configuring a new radar network, copy the iris2nm.in file to the
configuration directory with the following command:

cp /etc/vaisala/irisrda_templates/iris2nm.ini /etc/vaisala/irisrda/
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6. Add the following information to iris2nm.ini:

• Network Manager IP address and port number, available from your system
administrator

• Network Manager keys generated in Creating Network Manager authentication keys
(page 285).

See Exampleiris2nm.inifile (page 290).

7. In iris2nm.ini, check the heartbeat value for how often Network Manager
expects status information from the radar.

The heartbeat parameter defines how often Network Manager expects status
information from the radar as well as how often the radar should send status
information to Network Manager.
The default value is 60 seconds.

8. In the IRIS terminal window, register the source, that is, the radar site, with Network
Manager by typing the command:

/usr/libexec/vaisala/irisrda/iris2nm --register

Registration provides Network Manager with the site name and co-ordinates based on
settings defined in the Setup utility.

9. Start sending radar status updates to Nework Manager by typing the command:

sudo systemctl enable --now iris2nm.service

The iris2nm service runs in the background and sends antenna status to the network
manager at a frequency defined by the heartbeat.

10. To make sure the radar site has connected to the Network Manger and is and sending
status information, type:

/usr/libexec/vaisala/irisrda/iris2nm

If the connnection works correctly, the terminal displays textual information that is
returned from Network Manager.

17.4 Viewing radar status information in
Network Manager

Once your administrator has added a radar site to Network Manager, you can use Network
Manager to monitor radar status information.

For more information, see the Network Manager documentation.
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1. Select Map to view the status information on a map.

2. To show status information on the map, select Additional information and then select
the site details marker for each site.

Use the left menu to select which radar status information you want to display.
The map shows the location of each radar in your network as well as the status
information for the selected criteria.

3. Select All Measurements to view radar status information as a list.

17.5 Updating radar site information for
Network Manager

During the radar system and Network Manager set-up, try to enter site information as
accurately as possible.

In some cases, after the initial configuration, you may need to update the heartbeat period
or site information.

If you change this information, you must re-register the radar site with Network Manager.

1. To update the hearbeat interval, in /etc/vaisala/irisrda/iris2nm.ini,
update the heartbeat parameter (seconds).

The heartbeat parameter defines how often Network Manager expects status
information from the radar as well as how often the radar should send status
information to Network Manager.
The default value is 60 seconds.

2. To update the site coordinates select Setup > RCP Radar Control Processor.

Under Radar Site and Antenna Placement, update the coordinates.
See Radar site and antenna placement (page 174).

3. In rare situations, to update the Site Name, select SetupLicense.

Type a site name using up to 16 characters.

You must choose the site name carefully.
If the site name changes, you must request a new license from Vaisala.

4. In the IRIS terminal window, register the source, that is, the radar site, with Network
Manager by typing the command:

/usr/libexec/vaisala/irisrda/iris2nm --register

Registration provides Network Manager with the site name and co-ordinates based on
settings defined in the Setup utility.
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17.6 Starting or stopping the iris2nm service
Normally, the iris2nm service runs in the background.

If there are problems with the service, try restarting it.

1. To check the service status, type: systemctl status iris2nm
2. To start the service, type: systemctl start iris2nm
3. To stop the service, type: systemctl stop iris2nm

17.7 Radar status information available to
Network Manager

Table 35 Radar status information sent to Network Manager

Antenna Utility Network Manager Possible values

TR Power TR power On

Off

Radiate Radiate On

Off

Servo Power Servo power On

Off

Antenna Mode Antenna mode Local

IRIS

Computer

Standby Standby Ready

Warming

Magnetron Magnetron Critical Fault

Warning Fault

Normal

Air Flow Air flow Critical Low Air Flow

Warning Low Air Flow

Normal

TR Mode Transmit power Local

Computer

Interlock Interlock Critical Open Door

Warning Open Door

Normal

Waveguide Waveguide Critical Low Pressure

Warning Low Pressure

Normal
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Antenna Utility Network Manager Possible values

RCP Status RCP Status Critical RCP message

RCP message

17.8 Example iris2nm.ini file

[NETWORK_MANAGER_IP_ADDRESS]
hostname = //IP Address
port  = 8443 

[NETWORK_MANAGER_KEYS]
incoming_authentication = 
;enter-your-incoming_authentication, for example, ad9840f7-520f-4c26-ad9a-
b018a2e8dab0 

authentication_secret = 
;enter-your-authentication_secret, for example, 
PNUqLFXgnr93IwYFsMIzhrmvaWzA1zdyvvByvC/vrHD+Qbt3YOSABJ
+kdGkrXfua0Tciow7qdSZBKmZRjHm/jQ== 

[NETWORK_MANAGER_EVENT]
;update frequency for outputing antenna events to NM
;heartbeat in seconds. Should not be less than 10 seconds.
heartbeat = 60 

[CURL_OPTIONS]
verbose = false 

[ANTENNA_TO_NETWORK_MANAGER_STATUS]
ASF_TRPOWER = transmitReceivePower
ASF_RADIATE = transmitterRadiate
ASF_SERVO = servoPower
ASF_LOCAL = localControlOverride
ASF_STANDBY = standby
ASF_MAGTFLT = magnetronCurrent
ASF_LOWAIRFLOW = airFlow
ASF_TRLOCAL = transmitReceiveMode
ASF_INTERLOCK = safetyInterlocks
ASF_LOW_WGP = waveGuide
RCP_STATUS = radarControlProcessor
SUMMARY = summary

IRIS and RDA Utilities User Guide M212925EN-D

290



18. Information utilities

18.1 Productx
The productx product examiner utility displays the information contained in a specified
product file.

For all product types, productx displays:
1. Product header, including information such as the site where the ingest data came

from, the date and time when the ingest data was gathered, and its size.
2. Product-specific meta-data from the header for many product types.
3. Data values from the file.

For Cartesian data files, this could be a large number of pixels. In this case it skips data
to present a summary display which fits on the terminal. If you want no skipping,
specify a very large terminal width, say 10000.

18.1.1 Invoking productx
To invoke productx, issue the command: productx [options] filename
filename is the name of a product file stored in /usr/iris_data/product.

Raw products are stored in a separate directory: /usr/iris_data/product_raw.

Table 36 Raw Product Parameters

Parameter Description

-help Prints the list of options.

<filename> Specify which ingest header file to read.

-sweep:# Specify sweep number, origin 1. Z-axis for 3D data.

-version Print out just the version number.

-width=# Specify maximum line with for data display.

Each product file has a unique name based on the site ID, date, and a randomized algorithm.
The first 3 letters of the file extension show the product type.

Table 37 Product file naming

File name label Product type

BAS BASE

BEA BEAM

CAP CAPPI

FCA FCAST 
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File name label Product type

CAT CATCH

DWE DWELL

HMX HMAX

IMG IMAGE

LAY LAYER

MAX MAX

MHG MELTING LAYER

NDP NDOP 

OTH OTHER

PPI PPI

RAW RAW

RN1 RAIN1

RNN RAINN

RHI RHI

RTI RTI

SHE SHEAR

SLI SLINE

STA STAT

TDW TDWR

THK THICK

TOP TOPS

TRA TRACK

TXT TEXT

USE USER

VAD VAD

VUS VUSER

VIL VIL

VVP VVP

WND WIND

WRN WARN

XSE XSECT
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18.1.2 Productx examples
PPI example

A PPI product shows useful header information:

$ productx TMS090520180345.PPIFD6W -width:80
------------- Product Summary for TMS090520180345.PPIFD6W -------------
Ingest site name :'tms_rad1', Version: 8.11
Ingest hardware name :'tms_rad1'
Product site name :'SIGMET, dry2', Version: 8.12
File size: 519040 bytes (Disk space: 519040 bytes)
Product type is: PPI
PCO name: DEF_DBZ, TCO name: PPIVOL_B
PRF: 840/560Hz, Wavelength: 10.63cm, Nyquist: 44.65m/s(V), 22.32m/s(W)
XMT Polarization: Horizontal, Wind:???
Constant:72.06 dB, I0:-104.82 dBm, Cal Noise:-70.66 dBm, Bandwidth:0 kHz.
ZFlags: SP_T, block_zc, attn_zc, target_zc, dpatten_zc, dpatten_z
VFlags: SP_V, 3lag_w, ship_v, unfold_vc, FALL_VC, storm_vc
Heights: Radar: 970m, Ground: 948m, Melting: 4900m MSL
Size is: 720x720x1 pixels
Scale is: 500.00 x 500.00 x 0.00 m/pixel
Center Location: 22 24.7'N, 114 7.4'E, ref: 0 meters
Projection type is: Eqdist Cylinder
Projection Reference Point: 22 24.7'N, 114 7.4'E
Equitorial Radius: 0.00000 km, Flattening: 1/0.00000
Radar position is: 360.0, 360.0 pixels
Product data type is dBZ (2)
Color count:16, Color set: 1, variable
Seams: 16452.00 16702.00 16952.00 17252.00 17402.00 17502.00 17752.00
18052.00
18202.00 18302.00 18552.00 18852.00 19002.00 19102.00 19352.00 19652.00
Maximum range: 180.0 km
PPI elevation angle: 6.60 degrees
Ingest time: 18:03:45 20 MAY 2009 HKT (–480 minutes west) DST:0/0
Volume scan time: 18:03:45 20 MAY 2009 HKT (LT: HKT –480 minutes)
Oldest Ing time: 18:03:45 20 MAY 2009 LT
Product Gen time: 19:23:31 17 JUN 2009 UTC
Input count: 1
Product is not composited.
Displaying cartesian data with skip factor 40
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719:255 255 255 255 255 255 255 255 255 255 255 255 255 255 255 255 255 255
679:255 255 255 255 255 255 0   0   0   0   0   0   0   255 255 255 255 255
639:255 255 255 255 0   0   0   0   0   0   0   0   0   0   0   255 255 255
599:255 255 255 0   0   0   0   0   0   0   0   0   0   0   0   0   255 255
559:255 255 0   0   0   0   0   0   0   0   0   0   0   0   0   0   0   255
519:255 255 0   0   0   0   0   0   0   0   0   0   0   0   0   0   0   255
479:255 0   0   0   0   0   0   0   105 117 104 66  0   0   0   0   0   0
439:255 0   0   0   0   0   82  85  121 57  0   101 81  0   0   0   0   0
399:255 0   0   0   0   0   83  111 136 78  0   0   0   0   0   0   0   0
359:255 0   0   0   0   0   83  169 71  0   0   0   0   0   0   0   0   0
319:255 0   0   0   0   0   133 87  0   0   0   0   0   0   0   0   0   0
279:255 0   0   0   0   0   97  93  0 0 0   0   0   0   0   0   0   0
239:255 0   0   0   0   0   78  77  64  0   0   0   0   0   0   0   0   0
199:255 255 0   0   0   0   0   0   0   0   0   0   0   0   0   0   0   255
159:255 255 0   0   0   0   0   0   0   0   0   255 0   0   0   0   0   255
119:255 255 255 0 0 0   0   0   0   0   0   0   0   0   0   0   255 255
79: 255 255 255 255 0   0   0   0   0   0   0   0   255 0   0   255 255 255
39: 255 255 255 255 255 255 0   0   0   0   0   0   0   255 255 255 255 255

Status example

A Status product shows the status of IRIS processes at a particular site.

$ productx HOT000602152122.STAZ0GN
------------- Product Summary for HOT000602152122.STAZ0GN -------------
Ingest site name : 'SIGMET, HOT', Version: 7.17
Ingest hardware name : 'SIGMET, HOT'
Product site name : 'SIGMET, HOT', Version: 7.17
File size: 2340 bytes (Disk space: 2340 bytes)
Product type is: Status
PCO name: SIGMET, HOT, TCO name: FAULT
PRF: 500Hz, Wavelength: 5.00cm, Nyquist: 6.25m/s(V), 6.25m/s(W)
Polarization: Horizontal, wind:???
Heights: Radar: 600m, Ground: 100m, Melting: ???m MSL
Size is: 0x0x0 pixels
Center Location: 42_33.0'N, 71_25.8'W, ref: 600 meters
Projection type is: Azimuthal Equidistant
Projection Reference Point: 42_33.0'N, 71_25.8'W
Radar position is: 0.0, 0.0 pixels
Scale is: 0.000 x 0.000 x 0.000 km/pixel
Product data type is Xhdr (0)
Maximum range: 0.0 km
Ingest time: 15:21:22 2 JUN 2000 UTC (0 minutes west) DST:0/1
Volume scan time: 15:21:22 2 JUN 2000 (LT: EDT 300 minutes)
Oldest Ing time: 15:21:22 2 JUN 2000
Product Gen time: 15:21:22 2 JUN 2000
Input count: 1
Product is not composited
Site style is: RADAR
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Overall status is: FAULT
Status of IRIS_INGEST ON/Idle
Status of IRIS_INGFIO ON/NA
Status of IRIS_OUTPUT ON/NA
Status of IRIS_PRODUCT ON/Idle
Status of IRIS_WATCHDOG ON/Running
Status of IRIS_REINGEST ON/Idle
Status of IRIS_NETWORK ON/Idle
Status of IRIS_NORDRAD OFF/Stopped
Status of IRIS_SERVER ON/Idle
Status of IRIS_RIBBON OFF/Stopped
Status of IRIS_INPUT ON/Idle
Status of DSP N/A Stopped
Status of RCP Critical N/A DEAD
Status of WINDOW1 OK Idle test
Status of NETWORK1 OK Idle ToArchive2
Status of NETWORK2 OK Idle netcdf_out
Status of NETWORK3 OK Idle ToBufr
Status of NETWORK4 OK Idle ToHDF5
Status of WINDOW2 OK Idle Joe
Status of ARCHIVE1 OK Idle archive
RST mode: ’DEFAULT’
TSC mode: ’DEFAULT’
PSC mode: ’DEFAULT’
POM mode: ’DEFAULT’

Active task: ’’
Active product: ’’
Antenna Position, azimuth: 20.00, elevation: –0.99
Bite fault summary shows 2
Low Airflow: OK
Interlock: OK
Waveguide: OK
Top message #9, Repeats: 1
Problem starting scan at EL=6 (AZ velocity out of range)
Process: IRIS_INGEST, Name: F:202 M:3
Time: 16:34:36 30 MAY 2000
Message list contains 0 messages:

18.2 Rays utility
The rays utility gives information about ingest files. You can choose to display information
about various parameters of the ingest data.

18.2.1 Invoking rays
To invoke rays, issue the command:
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rays [options] filename

where filename is the name of an ingest header file stored in the directory /usr/
iris_data/ingest.

Ingest files are named with a time stamp for when the data were gathered. For example,
ingest data gathered at 10:17:30 on December 2, 1994 is stored in a file named
941202101730.

Table 38 Ray options

Option Description

-help Prints the list of options.

-data:dtype Specify which data type to display.

[-if:]filename Specify which ingest header file to read.

-inter Run in interactive mode. This is the old style, rays then prompts for
some of the options.

-perf Performance test, display ray headers only.

-range:# Specify starting range in km.

-sweep:# Specify sweep number, origin 1.

-terse Skip showing ingest header info.

-width:# Specify maximum line with for data display.

To make it easier to enter the names of the ingest files, change your default directory to the
ingest directory and get a listing of all the header files (with ls *.). Select the name of a file
with the mouse and paste it into the command line.

18.2.2 Headers only example
In the following example, rays uses the -perf option to display the ray header information
only. This format lets you evaluate the speed of IRIS or the signal processor and look for
missing rays.

There are 2 azimuth and elevation angles recorded with each ray. These are angles at the
beginning and ending of each ray.
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$ rays -perf -terse DRY020418160516. | more
Reading file: /usr/iris_data/ingest/DRY020418160516.01dBT

# 0 Az: 359.80,0.99 El: 0.48, 0.48 Size: 967 16:05:33
# 1 Missing
# 2 Az: 0.99, 2.20 El: 0.48, 0.48 Size: 967 16:05:33
# 3 Az: 2.20, 3.38 El: 0.48, 0.48 Size: 967 16:05:33
# 4 Az: 3.38, 4.59 El: 0.48, 0.48 Size: 967 16:05:33
# 5 Az: 4.59, 5.78 El: 0.48, 0.48 Size: 967 16:05:34
# 6 Az: 5.78, 6.99 El: 0.48, 0.48 Size: 967 16:05:34
# 7 Missing
# 8 Az: 6.99, 8.17 El: 0.48, 0.48 Size: 967 16:05:34
# 9 Az: 9.38, 9.38 El: 0.48, 0.48 Size: 967 16:05:34
# 10 Az: 9.38, 10.57 El: 0.48, 0.48 Size: 967 16:05:34
# 11 Az: 10.57, 11.78 El: 0.48, 0.48 Size: 967 16:05:34
# 12 Az: 11.78, 12.96 El: 0.48, 0.48 Size: 967 16:05:34
# 13 Missing
# 14 Az: 14.17, 14.17 El: 0.48, 0.48 Size: 967 16:05:34
# 15 Az: 14.17, 15.36 El: 0.48, 0.48 Size: 967 16:05:34
# 16 Az: 15.36, 16.57 El: 0.48, 0.48 Size: 967 16:05:34
# 17 Az: 16.57, 17.75 El: 0.48, 0.48 Size: 967 16:05:34
# 18 Az: 17.75, 18.96 El: 0.48, 0.48 Size: 967 16:05:34
# 19 Az: 18.96, 18.96 El: 0.48, 0.48 Size: 967 16:05:34
# 20 Az: 18.96, 20.15 El: 0.48, 0.48 Size: 967 16:05:34
# 21 Az: 20.15, 21.36 El: 0.48, 0.48 Size: 967 16:05:34
# 22 Az: 21.36, 22.54 El: 0.48, 0.48 Size: 967 16:05:34
# 23 Az: 22.54, 23.75 El: 0.48, 0.48 Size: 967 16:05:34
# 24 Az: 23.75, 24.94 El: 0.48, 0.48 Size: 967 16:05:34

18.2.3 Velocity example
You can choose any of the data parameters — V in this example — and rays then displays the
header, followed by range bins starting from the specified bin.

Where no data is available for a ray, it displays Missing. When no data is available for a
range bin within the ray, it displays a series of dashes (--.- --).
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$ rays XXX041029121855. -data:v2 | more
[joe@localhost ingest]$ rays COX071115233217. -data:v | more
Task Summary for: COX071115233217.
Site name: 'cox-radar', Task name: 'PPI_C'
Scan: PPI, Speed: 9.00 deg/sec, Resolution:1.00 deg
Description: 'Doppler Velocity Volume Scan'
Location: 21 26.0'N 91 58.6'E, Altitude: 64 meters, Melting height:Unknown
Dpolapp config:
Volume Time: 23:32:17.442 15 NOV 2007 UTC (0 min. west) (LT: BDT -360 min.)
ZFlags: SP_T, block_zc, attn_zc, target_zc, dpatten_zc, dpatten_z
VFlags: SP_V, 3lag_w, ship_v, unfold_vc, fall_vc, storm_vc
PRF: 720/576Hz, PulseWidth: 1.00 usec (1)
BeamWidth: 1.46/1.50 deg.
Radar constant: 0.00/0.00 dB, Receiver bandwidth 0 kHz.
Calibration I0: -111.95/-113.03 dBm, with noise -79.70/-76.95 dBm.
LOG-Noise: 0.1776, Lin-Noise: 0.1776, I-Off: 0.0000, Q-Off: 0.0000
SOPRM Flags: 0x04af, LOG Slope: 0.480, Z-Cal: -36.81dBZ, H/V: 0.00 dB
Filters: Dop:6, Log:0; PntClt: 3, Thresh: 1.0 dB; Samples: 80
Processing Mode: FFT, Xmt Phase: Fixed
Zdr Threshold: LOG GDR = 0.00 dB, XDR = 0.00 dB
T Threshold: LOG LOG = 2.4 dB
Z Threshold: LOG & CSR SIG = 5.0 dB
V Threshold: SQI & CSR CSR = 15.0 dB
W Threshold: SIG & SQI & LOG SQI = 0.42
Available moments are: dBZ V
Original moments were: dBT dBZ V W
Starting range 0.125 km, range bin spacing 625 meters
There are 8 sweeps, each having 360 rays and 320 bins
Angle list: 0.0 1.5 3.0 4.5 6.0 9.0 12.0 15.0
Reading file: /usr/iris_data/ingest/COX071115233217.01V
Sweep Time: 23:32:17.442 15 NOV 2007
Starting at range 0.12 km (bin 1), bin step: 0.62 km
# 0 Az: 359.52, 0.47 El: 0.02, 0.02 Size: 320 23:32:32
--.- --.- --.- --.- --.- --.- --.- 17.3 17.3 17.3 17.3 --.- --.- --.-
# 1 Az: 0.47, 1.51 El: 0.02, 0.02 Size: 320 23:32:32
--.- --.- --.- -61.5 -61.5 -62.1 -62.1 -62.7 59.7 59.1 --.- --.- --.- --.-
# 2 Az: 1.53, 2.52 El: 0.02, 0.02 Size: 320 23:32:32
--.- --.- --.- --.- --.- --.- --.- --.- --.- --.- --.- --.- --.- --.-
# 3 Az: 2.54, 3.50 El: 0.02, 0.02 Size: 320 23:32:32
--.- --.- --.- --.- --.- --.- --.- --.- --.- 34.6 -38.8 -1.8 --.- --.-
# 4 Az: 3.52, 4.53 El: 0.02, 0.02 Size: 320 23:32:33
--.- --.- -31.0 -31.0 -31.0 -31.0 -31.0 -30.4 -30.4 -30.4 56.1 -1.8 -1.8 -
1.8
--More--

18.2.4 Extended header example
For shipboard systems, additional information for each ray can be stored in an extended
header in the ingest file.

To display the extended header, use the -data:xhdr option.
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$ rays -data:xhdr -terse -if:DRY020418160516. | more
Reading file: /usr/iris_data/ingest/DRY020418041055.01Xhdr

The extended header includes time recorded to the nearest millisecond.

Starting at range 0.00 km (bin 1), bin step: 0.30 km
# 0 Az: 359.80, 0.55 El: 0.42, 0.42 Size: 1 4:11:08.055

The extended header shows the antenna azimuth and elevation, the platform pitch, roll, and
heading, and the derivatives of these values in degrees/second:

Az: 350.95 El: 0.40 Pitch: -0.13 Roll: -1.10 Head: 346.79
Vel: 18.72 deg/s 0.04 0.70 359.82 359.82

The extended header information is recorded from a serial data stream transmitted from
RCP. Typically this is configured to transmit updates at a maximum speed of about 20 times
per second. Because rays can be recorded at up to 40 rays per second, and because of
pipeline delays in the serial data, the extended header azimuth can lag the actual azimuth by
up to several degrees. Normally, the platform motion period is slower.

Tr: 2.29 El_or: 0.31 Lat: 1#section#45.5'N Long:138#section#
2.8'E Alt: 14
Cor: 3.59 Age: 291 Vel: 3.69 m/s 0.00 -0.17

Tr
Training angle, which is the pedestal relative azimuth of the pedestal.

El_or
Pedestal relative elevation angle.

Cor
Velocity correction (meters/second). Applied to velocity data to correct for platform
motion.

Age
Time in milliseconds since this update arrived from RCP.

Vel
Platform position and motion. Altitude is in meters, and motions are in meters/second.
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19. Using IRISnet

19.1 IRISnet overview
The IRISnet menu provides a status monitoring and user interface for IRIS network features.

The following example shows a network architecture with radar sites and a central site with
a number of displays, an analysis computer, and a Net Manager.

Figure 54 Example: IRISnet menu - Network Manager view
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Node icons symbols and color status indication

There are 2 types of node icons in IRISnet:
• Radar Sites– Workstations that run IRIS/Radar software. These nodes have signal

processors that collect data from the radar. In the case of an active IRIS control system,
these nodes also have a radar control processor (RCP).

• Analysis/Display Sites– Workstations that are run either IRIS/Analysis or IRIS/Display
software.

Each network node has a color indicating its status:
• Green - IRIS is running on the node.
• Yellow - IRIS is not running on the node because, for example, the node is turned off or

disconnected from the network.
• Red - The node is mis-configured with an invalid hostname or the network host cannot

be reached.

Each green IRIS site node can show two types of fault alarms:
• Red cross - Critical error, such as Radar process turned off or BITE fault.
• Yellow cross - Non–critical error.

The Message Summary menu of each system lists critical and non-critical faults.

Network connection lines and color status indication

Each node may have one or more network connections to the other nodes. These are
indicated by lines that are color–coded to indicate status:

• Green - Communication between the nodes is OK.
• Red - There may be a problem with the line or with the node.
• Yellow - The communication line cannot be sensed from your location.

This depends on how communications are routed through the nodes. In the example
figure, the IRISnet menu is run from the RPG11 workstation. The line connection
Products to Display is shown as yellow.

19.2 Starting IRISnet
1. In the terminal window, log in as either radarop or observer.

2. In the terminal window, type: irisnet.

19.3 Checking Network status
The system updates the status automatically every 10 seconds.

1. To check the automatic updates, check the update cycle from the bar in upper left
corner.

2. To update immediately, select Options > Update.
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19.4 Launching IRIS applications
Launch applications either on your workstation or remotely over the network using the IRIS 
Tools menu.

To open any of these utilities on a remote machine, the SSH key of the local machine must
be copied to the remote machine so the SSH connection can be made without typing a
password.

1. Double-click a network node icon to show the IRIS Tools menu for that node as shown
in the example above.

2. Select an IRIS function.

• Setup– the major configuration utility in IRIS (see IRIS and RDA Utilities Guide
(M212925EN)).

• Color Setup– to configure the IRIS color scales (see IRIS and RDA Utilities Guide
(M212925EN)).

• Siris and qiris– to start and stop IRIS.
• Utilities– to start the graphical utilities menu (see IRIS and RDA Utilities Guide

(M212925EN)).
• Overlay– to edit your background maps (see IRIS and RDA Utilities Guide

(M212925EN)).
• Real–time Display– to see an instant radar display.
• Xterm– starts a remote X-terminal.
• Sigaudio– to control the Iris sound features
• VRibbon– for optional IRIS/TDWR Option.
• Runways– for optional IRIS/TDWR Option.
• Ribbon setup– for optional IRIS/TDWR Option.

19.5 Checking application status
When you launch an application, you often get a Status menu showing the progress of the
application.
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For example, when you launch giris, the Status menu shows all the messages associated
with starting the IRIS software.

1. To check status messages, select Options > Status Menu.

If it is blank, there are no status messages yet.

2. To cancel the Status Menu, select Cancel.

This does not affect the application.

19.6 Configuring application tools
The IRIS Tools menu shows the available tools for the site: the top pane shows active tools
for the site, the bottom pane shows inactive tools.

Figure 55 IRISnet tools menu

1. Select Tools > Config.

The IRIS Tools menu appears.

2. To access an inactive tool, select it.

The tool moves up to the active tools pane.
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3. To de-select a tool, select it.

The tool moves down to the inactive tool pane.

4. To save you changes, select Exit Config.

5. To close the configuration view without saving your changes, select Cancel.

19.7 Using drawing tools
IRISnet drawing tools allow you to draw and save your network block diagram.

Figure 56 IRISnet drawing tools

You must have radarop privileges to change the IRISnet menu.

1. Collect information from you system manager on the names of network nodes, what
nodes are running IRIS, and so on.
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2. Select Options > Tools.

Select left or right to define if the tool bar is displayed on the left side or the right
side of IRISnet.

3. To add nodes:

a. Select the tool icon for either a radar site icon or an analysis/display site icon.

b. Move your cursor to the menu and click to plant the icon.

c. To position an icon, use click and drag (dragging is only available if the tool bar is
displayed).

4. To name or re-name network nodes:

a. Switch off the Tools.

b. Double-click the node name field at the bottom of the icon

The Server appears.
The Hostname must be the name recognized by the network (as assigned by your
network manager).
The Alias Name is the name that appears on the icon in IRISnet.

Vaisala recommends that you set the Alias Name to something logical like a radar
location or a workstation function and that the host name is the same.
You can alias hostnames as well in the Unix network configuration. Check with your
network manager if you want to alias an un-friendly hostname such as xnrf0327 to
something more recognizable such as BOS_Radar.

5. To connect the network nodes:

a. Select the line drawing tool.

b. Select a node attachment point.

There are 4 attachment points on a node icon – one on each side.

c. Drag the line over to the attachment point on another icon and release the mouse.

d. If you miss, re–select the line tool and try again.

After you have made connections between nodes, you can still move them. The node
lines "rubber–band".

6. If you make a mistake or want to remove a node or a line, select the eraser tool and
then select the object to delete.
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7. IRIS provides tools for customizing your control display with a background image. If
you wish to use a background image:

a. Select a .gif, such as a photograph of your headquarters so you can show the
location of each computer.

Save the background image in the /etc/vaisala/irisrda/images directory.

b. Import the image to IRISnet by selecting IRISnet > Options > Config.

Select the .gif file you want to use as IRISnet background.
The .gif image MUST be in the ${IRIS_CONFIG}overlay directory.
The background GIF image filename must be the exact name of the image in
the /etc/vaisala/irisrda/images directory. If filename is blank, no image is
displayed.

c. Save and restart IRISnet.

d. Set the icons by moving the radar and computer icons so that each site is
approximately at its geographical location on the map.

8. You can monitor other computers in your network, even if they do not run IRIS. They
are shown as red or yellow, indicating if they are connected to the network.

9. To save your work, select File > Save.

19.8 Configuring Network polling
In most cases, you do not need to change the polling scheme of IRISnet.
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Figure 57 Configure menu

1. Select Options – Configuration.

2. Define the Number of polling processes.

This is the number of background processes that wake-up after a specified number of
seconds (Time between updates) and check the state of the IRIS's that are displayed in
IRISnet.
The number of polling processes is 2 ... 15. The default number is 15.

If an IRIS computer is removed from the IRIS network, but IRISnet still shows the
computer, the polling process that was checking the removed computer hangs for a
2 minute timeout. This leaves one less polling process for checking IRIS status.
It is possible to hang IRISnet if the entire network goes down and all polling
processes are in timeout.

3. Define the Time between updates (seconds).

This is the time in seconds the polling processes sleeps. When they wake they check
the status of the IRIS's in the irisnet and then sleep again. The time between updates in
seconds is 15 ... 120. The default time is 60 seconds.

4. To take the changes into effect, save, exit, and restart IRISnet
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Glossary

Antenna Utility
IRIS utility for manually controlling and monitoring the radar and antenna.

Ascope Utility
A diagnostic and test utility used for aligning and testing the radar and signal
processor.

BITEX
Built-in test equipment software provided by IRIS.

differential reflectivity (ZDR)
Ratio between the horizontal reflectivity and the vertical reflectivity (dBZh - dBZv).
ZDR depends on the asymmetry of the shape, orientation, and falling behavior of the
particles. Positive values indicate more prominent horizontal echoes (such as from
large raindrops), and negative values indicate more prominent vertical echoes (such
as from hail and graupel).

dual-polarization
Ability of the radar to transmit and receive both horizontally (H) and vertically (V)
polarized microwaves. Dual-polarization is a property of dual-polarization radars.
Comparing the received dual-polarized microwaves gives detailed information on
hydrometeors.

IRIS
Interactive Radar Information System. A suite of software tools for configuring,
calibrating, and operating a complete weather radar system.

polarization
With respect to a transverse electromagnetic wave, the correlation between two
orthogonal components of its electric or magnetic field. Polarization of
electromagnetic radiation is defined by the direction of the electric field. In a dual-
polarization weather radar, both horizontal and vertical polarizations can be
transmitted and received simultaneously.

PW
Pulse width.

radar control processor (RCP)
Radar control processor. Controls and monitors weather radar system sub-units.

reflectivity (Z)
Property of the target that describes how much of the energy is reflected from the
target. Radars are calibrated to directly give the reflectivity from the received
backscattered energy. Unit for the reflectivity is mm6/m3. The logarithmic value is in
dBZ. Also called reflectivity factor. Related abbreviations: ZH - horizontal, ZV - vertical,
ZHV - horizontal and vertical.

RF
Radio frequency

Glossary
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RVP10
Vaisala Digital Receiver and Signal Processor RVP10. A product suite consisting of
Vaisala Intermediate Frequency Digital Receiver IFDR10 and Vaisala Signal Processor
RVP10SRV.
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Technical support

Contact Vaisala technical support at helpdesk@vaisala.com. Provide at least the following
supporting information as applicable:

• Product name, model, and serial number
• Software/Firmware version
• Name and location of the installation site
• Name and contact information of a technical person who can provide further

information on the problem

For more information, see vaisala.com/support.

Warranty
For standard warranty terms and conditions, see vaisala.com/warranty.

Please observe that any such warranty may not be valid in case of damage due to normal wear and tear,
exceptional operating conditions, negligent handling or installation, or unauthorized modifications. Please
see the applicable supply contract or Conditions of Sale for details of the warranty for each product.

Recycling

Recycle all applicable material according to local regulations.
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